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PeerSync Help

Welcome to Peer Software's powerful file mirroring, backup and distribution solution, Peer-
Sync v9.4. With this product you will be able to conveniently synchronize folders for back-up
purposes or portability requirements. Never again will you overwrite newer data by attempt-
ing to manually update an individual file or the contents of a folder. 

H is to ry

PeerSync has been available for download/purchase since early 1995. Since then hundreds
of downloads have been logged from various international forums where PeerSync was
made available and thousands of copies have been sold. PeerSync is an MS Windows-
based product. Originally written in Visual Basic, the current product is written in Delphi Object
Pascal. PeerSync originated as a solution to a problem frequently encountered by our own
developers, that of keeping files in sync between multiple hard drives. Developers working
on-site at customers' locations or at home during crunch schedules would then have to syn-
chronize their data back to the office server. This was most often done manually, with each in-
dividual file being dragged to the appropriate server folder. Invariably, data would be lost
when one or several of the server files contained new information which was subsequently
overwritten. In addition to loss of work and resulting frustration, the process was also time con-
suming. Anywhere from 20 minutes to 2 hours would be spent during each synchronization.
After reviewing several commercially available products, it became apparent that an effect-
ive and user-friendly solution to this common problem did not exist, hence the development of
PeerSync.

De scrip tio n

Configured through the Profiler, an intuitive and easy-to-use application, PeerSync automatic-
ally synchronizes multiple directories and sub-directories from user-defined Source to Target
Folders. While removing the frustration and loss of time associated with manual synchroniza-
tion, PeerSync prevents loss of data by checking file dates and times to ensure that newer in-
formation is not overwritten. Synchronization can occur between any mapped or UNC con-
nected drives located on local computers or computer networks. While processing and per-
forming any number of simultaneous tasks, PeerSync retains and expands upon the selectiv-
ity and precision of manual synchronization by offering a suite of automated file inclusion and
exclusion features. Files can be included within synchronization according to standard DOS-
type wild cards and excluded using sub-string comparisons or file attribute settings. Files can
be also be excluded according to their date and size. In addition, PeerSync can be con-
figured to update or add files which are out-dated or non-existent in the current Target Folder.
Precision and scope are further enhanced through PeerSync Jobs and Command Line
Modes. A virtually unlimited number of folder combinations (Jobs) can be created and stored
in Profiles which can be run manually or automatically using command line arguments. While
synchronizing large numbers of folder combinations at once, each combination can have a
unique set of exceptions. In this way PeerSync combines the benefits of precise folder match-
ing with that of an automated environment. Real-Time Source Folder monitoring and repetit-
ive operations on the host PC are also available with PeerSync's options. PeerSync can also
be used for network file management purposes. Reports run during synchronization can dis-
play added, updated, and opened files as well as directories created, and can display un-
matched files found in Target directories.

Emb e d d e d  Op e n File  Ma na g e r (EOFM)
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PeerSync's Embedded Open File Manager (EOFM) option was created and bundled into
PeerSync through a third party partner named EVault. EVault has announced that EOFM is
now "End-of-Life" and no further development or support will be provided. Thus, Peer Soft-
ware will no longer be including EOFM as part of PeerSync beginning in PeerSync version
9.0. In addition, we are no longer able to provide technical support on EOFM effective imme-
diately.
 
For Peer Software customers currently using EOFM and who are on a valid maintenance sup-
port contract, we offer a FREE upgrade from EOFM to the Volume Shadow Copy Service
(VSS) option. We urge all customers to take advantage of this FREE upgrade offer. Peer
Software is continuing development and support for VSS. 

File  T ra nsfe r Pro to co l (FT P)
As of version 9.4, PeerSync's File Transfer Protocol (FTP) is "End-of-Life" and no further de-
velopment or support will be provided. Please contact support@peersoftware.com for more
information. 

File  a nd  Fo ld e r Co mp re ss io n
As of version 9.4, PeerSync's  File and Folder Compression feature is "End-of-Life" and no
further development or support will be provided. Please contact support@peersoftware.com
for more information. 

Pe e rLo ck Co nfig ura tio n Sup p o rt

Starting with PeerSync v7.4, customers who are running PeerLock 2.0.1 or higher on the same
machine as PeerSync are able to configure PeerLock directly from the PeerSync Profiler.
Configuration options include the ability to link specific PeerSync Profile Jobs to PeerLock,
ability to access/view/edit the PeerLock Global Settings from the PeerSync Profiler, ability to
install/uninstall the PeerLock Service, as well as launch and view PeerLock directly from the
PeerSync Profiler. 

T CP WAN Co nne cto r
Version 7.4 and higher of PeerSync also supports real-time or scheduled bi-directional rep-
lication using our TCP replication mode.  In this version, PeerSync now supports bi-direc-
tional replication with target directories that reside outside the LAN, WAN, or VPN. 

EMC VNX a nd  Is ilo n
Version 9.4 and higher of PeerSync supports real-time and share migration for both EMC
VNX and Isilon when using CIFS/SMB.

The manufacturer of PeerSync makes no warranties, implied or otherwise, for use of this product. User assumes all re-
sponsibility for any data loss or damage.

Copyright © 1993-2019 Peer Software Inc. All Rights Reserved Privacy Policy

PeerSync is a registered trademarks of Peer Software, Inc.
Reproduction in whole or in part without permission is strictly prohibited.

The PeerSync Help Manual was built on Friday, February 22, 2019

http://www.peersoftware.com/solutions/file-locking-for-ms-dfsr.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com/our-privacy-policy.html
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Product Information

License

YOU SHOULD READ CAREFULLY T HE FOLLOWING T ERMS AND
CONDIT IONS BEFORE INST ALLING, USING OR DIST RIBUT ING T HIS
SOFT WARE. INST ALLING, USING OR DIST RIBUT ING T HIS SOFT WARE
INDICAT ES ACCEPT ANCE OF T HESE T ERMS AND CONDIT IONS. IN  T HIS
AGREEMENT , ' 'YOU' '  MEANS YOU AS AN INDIVIDUAL IF YOU ARE USING
T HIS SOFT WARE FOR PERSONAL USE. IF YOU ARE USING T HE SOFT WARE
ON EQUIPMENT  OWNED OR OPERAT ED BY A COMPANY OR
ORGANIZAT ION (COLLECT IVELY ' 'COMPANY' ' ), BY ACCEPT ING T HIS
AGREEMENT , YOU REPRESENT  T HAT  YOU ARE DULY AUT HORIZED T O
ACCEPT  T HIS AGREEMENT  ON BEHALF OF YOUR COMPANY.

COPYRIGHT

The software programs (hereafter the "Software") and documentation (hereafter the "Docu-
mentation") is copyrighted and remains the property of Peer Software, Inc. All rights are re-
served.

LICENSE

Peer Software, Inc. hereby grants you (hereafter the "User") a limited, non-exclusive, non-
transferable license to install and use the Software and accompanying Documentation con-
tained in the trialware distribution package (hereafter called the "Trialware Package") you re-
ceived (THE "Original Distribution") for your internal business purposes only. The Trialware
Package consists of copies of the Software and Documentation received via an electronic
transfer mechanism or an electronic storage medium including, but not limited to, diskette,
hard disk, removable disk, tape or optical devices such as CD-ROM or WORM. This license
to install and use the Software and Documentation is conditioned upon User’s compliance
with the terms of this Agreement.

You may install and use the Trialware Package on one or more computers provided there is
no chance that it will be used simultaneously on more than one computer. If you need to use
the Software on more than one computer simultaneously or on a network, please contact
Peer Software, Inc. for information about network licenses.

The Software is protected by trade secret and copyright laws and international treaty provi-
sions. You are not obtaining title to the Software or Documentation or any copyright or other in-
tellectual property rights. You further acknowledge that title and full ownership rights to the
Software and Documentation will remain the exclusive property of Peer Software, Inc. or its
suppliers, and You will not acquire any ownership rights to the Software. You may not subli-
cense, lease, rent, sell, convey, translate, modify, decompile, incorporate into another
product, convert to another programming language, reverse engineer or disassemble the
Software or Documentation for any purpose. You may not modify, or create derivative works
based in whole or in part upon, the Software. You agree to not remove, obscure, or alter Peer
Software, Inc.’s or any third party's copyright notice, trademarks, or other proprietary rights no-
tices affixed to or contained within or accessed in conjunction with or through the Software and
Documentation. Peer Software, Inc. reserves the right to periodically conduct audits upon ad-
vance written notice to verify compliance with the terms of this Agreement.



PeerSync Help 4

Copyright © 1993-2019 Peer Software Inc. All Rights Reserved

Once a license is purchased from  Peer Software, Inc., the Trialware Package will be author-
ized to function as the full working version of the Software with access to all licensed features.

NET WORK LICENSE

Multiple users on a network (e.g. a LAN) requiring access to the Software and Documentation
must purchase a Network License. Two forms of Network Licenses are offered, a Site Li-
cense and Enterprise or Concurrent User License. With a Site License, any user who ac-
cesses the Software or Documentation requires a user license, regardless of the frequency
of use. Once a Site License is purchased Software and Documentation may be copied to all
users who have been licensed. Site Licenses are customized for each purchase. The license
is based on a quantity of simultaneous users and or CPU installations.

The Concurrent User License allows the licensed number of users to simultaneously access
the Software and Documentation. The User agrees to operate metering software, which re-
stricts the simultaneous number of users to the quantity purchased. The Software and Docu-
mentation must be installed on network servers under the control of metering software. 

Both Site and Concurrent User Licenses allow installation of the Software and Documentation
to any number of servers on any number of geographic sites, limited only by the quantity of li-
censes purchased.

T ERM AND T RIAL PERIOD

You are permitted to use the Trialware Package for a trial period (hereafter the "Trial Period")
of thirty (30) days or 30 uses (which ever comes first) after receipt of the Trialware Package.
After such time, if you continue to use the Trialware Package, you must register your copy with
Peer Software, Inc. Failure to register after the Trial Period constitutes termination of this li-
cense. Upon registration, a password (hereafter called the "Password") will be provided to
eliminate the registration reminder screen.

This license is effective until terminated. You may terminate it by destroying the Software,
Documentation, and all copies thereof. This license will also terminate if you fail to comply
with any of the terms or conditions herein. You agree, upon such termination, to destroy all
Software, Documentation, and copies thereof. Upon request, You agree to certify in writing
that all copies of the Software and Documentation have been destroyed.

LIMIT ED WARRANT Y

THE SOFTWARE AND DOCUMENTATION IS PROVIDED "AS IS" WITHOUT WARRANTY
OF ANY KIND. PEER SOFTWARE, INC. DISCLAIMS ALL WARRANTIES RELATING TO
THIS SOFTWARE, WHETHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED
TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE, AND INFRINGEMENT AND ALL SUCH WARRANTIES ARE EXPRESSLY AND
SPECIFICALLY DISCLAIMED. 

EXCLUSIVE REMEDY

YOUR EXCLUSIVE REMEDY AND PEER SOFTWARE, INC. ENTIRE LIABILITY ARISING
FROM OR IN CONNECTIONS WITH THE SOFTWARE, DOCUMENTATION, AND/OR THIS
LICENSE (INCLUDING WITHOUT LIMITATION FOR BREACH OF WARRANTY OR
INFRINGEMENT) SHALL BE, AT PEER SOFTWARE, INC.'S OPTION, THE REPAIR OR
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REPLACEMENT OF THE SOFTWARE OR REFUND OF REGISTRATION FEES (IF
NOTIFICATION OF PROBLEM IS WITHIN 30 DAYS OF PURCHASE).

LIMIT AT IONS OF LIABILIT Y

UNDER NO CIRCUMSTANCES OR LEGAL THEORY, WHETHER IN TORT, CONTRACT,
OR OTHERWISE, SHALL PEER SOFTWARE, INC. OR ANYONE ELSE WHO HAS BEEN
INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS SOFTWARE BE
LIABLE TO YOU OR TO ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES (EVEN IF PEER SOFTWARE, INC. SHALL
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES), INCLUDING,
WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE,
COMPUTER FAILURE OR MALFUNCTION, OR, FOR ANY OTHER DAMAGES OR
LOSSES OF ANY NATURE. IN NO EVENT WILL PEER SOFTWARE, INC. BE LIABLE FOR
ANY DAMAGES IN EXCESS OF THE LIST PRICE PEER SOFTWARE, INC. CHARGES FOR
A LICENSE TO THE SOFTWARE. 

Some states do not allow the exclusion of the limit of liability for consequential or incidental
damages, so the above limitation may not apply to you.

BACK-UP

You may make one copy of the Trialware Package for backup purposes only.

D IST RIBUT ION

You may distribute the Trialware Package to others via an electronic transfer mechanism or
electronic storage media provided that no files are deleted from the Original Distribution Tri-
alware Package or are modified in any way. Files may be added to the Trialware Package
expressly for the purpose of identifying the party distributing the Trialware Package. You may
also place the Trialware Package into any archive or compressed format for ease of distribu-
tion.

You may not distribute the product Registration Key to others under any circumstances.

GENERAL

Export of the Software may be subject to compliance with the rules and regulations promul-
gated from time to time by the Bureau of Export Administration, United States Department of
Commerce, which restrict the export and re-export of certain products and technical data. If the
export of the Software is controlled under such rules and regulations, then the Software shall
not be exported or re-exported, directly or indirectly, (a) without all export or re-export licenses
and United States or other governmental approvals required by any applicable laws, or (b) in
violation of any applicable prohibition against the export or re-export of any part of the Soft-
ware. Some countries have restrictions on the use of encryption within their borders, or the im-
port or export of encryption even if for only temporary personal or business use. You acknow-
ledge that the implementation and enforcement of these laws is not always consistent as to
specific countries. Although the following countries are not an exhaustive list there may exist
restrictions on the exportation to, or importation of, encryption by: Belgium, China (including
Hong Kong), France, India, Indonesia, Israel, Russia, Saudi Arabia, Singapore, and South
Korea. You acknowledge it is your ultimate responsibility to comply with any and all govern-
ment export and other applicable laws and that Peer Software, Inc. has no further responsibil-
ity after the initial license to you within the original country of sale.
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In addition, neither the Software nor the Documentation and underlying information or techno-
logy may be downloaded or otherwise exported or re-exported (i) into (or to a national or res-
ident of) any country to which the United States has embargoed goods; or (ii) to anyone on
the United States Treasury Department's list of Specially Designated Nations or the United
States Commerce Department's Table of Denial Orders. By using the Software you are
agreeing to the foregoing and you are certifying that you are not located in, under the control
of, or a national or resident of any such country or on any such list.

This agreement shall be governed by the laws of the state of New York and shall inure to the
benefit of Peer Software, Inc. and any successors, administrators, heirs, and assigns. Any ac-
tion arising under this Agreement shall be filed in any state or federal court located in Suffolk
county in the State of New York, and You hereby agree, acknowledge and submit to the ex-
clusive jurisdiction and venue of such courts for the purposes of such action, waive any right
You may have to object to such jurisdiction or venue.

This Agreement sets forth all rights for the user of the Software and is the entire agreement
between You and Peer Software, Inc. and supersedes any other prior or contemporaneous
agreements or communications with respect to the Software and Documentation. This Agree-
ment may not be modified except by a written addendum issued by a duly authorized repres-
entative of Peer Software, Inc. No provision hereof shall be deemed waived unless such
waiver shall be in writing and signed by Peer Software, Inc. or a duly authorized representat-
ive of Peer Software, Inc. If any provision of this Agreement is held invalid, the remainder of
this Agreement shall continue in full force and effect. The parties confirm that it is their wish that
this Agreement has been written in the English language only.

PeerSync Installation

PeerSync is shipped (downloaded) in a full installation program. To run, simply double-click
on the executable in the Explorer window, or choose "Run" from the Start Menu and then se-
lect the application. For networked installations, PeerSync supports silent installation by
adding "/S" to the installation application's command line.

Example: %PATH%/ peersync _arc hitec ture_v ersion.exe/ S

See Additional Configuration Entries for more Information on silent installation configuration.

Additionally, PeerSync can use the PeerSync94.lic file for larger networked sales and site li-
censing. This file will be placed in the "PeerSync" folder. If PeerSync detects this file at star-
tup then it will use this data and bypass all other registration security checks. If the Peer-
Sync94.lic file is located in the same folder as the PeerSync installation application, this file
will then be automatically placed in the PeerSync installation folder during installation. To ob-
tain a PeerSync94.lic file, please specify your requirements during purchase/registration.

Note: Adding / S / A INSTALL.LOG to the Uninstall.exe command line will perform an automatic silent uninstall of
PeerSync. 

Additional Configuration Entries

PeerSync and the PeerSync installation (peersync_architecture_version.exe) use a configur-
ation file (PSDef.cfg) to read and set options during and after installation.  If a PSDef.cfg file is
located in the same folder as peersync_architecture_version.exe before installation, this file
will be automatically copied to the PeerSync installation folder during installation.
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Pre -Ins ta lla tio n Co nfig ura tio n Op tio ns

The following options are available before installation and are used during manual
and silent installs:

Ins ta lla tio n
Fo ld e r

This option can be set to any directory path and designates what directory
to install PeerSync into.

D isa b le  In-
s ta ll Re -
b o o t

This option can be set to 'Yes' or 'No' and allows you to suppress the re-
booting (if needed) of your computer after installation. 

Ins ta ll
PSPro file r

This option can be set to 'Yes' or 'No' and allows you to decide if the
PSProfiler interface is to be installed.

Ins ta ll PSW-
iza rd

This option can be set to 'Yes' or 'No' and allows you to decide if the PSW-
izard interface is to be installed.

Ins ta ll
SNMP

This option can be set to 'Yes' or 'No' and allows you to decide if files
needed for SNMP are to be installed (SNMP is only available in the En-
hanced Package).

Cre a te  Sta rt
Me nu Sho rt-
cut

This option can be set to 'Yes' or 'No' and allows you to decide if shortcuts
related to the PeerSync installation will be added to the Start menu.

Po st Ins ta lla tio n Co nfig ura tio n Op tio ns

The following options are used by PeerSync and other installed applications after in-
stall:

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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Use r Na me This is used to set the Registration or Evaluation information to be read in
by PeerSync.

Co mp a ny
Na me

This is used to set the Registration or Evaluation information to be read in
by PeerSync.

Op tio ns This is used to set the Registration or Evaluation information to be read in
by PeerSync.

Pa sswo rd This is used to set the Registration or Evaluation information to be read in
by PeerSync.

T e m-
p Fo ld e r

This option can be set to any directory path and will be used for a tempor-
ary folder PeerSync to use.  If the path does not exist, an attempt will be
made to create it.  If it cannot be created, the default will be used which is
the logon users system Temp path.

Registration and Passwords

If this is an unregistered or Evaluation Copy of PeerSync, you can register it with Peer Soft-
ware, Inc. as a fully licensed copy by providing credit card information via phone or secure In-
ternet registration, or by sending a check or money order to the address below (see included
"readme.txt" file for pricing information).  As an integral component of PeerSync 9.4 and all
subsequent versions, the Profiler application is included as part of registration. 

Re g is te r o nline  v ia  se cure  Inte rne t c re d it ca rd  re g is tra tio n a t: 
http://www.peersoftware.com

Re g is te r b y  p ho ne  v ia  c re d it ca rd  b y  ca ll ing :
703.763.7700 between the hours of 9:00 AM to 5:00 PM EST

Re g is te r b y  FAX v ia  Purcha se  Ord e r:
Send Purchase orders to 703.763.7705 

Re g is te r b y  ma il, se nd  che ck o r mo ne y o rd e r to :  
Peer Software, Inc.
5900 Fort Drive , Suite 415
Centrevile, VA 20121

Info rma tio n Re q uire d :
Full name (as it appears on the credit card)
End User Name (user to be licensed for the product)
Company Name (if applicable)
Address (City, State / Province, Country, and Postal Code)
Phone Number
Entire Card Number
Card Expiration Date
Card Security Code
Email Address 
(Peer Software, Inc. will send the Authorization Key required to unlock PeerSync's Evaluation
Counter to this).

Qua ntity  D isco unts  
Visit http://www.peersoftware.com or contact us for more information.

http://www.peersoftware.com/purchase/registration.aspx
http://www.peersoftware.com
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Upon registering PeerSync, user information will be generated according to the name and
company name (if any) you specified during registration, as well as a password specific to
the product version you have licensed. This information will be emailed to you and will be
used to activate your current copy. Additional license fees must be paid for multi-user use.

PeerSync may not be commercially distributed or distributed by government agencies in-
cluding their contractors UNLESS registration fees are paid for by the distributing party.

See License agreement for product redistribution.

Please visit http://www.peersoftware.com for different versions of PeerSync and types of li-
censing we offer.

Note Regarding Updates:  As new updates/ changes become available, updated versions of the software will
be posted at http:/ / www.peersoftware.com.  Check this page periodically to download the latest executables.  Your
Authorization Key will continue to work with updated versions unless a major release is issued, or PeerSync is in-
stalled in a different folder than the previously installed/ authorized version.

Ente ring  Yo ur Use r Info rma tio n a nd  Pa sswo rd

T hro ug h a n Eva lua tio n Co p y o f Pe e rSync:

After registration with Peer Software, Inc., you will receive Registration Information generated
which is from the information you provided during registration. The password you receive will
be specific to the PeerSync product you have licensed and registered with Peer Software.
Upon entering valid password and user information into your Evaluation Copy, that copy will
be immediately converted to a fully licensed version of the appropriate PeerSync product.
The instructions below apply to a "Registered Evaluation Copy" of PeerSync, that being one
whose evaluation period is still active.

To activate your registered and licensed PeerSync product, first run your Evaluation Copy of
PeerSync. Then choose "About" from the Help Menu located on the far right of the Profiler
Menu Bar. To activate your registered and licensed PeerSync product, first run your Evalu-
ation Copy of PeerSync. Then choose "About" from the Help Menu.

 Located on the far right of the Profiler Menu Bar. This opens the About PeerSync screen,
which contains "User Name," "Company", "Options" and "Password" fields.

Be sure to enter this information exactly as you received it, with the same spacing, hyphena-
tion, punctuation, and cases (i.e. if a comma or period contained within a company name is
omitted, registration will not be accepted). It is advisable to cut-and-paste passwords directly
from the Email registration information. If passwords are typed using lower case letters where
upper cases have been indicated, or if other information is typed incorrectly, the message
shown below will be displayed. This message indicates that registration was unsuccessful;
shows the number of attempts made to register, and contains' a link to Peer Software's web-
site. You will only be allowed a limited number of attempts before the application closes en-
tirely and will need to be opened again in order to retry.

If registration is successful, your will receive a success dialog. Your Evaluation Copy will
have been immediately activated as a registered version of the PeerSync product you have
licensed, with this change indicated on the interface title bar. Click "OK" on the success dialog

http://www.peersoftware.com
http://www.peersoftware.com
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to begin usage of your newly activated PeerSync product. You will not have to exit and restart
the application to do so.
 
T hro ug h a n Unre g is te re d  Co p y o f Pe e rSync: 

Unregistered copies of PeerSync are Evaluation Copies whose evaluation period has ex-
pired, or copies into which a valid password and user information has not yet been entered.
These copies can still be activated as fully licensed versions of whichever PeerSync product
whose usage you have purchased from Peer Software, Inc.

After registration with Peer Software, you will receive Registration Information which is gener-
ated from the information you provided during registration. The password you receive will be
specific to the PeerSync product you have licensed. 

To activate your copy of PeerSync as a fully licensed version, first run the copy. Because
your copy is unregistered, the application will not open in its entirety, instead an About Peer-
Sync screen will open. This screen contains "User Name," "Company", "Options" and "Pass-
word" fields.

Be sure to enter this information exactly as you received it, with the same spacing, hyphena-
tion, punctuation, and cases (i.e. if a comma or period contained within a company name is
omitted, registration will not be accepted). It is advisable to cut-and-paste passwords directly
from the Email registration information. If passwords are typed using lower case letters where
upper cases have been indicated, or if other information is typed incorrectly, the message
shown below will be displayed. This message indicates that registration was unsuccessful;
shows the number of attempts made to register, and contains' a link to Peer Software's web-
site. You will only be allowed a limited number of attempts before the application closes en-
tirely and will need to be opened again in order to retry.

If registration is successful, your will receive a success dialog. Your copy will now have been
immediately activated as a registered version of the PeerSync product you have licensed.
Click "OK" on the success dialog to begin using your registered copy: the About PeerSync
screen will close and the full application interface will be displayed. You will not have to exit
and restart the application to begin usage.

T ERMS AND CONDIT IONS

READ T HE LICENSE AGREEMENT  BEFORE USING T HIS PROGRAM. 

Please send any suggestions, comments or requests for support to the proprietor of Peer-
Sync:

Peer Software, Inc.
5900 Fort Drive , Suite 415
Centrevile, VA 20121

Phone: 703.763.7700
Fax: 703.763.7705
Web: http:/ / www.peersoftware.com

http://www.peersoftware.com
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Upgrade Information

Visit http://www.peersoftware.com/support/request-product-update.html to get the latest ver-
sion of PeerSync. 

Check this page periodically to download the latest executables. Your Authorization Key will
continue to work with updated versions unless a major release is posted.

T o  Up g ra d e  Pe e rSync a nd  PSLis te ne r

Major product upgrades such as v9.3 to v9.4 will require a new product key. Users currently
on annual maintenance must fill out the request for upgrade form to receive the upgrade li-
cense key before downloading v9.4.x. Users not on annual maintenance must contact sales
for upgrade pricing.

The following document outlines the steps to upgrade PeerSync and PeerSync Listener
(ByteReplicator - TCP WAN Connector/PSListener Agent) from one version to the next:
http://www.peersoftware.com/support/knowledgebase/item/peersync-upgrade-instruc-
tions.html

Interface Features

The manufacturer of PeerSync makes no warranties, implied or otherwise, for use of this product. User assumes all re-
sponsibility for any data loss or damage.

Copyright © 1993-2019 Peer Software Inc. All Rights Reserved Privacy Policy

http://www.peersoftware.com/support/request-product-update.html
http://www.peersoftware.com/support/request-product-update.html
http://www.peersoftware.com/contact.html
http://www.peersoftware.com/support/knowledgebase/item/peersync-upgrade-instructions.html
http://www.peersoftware.com/support/knowledgebase/item/peersync-upgrade-instructions.html
http://www.peersoftware.com/our-privacy-policy.html
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Reproduction in whole or in part without permission is strictly prohibited.

The PeerSync Help Manual was built on Friday, February 22, 2019

Getting Started

The Profiler is used to create PeerSync Profiles. A Profile can contain as many as 255 indi-
vidual synchronization tasks, or Jobs. A Job is defined by identifying a Source Folder, a Tar-
get Folder (to which the contents of the Source will be synchronized), and then choosing from
more than 80 easily specified Job Settings. These settings determine which contents will be
synchronized, in what manner, and when they will be synchronized -- according to your choice
of Real-Time, Scheduled, or manually initiated operations.  

The process of building a Profile is made quick and simple by allowing you to easily create
Jobs and then follow the sequentially arranged list of Settings screens accessed through the
Selection Tree, which is located on the left side of the application interface. The user begins
by first selecting a single Job or Multiple Jobs from the Profile Job List. Then specific syn-
chronization criteria is applied to the selected items using Job Settings. Once synchronization
criteria has been configured for each Job, Run/View Current Profile window is used to launch
the entire Profile. By offering a Tool button Toolbar as well as separate Selection Tree and
Profile Job List windows, Profiler's browser-based interface allows you to easily view, create,
copy, rename, move, or delete Jobs regardless of which Settings screen is currently being
displayed.

Pro d uct De finitio ns

Synchro niza tio n Updating any existing files or adding new files in the Target
Folder using the Source Folder as the guide. When completed,
the Target Folder should contain all of the files in the Source
Folder with matching content and time stamps.

Re p lica tio n Same as synchronization, except files that are in the Target
Folder that do not have a matching Source File will be deleted.

Pro file s A Profile is a description of a complete synchronization scen-
ario. Profiles can contain many Source-Target combinations
allowing the end-user to define very detailed file synchroniza-
tions and run them all within a single request. For example, you
could build a Profile that contains Multiple Source and Target
Folders such as:

Source = C:\My Documents Target = \
\SERVER1\USERS\TEST\My
Documents

Source = D:\LocalData Target = \
\SERVER2\USERS\TEST\LocalD
ata

Source = C:
\WINDOWS\Profiles

Target = \
\SERVER3\USERS\TEST\Profiles
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Each of these Source-Target entries can then be further de-
tailed with more than 65 options each making each entry a
completely self-contained process while still allowing it to be
run as part of a bigger set or Profile. 

Jo b s A Job is a single entry in a Profile. A Profile can contain from
one to 255 Jobs and each Job contains more than 80 individual
option settings.

Re a l-time  Mo d e In this mode of operation, PeerSync will automatically detect
changes made to the Source Folder(s) and execute the syn-
chronization options selected for the matching Job. Typically,
the Target Folder is updated with the Source Folder change
within moments of the change. Note that PeerSync may have
completed the operation before Windows actually displays the
change in the Target Folder Explorer window.

Sche d ule d  Mo d e In this mode of operation, PeerSync will execute the desig-
nated Job at the selected time. Each Job in the Profile can
have the same or different time interval.

Pro d uct Sup p o rt All support of PeerSync will be handled on our web site support
page located at http://www.peersoftware.com/support/submit-
a-case.html.

PeerSync is fully supported under all NT based platforms of
Windows but should first be evaluated on each machine in
which you wish to register the product on. PeerSync is no
longer fully supported under Windows 9x platforms.

Notes:  

1. The Profiler is not meant to be running persistently on the Desktop. Rather it should be accessed to cre-
ate/ modify Profiles and to view the status of running Jobs. 

2. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:/ / www.peersoftware.com/ support/ submit-a-case.html.

Tool Buttons

Profiler offers simple buttons allowing you to easily modify the current Profile and its Jobs, re-
gardless of which screen has been chosen from the Selection Tree. These buttons can be
hidden by unchecking the "Tool Buttons" option, accessed through the "Toolbars" item on
the View Menu. Even if this Toolbar has been hidden you will still be able to access its op-
tions by using the File, Edit, and Job Menus. You can also change the placement of these
buttons by clicking on the left side of the Toolbar and dragging it to rest above or below the
Profile Description Toolbar. 

T o o l Butto ns T o o lb a r

The following descriptions are listed in the order in which they appear left to right on the
Tool Buttons Toolbar and are all accessible via the application Menus.

http://www.peersoftware.com/support/submit-a-case.html
http://www.peersoftware.com/support/submit-a-case.html
http://www.peersoftware.com/support/submit-a-case.html
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Ne w Pro file Located on the far left of the Toolbar, this button creates a new Profile. If an-
other Profile containing unsaved changes is currently open when this button
is pressed, a dialog box will open asking you if you want to save changes
to the current Profile before opening a new one (See Save Profile Button
Below). If you choose "No," the new Profile will replace the current one and
no changes will be saved.

Note:  If the current Profile has not been previously saved and "No" is chosen, the entire
Profile will be lost. 

Op e n Pro -
fi le

This button displays a "Select Profile File" dialog box allowing you to open
an existing Profile. By default, it will open in the path in which PeerSync has
been installed (i.e. C:\Program Files\PeerSync). Links to previously
opened Profiles can be accessible through a drop-down list opened by
clicking on the arrow key attached to this button.   

Sa ve  Pro -
fi le

This button allows you to save new Profiles, or save changes made to ex-
isting Profiles. If you are saving a new Profile, a "Save As" dialog box will
open allowing you to name and store it as an .SNC file in your choice of
folders, with "NewProfile" as the default name and the path in which Peer-
Sync has been installed as the default directory. Profiles and Profile modi-
fications must be saved in order to be subsequently accessible. 

La unch Cur-
re nt Pro file

This feature will launch the current Profile (Job/Global settings). During this
process, an instance of PeerSync will be started with the current Profile as
the first parameter and the arguments selected from the Options/Com-
mands screen as the subsequent parameters. You can automate this pro-
cess via a shortcut, through the startup folder, in the registry or as a service
by selecting one of these features from the StartUp Services screen. 

Note: An active Profile must be stopped/ restarted in order for any configuration changes to

take effect. 

T e rmin-
a te /Sto p
Active  Pro -
fi le

This option, when available, will allow a user to terminate an instance of
PeerSync that contains an active Profile that is connected to the Profiler. 

Re sta rt Act-
ive  Pro file

This option, when available, provides intelligent restart functionality that
eliminates/improves scanning upon PeerSync service/application restart.
This greatly improves performance during a restart (most commonly due to
profile changes, but also for any other reason). 

Note: An active Profile must be restarted in order for any configuration changes to take ef-
fect. 

Co nne ct:
Ena b le  Jo b
Co ntro l
Mo d e

This tool button becomes visible when the Profiler has been started and is in
a running state. The option connects the configuration Profile to the running
PeerSync. When selected, this option changes the Job List Display into
Job Control Mode. 

Disco nne ct:
Ena b le
Co nfig ura -
tio n Mo d e

This tool button becomes visible when the Profiler is running as a service
and Job Control Mode has been enabled. When selected, this option
changes the Job List Display into the default Configuration Mode. 
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Ad d  Jo b This button adds a Job to the bottom of the current list (See Profile Job List).
Jobs are named "New Job Item" and assigned a number by default. If you
have selected "Use Wizard to Add New Jobs" from the Options Menu, the
Wizard application will open when this button is pressed. The Wizard
provides a guided, step-by-step method for creating and configuring new
Jobs. A drop-down list attached to this button also allows you to choose
between "Add Job With Wizard" or "Add Job With Defaults" options. If the
former is chosen, Wizard will open every time this button is pressed. If the
latter is chosen, new Jobs added to the list through this button will be con-
figured manually using Selection Tree screens. These Jobs will use
whichever default settings are currently applied (See Job Menu, "Save De-
faults"). 

Note:  The first time "Add Job With Wizard" is chosen from the drop-down list, the Wizard
application will open. After that point Wizard will be launched by pressing the Add Job but-
ton.  

Co p y Jo b Creates a copy of the currently selected Job and places it at the bottom of
the Profile Job List. Copies will be numbered by default and named after
the original (i.e. "Copy 1 of My Syncs").

Re na me
Jo b

Allows you to rename the currently selected Job. Jobs can also be re-
named manually by clicking on them after they have been highlighted.  

De le te  Jo b Deletes the currently selected Job(s). When this button is pressed, a dialog
box will open asking you to confirm deletion. Jobs can also be deleted by
selecting them and then pressing the DELETE key on your keyboard.

Mo ve  Jo b
Up

Moves the currently selected Job up one place within the Profile Job List.

Mo ve  Jo b
Do wn

Moves the currently selected Job down one place within the Profile Job
List.

Sho w
Se le ctio n
T re e

Shows or hides the Selection Tree. If the Tree has been hidden, its space
will be filled within the interface by the currently selected Settings screen.
When the tree is hidden, screens can still be selected using the drop-down
list attached to the Back button. 

Jo b  Vie w Click the down arrow button next to this option to see the entire list of set-
tings that can be used to alter the view of the Job list. 

Se le c t Co lumns This option is available only when the Details view
mode is set. It is used to define the exact columns to
display in the Job list. Options include Source, Target,
Group, Modified, and State.

La rg e  Ico ns Select this option to represent each Job as a large icon
in the Job list panel.

Sma ll Ico ns Select this option to represent each Job as a small icon
in the Job list panel

Lis t Select this option to represent each Job as a list in the
Job list panel.
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De ta ils Select this option to represent each Job as a detailed
list in the Job list panel. Use the Select Columns option
to customize the view to show only the desired
columns.

Gro up  b y This option is only available when the Large Icons, Small
Icons, or Details view modes are selected. Use this op-
tion to group the Jobs based on the following categories:
Source, Target, Job Group, Job State, and Modified. 

Op tio ns This option is only available when the Details view mode
is selected. Use this option to customize the look of the
Job list panel by selecting: Show Columns, Show Grid
Lines, or Row Select. 

Ba ck Opens the screen located immediately above that, which is currently being
displayed. Settings screens can also be accessed using the drop-down
list located on the right side of the Back button; list items follow the same or-
der as that shown on the Selection Tree. 

Ne xt Opens the Profile Options screen located immediately below the screen
currently being displayed.

He lp
Ma nua l

Opens the application help file. You may also access specific parts of the
help file for features you are currently observing by pressing 'F1' on your
keyboard.

Profile Description

This field is located bellow the Tool Buttons Toolbar by default and displays a textual de-
scription of the current Profile. By default the description for an unsaved Profile will read "Pro-
file Job List." Unless you enter a unique description into this field, a default description will be
assigned upon saving the Profile; this default description will match the new Profile name.

Descriptions can be changed at any time; like all Profiler configurations, they must be saved
prior to closing the Profile or application in order to be stored. The Profile Description can
also be hidden by unchecking the "Profile Description" option, accessed through the "Tool-
bars" item on the View Menu.

Menus

1.  File Menu

File

This menu includes items allowing you to create and save new Profiles, open existing Pro-
files, create Profile desktop shortcuts, and exit the application. 

Ne w Create a new Profile. This feature is accessible from the Tool
Buttons Toolbar.
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Op e n Open an existing Profile. This feature is also accessible from
the Tool Buttons Toolbar.

Re o p e n Reopen a recently used Profile.

Sa ve Save the current Profile. This feature is also accessible from
the Tool Buttons Toolbar.

Sa ve  a s Rename and Save the current Profile.

Pro file  - Re ve rt to
Sa ve d

Revert to the last saved settings of the current Profile. 

Pro file  - Me rg e  Exis t-
ing

Merge an existing Profile into the current Profile.

Pro file  - Cre a te  Sho rt-
cut o n De skto p

Create and add a shortcut to PeerSync of the current Profile
and settings/command line arguments to the desktop.

Pro file  - Sa ve  De -
fa ults

Save the current settings of the Profile as the default settings.

Exit Close/exit the application.

2.  Edit Menu

Ed it

Allows you to move one step up or down between Selection Tree options screens while
providing a shortcut to the Run/View Current Profile Activity screen.

Ba ck Move back to the previous screen. This feature is accessible
from the Tool Buttons Toolbar.

Ne xt Move on to the next screen. This feature is also accessible
from the Tool Buttons Toolbar.

Run/Vie w Curre nt Pro -
fi le  

Go to the Run/View Current Profile Activity screen.

3.  View Menu

Vie w

Allows you to change the appearance of the application interface. "Hint" items enable or
disable pop-up hints activated by passing the mouse pointer over interface features, as
well as those displayed in the Status Bar located at the bottom of the application interface.
In addition to a description of Profiler features, hints will identify command line arguments
associated with those features (if any).

T o o lb a rs  - T o o l But-
to ns

Show/hide the Tool Buttons Toolbar.



PeerSync Help 18

Copyright © 1993-2019 Peer Software Inc. All Rights Reserved

T o o lb a rs  - Pro file  De -
scrip tio n

Show/hide the Profile Description Toolbar.

T o o lb a rs  - with Ho t
T ra cks

Show/hide the hot tracks features for the Toolbars.   

T o o lb a rs  - with T e xt
La b e ls

Show/hide description text labels for the Toolbars.

Se le c tio n T re e Show/hide the Selection Tree left side panel. This feature is
also accessible from the Tool Buttons Toolbar.1

Re fre sh Curre nt Pro -
fi le  Activ ity

Refresh Profile activity.

Sta tus  Ba r Show/hide the Status Bar at the bottom of the application.

H ints  - o n Ap p lica tio n Show/hide pop-up hints displayed on the application.

H ints  - o n Sta tus  Ba r Show/hide hints displayed on the Status Bar.

Fo ld e rs Allows for the ability to launch and display Source and Target
Folder selections in organized Explorer windows in a set view-
ing area. This helps the user to view and/or validate the Source
and Target Folder content before, after, and during synchroniz-
ation. These features may be helpful during evaluation and
when running and testing a newly modified Profile.  

Jo b  Gro up s Similar to Microsoft's Multiple Document Interface (MDI), Peer-
Sync now contains a multi-pane interface that allows the user to
organize groups of Jobs (Source and Target pairs) by any
convention necessary. User-specified tab controls allow quick
transition from one group to another. The traditional Job list in-
terface is still available for those who do not need the group
panes.

Pro file  Me ssa g e s Open the Profile Message Log file if it exists. The naming con-
vention of the Message Log files is as follows: Profile.snc.log,
where Profile represents the name of the current Profile. 

4.  Options Menu

Op tio ns

Allows you to select options pertaining to the way PeerSync, the Profiler and the Wizard in-
teract with each other and Windows Explorer.

Se t Co mp a tib il ity Option to run the Profiler, PeerSync, or PSWizard using re-
duced color mode.

Use  Wiza rd  to  Ad d
Jo b s

Available only if the Wizard is installed during the PeerSync in-
stallation. If selected, directs Profiler to open the Wizard applic-
ation as an easier and simpler way to add new Jobs to a Pro-
file. If not selected, the Add Job option will use the saved Job
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defaults. This feature is toggled on or off depending on which
option was used the last time that a Job was added (with De-
faults or with Wizard).

Cre a te  SNC e xte ns io n
a sso c ia tio n

If selected, creates an association of any file that has an SNC
extension with the Profiler to be used as the default application
to open these files. If not selected, the association of SNC files
with the Profiler will be removed. This feature is also access-
ible from the  Startup Services screen.

Ad d  Quick-Sync
Fo ld e r o p tio n to  Ex-
p lo re r me nu

If selected, will add our Quick-Sync feature to Windows Ex-
plorer. To access this feature, simply right-click on any folder in
Explorer, or on your Desktop, and you will be able to sync the
folder to selected Target Folder(s), add the Job to a Quick-
Sync Profile that is stored out in memory, and administer the
ability to modify/add to the Jobs using the Profiler. This feature
is also accessible from the Startup Services screen. 

Che ck Fo r Mo d ifie d
Pro file

If checked, this option will activate a timer to check if a change
occurred to the Profile every 3 seconds and will prompt for a re-
load. 

On Pro file  Exit This option allows for the ability to do one of the following when
exiting the Profiler while it is connected to an Active Profile: Dis-
play Terminate Active Profile Dialog, Leave Active Profile Run-
ning, or Terminate Active Profile.

Glo b a l Se tting s Displays various settings including Recovery/Offline Options,
Performance Options, Reporting Options, Display Options,
ACL Options, Bi-directional Options, Managed Files Options,
and Current Command Line Arguments.

5.  Run Menu

Run 

Allows you to Launch the Current Profile, Terminate the Active Profile and Update the Cur-
rent Profile.

No te : An active Profile must be restarted in order for any configuration changes to take ef-
fect. 

La unch Curre nt Pro file This feature will launch the current Profile (Job/Global settings)
in PeerSync. During this process, an instance of PeerSync will
be started with the current Profile as the first parameter and the
arguments selected from the Options/Commands screen as
the subsequent parameters. You can automate this process
via a shortcut, through the startup folder, in the registry or as a
service by selecting one of these features from the Startup Ser-
vices screen. This feature is also accessible from the Tool But-
tons Toolbar. 
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T e rmina te  Active  Pro -
fi le

This option, when available, will allow a user to terminate an in-
stance of PeerSync that contains an active Profile which is con-
nected to the Profiler. This feature is also accessible from the
Tool Buttons Toolbar.

Up d a te  Curre nt Pro file This option, when available, will allow a user to update an in-
stance of PeerSync with the current Profile opened in the Pro-
filer.

Re sta rt Active  Pro file This option, when available, provides intelligent restart func-
tionality that eliminates/improves scanning upon PeerSync ser-
vice/application restart. This greatly improves performance
during a restart (most commonly due to profile changes, but
also for any other reason). 

Pre -Sync Re p o rt This executes a pre-sync report of the currently selected Jobs.
During this process, files and folders will not be modified and
persistent arguments set for the current Profile will be ignored.
A report will be created and displayed with the work that would
be performed if a synchronization was actually run. This feature
may be quite helpful during evaluation and when running and
testing a newly modified Profile. Pre-Sync Report options are
as follows:

Run a  Pre -Sync Re p o rt (d o  no t sync fi le s / fo ld e rs)
Starts PeerSync to analyze the work that would be performed if
synchronization was actually run. During this process files and
folders will not be modified. The report file, PreSync.Log, will be
displayed at the end of the run. 

Ove rwrite  e xis ting  Pre -Sync re p o rt fi le s
Enabled by default, this setting overwrites the PreSync.Log file
when the Pre-Sync process completes.

Sho w Pre -Sync re p o rt fi le  a t e nd  o f run
Enabled by default, this setting will open and display the
PreSync.Log report file after the Pre-Sync process completes.

Re p ro ce ss Fa ile d
Eve nts

This option, when available, will allow for Failed Files to be pro-
cessed. Failed Files are files that have failed to be replic-
ated/synchronized possibly due to Retries being turned off or
exceeded.

Re p ro ce ss Fa ile d
Sca ns

This option, when available, will allow for Failed Scans to be
processed. Failed Scans will only occur if a scan is interrupted
or cannot run and the Re try  fa ile d  co nne ctio n e ve ry  x
minute s  option is disabled.

Note:  Because it is separate from the core software engine, the Profiler allows you to create and configure new
Profiles while PeerSync runs Synchronization Operations at optimum efficiency. In both this Help file and on Profiler
screens, "Current"  refers to the Profile currently being configured but not yet launched, while "Active" most often
refers to the Profile presently being run by the PeerSync engine.
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6.  Job Menu

Jo b

Allows you to manipulate Jobs within the current Profile. If "Allow Multiple Selection" has
been checked on this menu, you will be able to select and apply settings to Multiple Jobs.

Ad d  - Jo b  with De -
fa ults  

Creates and adds a Job to the current Profile using the saved
Job defaults. This feature is also accessible from the Tool But-
tons Toolbar and the Profile Job List Pop-Up Menu.

Ad d  - Jo b  with W iza rd Creates and adds a Job to the current Profile suing a Wizard
which guides in the creation of a Profile. This feature is also ac-
cessible from the Tool Buttons Toolbar and the Profile Job List
Pop-Up Menu.  

Co p y Creates a duplicate copy of the currently selected Job and all
of its settings. This feature is also accessible from the Tool But-
tons Toolbar and the Profile Job List Pop-Up Menu.

Re na me Allows for the renaming of the selected Job. This feature is also
accessible from the Tool Buttons Toolbar and the Profile Job
List Pop-Up Menu.

De le te Allows for the deletion of the currently selected Job(s). This fea-
ture is also accessible from the Tool Buttons Toolbar and the
Profile Job List Pop-Up Menu.

Cle a r All This will close the current Profile allowing for the user to create
a new Profile.

Mo ve  Up Moves the currently selected Job up one in the list. This feature
is also accessible from the Tool Buttons Toolbar and the Pro-
file Job List Pop-Up Menu.

Mo ve  Do wn Moves the currently selected Job down one in the list. This fea-
ture is also accessible from the Tool Buttons Toolbar and the
Profile Job List Pop-Up Menu.

Se le c t All This will select all of the Jobs. 

Inve rt Se le c tio n This will change the selected state of all the Jobs.

Allo w Multip le  Se le c-
tio n

Gives the ability to select and apply settings to Multiple Jobs.

Cre a te  Auto  Jo b
Na me

This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which
make it a simple task to organize the Job list.

Lo g  File  - Vie w Display the log file for the selected Job.

Lo g  File  - Cle a r Clear the log file for the selected Job.

Me ssa g e  Lo g  File  -
Vie w

Display the message log file for the selected Job or profile.
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Me ssa g e  Lo g  File  -
Cle a r

Clear the message log file for the selected Job or Profile.

Sa ve  De fa ults Stores the currently selected Job Settings as the default for all
subsequent newly added Jobs. 

7.  Help Menu

He lp

While allowing you to access Help files and the About screen, this menu also provides
demonstrations of PeerSync's Real-Time Monitoring and Scheduled Operation modes.

De mo s This option allows the user to instantly run either a Real-Time
or Scheduled test Profile to demonstrate PeerSync's synchron-
ization capabilities. 

We b  Site This menu item will have many links back to our web site for
product information, downloads, updates and support.

Online  Re so urce s Provides links to online demos/tutorials/documents and for-
ums.

Che ck fo r Up d a te s... Checks whether you are using the latest version of PeerSync.
This process requires an Internet connection in order to trans-
mit your registration information to our web server for validation.
This feature also has the ability to check updates for all Peer-
Sync related products (if they are installed) directly from the
Profiler. This includes the PSListener, PeerLock, and the Peer
Administrator. A menu option to check for updates will be dis-
played for all products that have been installed.

Pe e rSync He lp Will open the application help file to the contents section. You
may also access specific parts of the help file for features you
are currently observing by pressing 'F1' on your keyboard.

Inc lud e  Unche cke d
Jo b s in Sup p o rt Info
File

If enabled, the Create Support Info File on the Desktop... log
and configuration gathering process will collect Job information
from un-checked Jobs.

Cre a te  Sup p o rt Info
File  o n the  De skto p ...

This option will compile all Profile related files into a zip folder
on the Desktop. This information can be submitted to our sup-
port team for analysis. The following is a list of files that are in-
cluded if they exists: 

Pe e rSync File s :

[ProfileName].snc - Profile

PSDEF.CFG - Configuration File

[ProfileName] .tot.xml - Total Support File

[ProfileName]_np .tot.xml - Total Support File (Non Per-
sistent)

[ProfileName] .cur.xml - Current Support File 
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[ProfileName]_np .cur.xml - Current Support File (Non Per-
sistent)

[ProfileName].las.xml - Last Support File

[ProfileName]_np.las.xml - Last Support File (Non Persist-
ent)

[ProfileName].snc[.bak*].log - Profile Error Log Files

PSError.Log - Application Error Log File

[JobName].[bak*].log - Job Level Log Files

[JobName].flt[.bak*].log - Job Level Error Log Files

[JobName].del[.bak*].log - Deletion Cleanup Log Files

[ProfileName].tlr - Time Last Run Log File

[%VariableNames%].txt - Also included are Variable
Data Import and Job Data Im-
port files

ADDCache.cur.txt - Current cache file of Add
events

ADDCache.las.txt - Last cache file of Add events

UPDCache.cur.txt - Current cache file of Update
events

UPDCache.las.txt - Last cache file of Update
events

DELCache.cur.txt - Current cache file of Deleted
events

DELCache.las.txt - Last cache file of Deleted
events

JSCCache.cur.txt - Current cache file of Job
Scans

JSCCache.las.txt - Last cache file of Jobs Scans

EXCCache.cur.txt - Current cache file of Excluded
items

EXCCache.las.txt - Last cache file of Excluded
items

FFLCache.cur.txt - Current cache file of Failed
Events

FFLCache.las.txt - Last cache file of Failed
Events

JSHCache.cur.txt - Current cache file of Historical
Data

JSHCache.las.txt - Last cache file of Historical
Data

MSGCache.cur.txt - Current cache file of Mes-
sages

MSGCache.las.txt - Last cache file of Messages

CTPCache.cur.txt - Current cache file of Copy
Thread Progress

CTPCache.las.txt - Last cache file of Copy
Thread Progress

SNCCache.cur.txt - Current cache file for the Pro-
file
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SNCCache.las.txt - Last cache file for the Profile

MFLCache.cur.txt - Current cache file of Managed
Files List items

MFLCache.las.txt - Last cache file of Managed
Files List items

SupportInfo.txt - Contains the list of files that
PeerSync will try to include in
the support zip folder

Pe e rLo ck File s :

PLDef.CFG - Configuration File

PeerLock[.bak*].log - PeerLock Log Files

 The files will be zipped and stored on the Desktop for easy at-
tachment to emails.  A copy of the zipped folder will also be
stored in the PeerSync installation folder (i.e. C:\Program
Files\PeerSync\InfoFiles\SupportInfo_date/time .zip). 

Cre a te  Syste m Info
File  o n the  De skto p ...

Creates a system info file (SysInfo.nfo) on the Desktop. A copy
of the file will be kept in the InfoFiles folder located in the Peer-
Sync installation folder (i.e. C:\Program Files\PeerSync\In-
foFiles\SystemInfo_200810081953.zip - where 200810081953
represents yyyymmddhhss respectively). Creating the System
Information File takes a few minutes. Keeping a copy of the
System Information file in the InfoFiles folder eliminates the
need to wait for the creation of a new file whenever one is
needed and provides an archive of previous system states
that can be used for troubleshooting.

Re g is te r Pe e rSync Will display the PeerSync Registration Screen to activate the
PeerSync trial version or upgrade the current license.

Lice nse  Info rma tio n Will display the different Product Editions and Licensing avail-
able for PeerSync. Will also display what the current edition
has available as well as other useful information about the cur-
rent package you are running.

Ab o ut Pe e rSync Will display an about screen, which contains information about
the current PeerSync you are running.

8.  Evaluation Menu

Eva lua tio n

Only displayed in evaluation copies of the software, this menu item will contain features that
we believe are helpful to the user during evaluation such as demos, README files, and
other evaluation oriented features.

Re a d  me  firs t... Opens the Evaluation.txt file that provides instruction on how to
run the built-in Demo, add your first Job, run your first Profile and
steps on how to use Quick-Sync and the Wizard. 
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Re vie we r's  Guid e Opens the Reviewer's Guide manual that provides a quick
product overview and useful evaluation scenarios and demon-
strations. 

Re a l-T ime  Mo nito ring
De mo  

Launches a demo that will synchronize the designated source
and target folders automatically upon change in real-time. 

Sche d ule d  Op e ra tio n
De mo

Launches a demo that will synchronize the designated source
and target folders every 15 seconds.

End  De mo  Available only if PeerSync is running either the "Real-Time" or
"Scheduled" demo. Selecting this option will terminate the run-
ning demo.

Lice nse  Info rma tio n Opens the Licensing dialog which lists all the options/features
that are Active or Inactive in the product. The About screen can
be accessed from this dialog by clicking on the Register but-
ton. 

Buy No w ... Opens the web browser to our online purchase page from
where the product can be purchased directly. 

9.  Popup View Menu

Vie w Po p up  Me nu

Activated by right clicking on the Tool Buttons Toolbar, Profile Description Toolbar, or the
Status Bar. Some of these options can be selected from the View Menu.

T o o l Butto ns Show/hide the Tool Buttons Toolbar.

Pro file  De scrip tio n Show/hide the Profile Description Toolbar.

with Ho t T ra cks Show/hide the hot tracks features for the Toolbars.   

with T e xt La b e ls Show/hide description text labels for the Toolbars.

Sta tus  Ba r Show/hide the Status Bar at the bottom of the application.

10.  Popup Tray Icon Menu

Pe e rSync T ra y  Ico n Po p up  Me nu

Activated by right clicking on the Tray Icon. The Tray Icon is only accessible when Peer-
Sync is running as an application (not as a service) and has the "Show tray icon" option en-
abled in the Options/Commands window. 

Vie w Lo g  File  Allows you to access, launch and view Log files in the default
text editor for the current Profile.

Vie w Me ssa g e  Lo g
File

Allows you to access, launch and view the Message log file for
the current Profile.
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Vie w Ad min Fo ld e r Allows you to access, launch and view Admin log file Folders in
Explorer for the current Profile.

Op e n So urce  Fo ld e r Allows you to access, launch and view Source Folders in Ex-
plorer for the current Profile.

Op e n T a rg e t Fo ld e r Allows you to access, launch and view Target Folders in Ex-
plorer for the current Profile.

Sho w Sta tus  D isp la y  This item will show the PeerSync Status Display dialog box
during synchronization so the user can see activity, status, and
other information while PeerSync is running. This feature is only
available if the Display Status in the PeerSync feature was en-
abled for the current Profile.

Co nne ct/La unch Pe e r-
Sync Pro file r

This item will open the Profiler, if it is not already open, and
send status messages to be displayed on the Run/View Cur-
rent Profile Activity screen. This connection feature will only
work if the Display Status in Profiler feature was enabled for the
current Profile.

Ab o ut Pe e rSync Will display an about screen, that contains information about
the current PeerSync you are running.

Exit Pe e rSync Allows you to close/exit the current session of PeerSync.

Note: A pop-up hint message will be displayed when you mouse over the Tray Icon. This will provide key informa-
tion about the current PeerSync application running including the Profile name and the status of VSS if it is running. 

11.  Profile Job List

Located beneath the Toolbars, this window displays all Jobs associated with the current Pro-
file. Use of this list is central to the Profile-building process; all configurations made on the
Job Settings screens (accessed through the Selection Tree) will only be applied to those
Jobs currently selected from this list. 

To select a Job, highlight it using the left mouse button. The "Allow Multiple Selection" item
must be checked on the Job Menu in order to select and have settings applied to Multiple
Jobs. To select Multiple Adjacent Jobs, highlight the first Job, hold down the SHIFT key on
your keyboard, and then highlight the last Job you wish to include. You can also hold down
the SHIFT key and then use the up or down arrow keys on your keyboard. To select Multiple
Nonadjacent Jobs, highlight the first Job, then hold down the CTRL key on your keyboard
and click on each additional Job you wish to include. Once you have selected a Job or Jobs,
move through the screens found on the Selection Tree and apply settings as desired. High-
lighting on the selected Job(s) will appear gray as you move through these screens, indicat-
ing that any configured settings will only be applied to those selected Jobs. 

The box appearing to the left of each Job must be checked in order for that Job to be in-
cluded in the active Profile when launched. Although unchecked Jobs will not be processed
upon launch, they will be saved within the Profile for future use and/or selection. 

Upon creating a new Profile, an initial Job will be displayed bearing the name "New Job Item
1" by default (this applies to manual Job creation only). The first New Job added within an ex-
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isting Profile will also bear this name. Successive Jobs will be named "New Job Item 2,"
"New Job Item 3," etc. Any selected Job can be renamed through the "Rename" Tool Button,
through items found on both the Job Menu and Profile Job List Pop-Up Menu described be-
low, or manually by selecting it a second time using the left mouse button.

In both new and stored Profiles, you can navigate the Profile Job List as well as add, copy,
delete, and navigate Jobs using the Tool Buttons; using items from the Job Menu, and by us-
ing items found on the Profile Job List Pop-Up Menu described below. You can also navigate
the list and delete items using the DELETE and up and down arrow keys on your keyboard. 

Note:   In order to navigate or modify the Profile Job List, you must have first clicked somewhere within the Profile Job List
window; this ensures that during configuration any options chosen from the Selection Tree screens are applied exclusively
to the currently selected Job. 

The height of the Profile Job List window can be changed by passing the mouse pointer over
its bottom border until a double/Arrow cursor appears, then dragging the window to meet the
desired size. At minimum size, only a single Job may be viewed. Adding a new Job while this
view is in effect prompts display of up and down arrow buttons in the right side of the window.
These buttons allow you to view different Jobs within the list. 

Jo b  Lis t Po p -Up  Me nu

Activated by right clicking on the Profile Job List, this menu duplicates the mostly used fea-
tures found on the Job Menu while providing some additional items listed below. 

Synchro nize  Se le c te d
Jo b s 

This executes an immediate, non-persistent synchronization of
the currently selected Jobs ("non-persistent" refers to a one-
time sync process; "persistent" refers to ongoing sync opera-
tions such as Real-Time Monitoring or Scheduled Operations).
During this process, persistent arguments set for the current
Profile will be ignored. When the button is released, a confirma-
tion dialog will be displayed indicating which Jobs have been
selected from the active Profile and asking you to confirm syn-
chronization through a "Yes" or "No" button. If "Yes" is selected,
the synchronization will proceed. A message will always be
displayed upon completion of this operation. Other sync opera-
tions allow you to choose whether or not such a message will
be displayed. 

Cre a te  Pre -Sync Re -
p o rt

This executes a pre-sync report of the currently selected Jobs.
During this process, files and folders will not be modified and
persistent arguments set for the current Profile will be ignored.
A report will be created and displayed with the work that would
be performed if a synchronization was actually run. This feature
may be quite helpful during evaluation and when running and
testing a newly modified Profile.  

Co nne ct: Ena b le  Jo b
Co ntro l Mo d e

See description for this option under Tool Buttons. 

Disco nne ct: Ena b le
Co nfig ura tio n Mo d e

See description for this option under Tool Buttons. 
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Sta rt Pe nd ing  Jo b :
Na me

See description for this option under Job Control Mode. This op-
tion is only available when the Job List Display is in Control
Mode. 

Sta rt Pe nd ing  Jo b :x See description for this option under Job Control Mode. This op-
tion is only available when the Job List Display is in Control
Mode. 

Lo g  File  - Vie w This menu item allows you to view Log reports by opening the
file in a text editor. This feature is also accessible from the Re-
porting screen. 

Lo g  File  - Cle a r This menu item allows you to clear Log reports. This feature is
also accessible from the Reporting screen. 

Me ssa g e  Lo g  File  -
Vie w

This menu item allows you to view Message Log reports by
opening the file in a text editor. This feature is also accessible
from the View Menu item. 

Me ssa g e  Lo g  File  -
Cle a r

This menu item allows you to clear Message Log reports. This
feature is also accessible from the View Menu item. 

Jo b  Lis t Vie w Op tio ns This feature enables/disables the ability to display the "Click
Here to Add Another Job" Job every time a new Job has been
created.

Use  "<Click  He re  to
Ad d  Ano the r Jo b >"
Fe a ture

This menu item will add a new Job to the end of the Job list
named "<Click Here to Add Another Job>" every time a new
Job is created.

Sup p re ss  Ad d  Jo b
Co nfirm D ia lo g

This menu item will suppress the Confirmation Dialog that is
launched when clicking on the "<Click Her to Add Another
Job>" Job.

Vie w Jo b  Gro up s* (En-
hanced Package) 

This feature enables/disables the ability to allow the user to or-
ganize/categorize Jobs within a Profile into Job Groups. 

When this feature is enabled, you can create as many Job
Groups as desired. Each Job Group is represented by a Tab.
Each Tab displays the Job Group Name, the number of
Checked Jobs and the number of Total Jobs for the corres-
ponding Job Group, in the following format:  GROUP NAME
[CHECKED JOBS / TOTAL JOBS]

Se le c t All This menu item will select/highlight all Jobs within the current
Job Group for a quick and easy way of modifying all Jobs
within a given Profile. If this feature is not enabled you must turn
on the Allow Multiple Selection feature on from the Job Menu.

La st Run On This is a display of the last run date/time of the selected Job
within the current Profile. This is the date/time that will be used
when comparing files for the Bi-directional Synchronization
Mode option on the File Options screen. This feature is also
displayed on the from the  Folder Selection screen. 

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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La st Run On - Re se t This allows a means of resetting the last run date/time of the
selected Job within the current Profile. 

Jo b  Gro up  Po p -Up  Me nu* (Enhanced Package) 

Activated by right clicking on the Profile Job List, this Popup menu allows for the following
features:

Ad d  Jo b
Gro up

This menu item will create and add a new Job Group to the existing Profile. 

Ed it o r De -
le te  Jo b
Gro up s

These menu items will display the Modify Job Groups Dialog, allowing for
the adding, renaming, moving, re-ordering, modifying and/or the deletion of
Job Groups. 

Ed it Jo b
Gro up s D ia -
lo g

To add a Job Group click "New," then type the desired name into the field
located at the bottom of the dialog. Repeat this process for each Job
Group you wish to add. Entries can be deleted by selecting them from the
list and clicking the "Delete" key at the bottom of the box. You can also use
the "Up" and "Down" buttons to reorder the items.

All T a b s -
Che ck All
Jo b s

This menu item will set all Jobs to the checked state allowing for a quick
and easy way of checking all Jobs across all Job Groups. 

All T a b s -
Unche ck All
Jo b s

This menu item will set all Jobs to the unchecked state allowing for a quick
and easy way of unchecking all Jobs across all Job Groups. 

* Note:  Some features described on this page require the Enhanced Package.

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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Selection Tree

Screens can be accessed through the Selection Tree that are used to set synchronization cri-
teria for individual Jobs (Job Settings), as well as set global properties relating to execution
of the entire Profile and all related Jobs (Global Settings). Once you have selected a Job or
Jobs from the Profile Job List , all options configured on Job Settings screens will only be ap-
plied to those selections. After synchronization criteria for all individual Jobs have been es-
tablished, use the Global Settings screens to set global properties relating to all Jobs, as well
as choosing how you would like the Profile to be executed. The Profile Job List will appear
gray when any Global Settings screen is displayed, indicating that all properties set on that
screen will be applied to the entire Profile.

Se le c tio n T re e  
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The Selection Tree is located at the left side of the Profiler interface. The Selection Tree
can also be hidden by unchecking the "Selection Tree" option, accessed through the
"Toolbars" item on the View Menu.

Se le c tio n T re e  Mo d e s The Selection Tree Modes are located in a drop-down list
above the Selection Tree. These modes can be used to
show/hide PeerSync configuration windows. The Selection
Tree can be set to Ba s ic , Inte rme d ia te , Ad va nce d  or Cus-
to mize d . Some Selection Tree items will not be accessible
depending on the package you are currently using.  "Basic" is
the default Selection Tree Mode. 

Se le c tio n T re e  Ca t-
e g o rie s

New in PeerSync v7.4, customers who are running PeerLock
v2.0.1 or higher on the same machine as PeerSync will now be
able to configure PeerLock directly from the PeerSync Profiler.
Configuration options include the ability to link specific Peer-
Sync Profile Jobs to PeerLock, ability to access/view/edit the
PeerLock Global Settings from the PeerSync Profiler, ability to
install/uninstall the PeerLock Service, as well as launch and
view PeerLock directly from the PeerSync Profiler. 

The Selection Tree can be categorized into four sections:
Pe e rSync, Pe e rLo ck, Sta rtup /Se rv ice , and Run/Vie w. By
default these categories will not be shown unless you have
PeerLock v2.0.1 or newer installed on the same computer as
PeerSync. You can manually display these categories by
adding PeerLock  windows to the Custo mize d  tree mode.  

Se le c tio n T re e  Po p -Up  Me nu

Activated by right clicking on the Selection Tree, this menu duplicates the items listed in the
Selection Tree, as well as, the items listed in the drop-down list located on the right side of
the Back button on the Tool Buttons Toolbar. When right-clicking on the PeerSync Selec-
tion Tree Category, this Menu offers the following options:

Sho w All Pro file  Op -
tio ns

This feature will toggle between showing all Profile Options and
the Custom Options in the Selection Tree. 

Custo mize This feature will allow the user to select which Profile Options to
display in the Custom Selection Tree, when the "Show All Pro-
file Options" is turned off. When selected the user will be given
the dialog box shown below to pick and choose which Profile
Options to use.

Se le c tio n T re e  Ca te g o rie s
PeerSync
PeerLock
Startup/Service
Run/View

http://www.peersoftware.com/solutions/file-locking-for-ms-dfsr.html
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1.  PeerSync

1.1  PeerSync Job Settings

Pe e rSync Jo b  Se tting s  Scre e ns
Folder Selection
Automation
Blackout Settings
Scan Limitations
File Options
NFS Settings
Permissions
Open Files
Managed Files
Performance
Byte Replicator
Revisioning
Miscellaneous
Additional Features
Exceptions
Reporting
Admin Reporting
Email Reporting
Pre/Post Process
Advanced Options
PeerSync Global Settings
Options/Commands
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Note:  Some settings are ignored when enabled in conjunction with other settings. For example, report summaries
are ignored in multiple threaded or enhanced Real-Time mode.

1.1.1  Job List Display

T o p ics
Configuration Mode
Job Control Mode
Job List Popup Menu

Note:  The Job List Display is the area within the Profiler listing all the Jobs and visually categorizing them based
on various modes. 

The Jo b  Lis t D isp la y  is the area within the Profiler lists all the Jobs and visually categor-
izes them based on various modes for improved Job review. 

Co nfig ura tio n Mo d e

This is the default mode used by the Profiler. Here, each Job is categorized into one of the
following states:

Ena b le d All the Jobs which have a checked check box will be listed in
this category. 

D isa b le d All the Jobs which have an un-checked check box will be listed
in this category. 

The Jo b  Lis t D isp la y  is the area within the Profiler listing all the Jobs and visually categor-
izing them based on various modes for improved Job review. 

The Profiler supports Jo b  Co ntro l functionality that allows every Job to be stopped, started,
or restarted individually. To enter the Jo b  Co ntro l mode, right click in the Jo b  Lis t D isp la y
and select Co nne ct: Ena b le  Jo b  Co ntro l Mo d e  from the Profile Job List pop-up menu. 

Jo b  Co ntro l Mo d e

Active This category lists Jobs which are running successfully without
any errors. 

Active  w/Erro rs This category lists Jobs which are running but contain errors
typically indicating connectivity issues.
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Active  w/Wa rning s This category lists Jobs which are running but contain errors
typically indicating Failing Events. 

Ina ctive Lists Jobs that were disabled or were newly added and the Pro-
filer does not yet know information about them. As soon as the
Profile is saved, newly added Jobs will be added to the Pending
state. 

Pe nd ing Lists Jobs that were enabled or were newly added to the running
Profile but have not yet been started.

Sto p p e d This category lists Jobs which have been stopped since the Pro-
file has been started.

Jo b  Co ntro l Ba r

The Jo b  Co ntro l Ba r buttons allows every Job to be stopped, started, or restarted indi-
vidually. 

Sta rt Pe nd ing  Jo b s:x Start all the Jobs that are in a Pending state where x represents
the total number of Jobs that are in a Pending state.

Sta rt Jo b Start the selected Job that is in a Sopped state.

Sto p /Re sta rt Jo b Stop or restart the selected Jobs that are in an Active state.

Sa ve  Pro file  a nd  Re -
fre sh

When Job changes are made to the running Profile, a Sa ve
Pro file  a nd  Re fre sh option can be seen at the bottom right
corner of the Jo b  Lis t D isp la y . Saving will refresh the Jo b
Lis t D isp la y  to reflect any changes. The Job Control Bar but-
tons become disabled and grayed out to indicate that Profile
changes were made which require saving. 

Note: An active Profile must be restarted in order for any configuration changes to take effect. 

Co nfig ura tio n Mo d e  Co lumns

The following columns can be viewed in the Job List Display when in Configuration or Con-
trol Mode:

So urce Displays the source paths of the listed Jobs.

T a rg e t Displays the target paths of the listed Jobs.

Gro up Lists the name of the group each Job belongs to.

Sta te Identifies the State each Job belongs to.

Mo d ifie d Displays the time and date the last time a Job was modified.
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1.1.2  Folder Selection

T o p ics
Folder Selection Overview 
Source Folder Selection
Target Folder Selection 
Include Sub-folders
Swap Source and Target Folders 
Last Save
Last Scan
Other Features

Note:  Features listed on this page may require the TCP WAN Connector, NetApp, or NFS options.

Each Job within a Profile is initially defined by using the Folder Selection screen to select a
Source and Target Folder. The contents of a Source Folder will be synchronized to a Target
Folder according to criteria further defined on other Settings screens. Once you have high-
lighted a Job or Jobs from the Profile Job List, this screen offers several different methods to
locate and select folders for synchronization. File paths can be typed manually, or you can
browse local and network drives to locate and select your desired folders. 

So urce  Fo ld e r Se le c tio n

The options listed on this page can be accessed from the Folder Selection window. The
following options are available for selecting a Source folder.

Us ing  No rma l Mo d e  Select a "Normal" Source folder if you can navigate to the de-
sired Source directory via a Local Path, a UNC Path, or a
Mapped Drive. This selection requires that the machine on
which PeerSync is running has full access to the desired
Source directory. In some instances Network Logon may be re-
quired. 

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
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Select a Source Folder by typing the file path into the field
provided or by using the Select Source Folder Button. By de-
fault, the Source Folder field will contain the path in which Peer-
Sync has been installed: in most cases this will be C:\Program
Files\PeerSync\Source. The convention outlined in this path
must be used when manually typing entries, (i.e. a drive must
be specified followed by a colon, with subsequent folders sep-
arated by backslashes). This field is not case sensitive, though
spaces may only be entered where they are part of valid folder
names (i.e. "Program Files"). No space should appear
between slashes and folder names. This field also supports
File/Folder Path Variables. 

UNC names can be entered manually, or can be selected from
the Network Neighborhood using the "Browse for Folder" dia-
log box (see Select Source Folder Button). UNC names will ap-
pear in the form \\COMPUTER\SHAREDDEVICE\PATH. For
example: \\SERVER11\D\USERDATA.

Starting with the release of v9.0, we now support the ability to
connect to a remote NetApp filer and register for real-time
event notification.  Please visit http://www.peersoftware.com or
contact Sales for license information.

Note:  We do not recommend using UNC paths for folders that reside on the
local machine, in this scenario you should use the local path to that folder.

Folders can also be dragged and dropped from MS Windows
Explorer into the Source Folder Field for automatic insertion.

The Source Folder Field holds a folder selection History of up
to 10 entries. They can be selected by clicking on the drop
down button located to the right of the field. 

The current path will be displayed below the Source Folder
Selection Field. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to cor-
rect the invalid path and you exit the Source Folder Selection
field, the application will throw a message and use the default
PeerSync installation path C:\Program Files\PeerSync\Source
instead.

The Host Name and User Name & Password values (if
provided) are displayed above the Source Folder Selection
field (see Network Logon).

Us ing  T CP Mo d e  Select a "TCP" Source folder if the Source directory is outside
the scope of the machine on which PeerSync is running. TCP
enables access to machines not located on the same network
as PeerSync. As a prerequisite, the PSListener needs to be in-
stalled and running on the remote Source machine in order for

http://www.peersoftware.com
http://www.peersoftware.com/contact.html
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PeerSync to be able to communicate with it. This feature sup-
ports encryption and compression.

Note: We strongly recommend the use of a VPN when transferring files over
the public Internet for security purposes. Otherwise, you should use our En-
cryption feature with a user name and password to protect data and all commu-
nication as it is being transferred. 

When selecting the TCP Mode for the first time the Source
TCP/Port Configuration window will open automatically for
Source Folder configuration. Otherwise, the previously entered
TCP folder path will be displayed. This path can be manually
edited by typing directly into the field provided or by using the
Configuration button. The convention outlined in this path must
be used when manually typing entries, (i.e. the key word TCP
must be specified followed by a colon, two backslashes, the
Source IP address or machine name, and subsequent folders
separated by backslashes). This field is not case sensitive,
though spaces may only be entered where they are part of
valid folder names (i.e. "Program Files"). No space should ap-
pear between slashes and folder names. This field also sup-
ports File/Folder Path Variables. 

The Source Folder Field holds a folder selection History of
more then 10 entries. They can be accessed by clicking on the
drop down button located to the right of the field. 

The current path will be displayed bellow the Source Folder
Selection Filed. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to cor-
rect the invalid path and you exit the Source Folder Selection
field, the application will throw a message and use the last
valid TCP path specified or the default path TCP:\
\127.0.0.1\C\Source. 127.0.0.1 represents the loopback IP ad-
dress of the local host (i.e. the machine on which PeerSync is
running).

The provided Host Name and User Name & Password values
are displayed above the Source Folder Selection field. 

Re la te d  Op tio ns
Source TCP/Port Configuration
Source Folder Configuration Button
Select Source Folder Button
Explore/Open/Create Button
Source Folder Popup Menu

Notes: 
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1. The TCP features listed on this page require the TCP WAN Connector option. Please visit http:/ / www.peersoft-
ware.com or contact Sales for additional information.

2. You cannot monitor a TCP source in Real-Time.

3. NetApp CIFS real-time support requires the NetApp option.  Please visit http:/ / www.peersoftware.com or con-
tact Sales for additional information.

4. NFS real-time support requires an NFS and NetApp enabled license.  Please visit http:/ / www.peersoftware.com
or contact Sales for additional information.

5. Bi-directional synchronization mode, as well as other non applicable features are ignored when using a TCP
Source.

6. Selecting a TCP Source and a TCP Target for the same Job is not supported.

7. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the syn-
chronization process (Source or Target).

We strongly recommend the use of a VPN when transferring files over the public
Internet for security purposes. Otherwise you should use our Encryption feature
with a user name and password to protect the data and all communicaiton as it is
being transferred.

This option requires our PSListener tool to be installed on the remote computer
with identical Encryption and Port configuration.

So urce  T CP/Po rt Co nfig ura tio n 

The Source Folder Configure Button is activated by clicking on the Co nfig ure  button located
in right lower corner of the Source Folder panel/section. Selecting the Configure button opens
the Source TCP/Port Configuration window. Alternatively, you may right-click on the Source
Folder field and select Configure: Source Folder (See Source Folder Popup Menu). 

T CP Co nfig ura tio n T a b

General Settings

Ho st Na me Enter the IP address or machine name of the Source Folder into this filed.
You may use the machine name only if the remote Source Machine resides
on the same network as that on which PeerSync is running. 

Pa th o n
Ho st

Provide the full path (i.e. C:\Documents and Settings\Source) to the Source
folder in this field. The path entered needs to be a local path without a ma-
chine name or UNC format. This field does not validate the existence of the
path you provide therefore you must exercise great care when doing so. If
the path does not exist, PeerSync will create it during run time as long as a
valid host name or IP address has been provided and it can find the drive
letter specified.

A UNC path can be entered for the Pa th o n Ho st selection for a T CP
so urce  or T CP ta rg e t.   This gives the ability to configure non-windows to
non-windows Jobs over TCP (i.e. Ne tAp p  to  Ne tAp p  o ve r T CP).  Note:
This will make use of a new NET WORK constant in the source or target
selection. 

Example: 

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
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TCP:\\WindowsServer\NETWORK\\NetAppSVM\vol1\Data

Care must be exercised if your PSListener contains a "Root Path". If you
specify such a path in your PSListener it will behave like an FTP server that
sets Root Paths to limit user access to the local file system. If a "Root Path"
exists on the PSListener it will limit PeerSync's ability to access directories
on the remote device. PeerSync will only be able to access directories
equal to or bellow the specified "Root Path" level provided that it meets the
Po rt and Encryp tio n requirements. In no circumstances can PeerSync
access directories located above this path. If the remote path you enter in
the Path to Host  field references a directory above the "Root Path", Peer-
Sync will create that folder structure at runtime bellow the "Root Path". 

Example: 

PSListener "Root Path" = C:\Backup\Users\Admin
PeerSync's "Path to Host"  = C:\Backup\My Documents
Actual Remote Source Path = C:\Backup\Users\Ad-

min\C\Backup\My Documents

Note: The "Root Path" will be ignored when performing byte-level replication using Normal
Mode (i.e. Local or UNC paths). 

Po rt Co nfig ura tio n T a b

Po rt Co nfig ura tio n  

T ime  Out Sets the amount of time a connection will wait to complete a
data transfer before exiting and performing the failure opera-
tion. 

Po rt This is the TCP Port used to communicate with the Listener on
the remote machine. This must match the port number that the
PSListener is configured for. By default both Listener and Peer-
Sync use port 7333.

Note: The Profiler will not support W ell Known Port numbers 0 - 1023. You
must use port numbers that are greater than or equal to 1024. 

Co mp re ss io n Uses a lossless compression algorithm to transmit data in
fewer bits. By default Compression is disabled to achieve
faster performance. 

Use r Info rma tio n (T o  b e  use d  fo r e ncryp tio n)

This is an optional setting that allows you to specify a Use r Na me  and Pa sswo rd  to be
used for encryption as well as authentication purposes when connecting to the remote
PSListener. In order to activate encryption or authentication, you must specify both a Use r
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Na me  and a Pa sswo rd  value.  Strong DES encryption will be used to encrypt the data
and communication as it is being transmitted over the Internet, LAN, WAN, or VPN. 

Use r Na me The Use r Na me  can be arbitrarily chosen and is not tied to
Active Directory. However, once specified, you must enter the
same User Name entry in the PSListener Configuration resid-
ing on the remote location. 

If you specify a Use r Na me  without a Pa sswo rd , the User
Name entry will be ignored and no encryption or authentication
with the PSListener will occur. 

Pa sswo rd The Pa sswo rd  can be arbitrarily chosen. Once specified, you
must enter the same Password in the PSListener Configuration
residing on the remote location. 

Notes: 

1. The TCP features listed on this page require the TCP WAN Connector option. Please visit http:/ / www.peersoft-
ware.com or contact Sales for additional information.

2. You cannot monitor a TCP source in Real-Time.

3. Bi-directional synchronization mode as well as other non applicable features are ignored when using a TCP
Source.

4. Selecting a TCP Source and a TCP Target for the same Job is not supported.

5. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the syn-
chronization process (Source or Target).

So urce  Fo ld e r Co nfig ura tio n: Us ing  No rma l Mo d e

The Source folder configure button is activated by clicking on the Co nfig ure  button located
in right lower corner of the Source Folder panel/section. Selecting the Configure button opens
the So urce  Fo ld e r Co nfig ura tio n window. Alternatively, you may right-click on the So urce
Fo ld e r field and select Co nfig ure : So urce  Fo ld e r (See Source Folder Popup Menu). 

Re la te d  Op tio ns
Detection Method - Global
Connection Manager - Global
Network Logon Settings
NetApp FPolicy
NetApp FPolicy cDOT
EMC Celerra/VNX Settings
EMC Isilon Settings
CIFS/NFS
FPolicy Utilities

Detection Method for Real-time Monitoring

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
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Choose the desired detection method for the Source folder. You may choose from the fol-
lowing options:

De fa ult Select this option to specify a local or remote drive which resides on the
network (LAN, WAN, or VPN). This is the recommended detection method
for most scenarios. Close the So urce  Fo ld e r Co nfig ura tio n dialog
once you have selected your desired source folder detection mode and
enter the path to the source folder in the Fo ld e r Se le c tio n screen (i.e. D:
\Path\Folder). 

Note: PeerSync must reside on the source system in order to enable Normal real-time detec-
tion.

Ne tAp p
FPo licy  7-
Mo d e

Select this option to specify the path to a 7-Mode NetApp filer for either
real-time or scanning scenarios. Close the So urce  Fo ld e r Co nfig ura -
tio n dialog once you have selected your desired source folder detection
mode and enter the path to the source folder in the Fo ld e r Se le c tio n
screen (i.e. \\NetAppFiler\Share\Folder).

Note: This option can only be activated if the license supports NetApp detection. Please visit
http:/ / www.peersoftware.com or contact Sales for additional information.

Ne tAp p
FPo licy
cDOT

Select this option to specify the path to a cDOT NetApp filer for either real-
time or scanning scenarios. Close the So urce  Fo ld e r Co nfig ura tio n
dialog once you have selected your desired source folder detection mode
and enter the path to the source folder in the Fo ld e r Se le c tio n screen
(i.e. \\NetAppFiler\Share\Folder).

Note: This option can only be activated if the license supports NetApp detection. Please visit
http:/ / www.peersoftware.com or contact Sales for additional information.

EMC CEE
Ce l-
e rra /VNX

Select this option to specify the path to a EMC CEE Celerra/VNX  filer for
either real-time or scanning scenarios. Close the So urce  Fo ld e r Co nfig -
ura tio n dialog once you have selected your desired source folder detec-
tion mode and enter the path to the source folder in the Fo ld e r Se le c tio n
screen (i.e. \\CEEVNX1\Share\Folder).

Note: This option can only be activated if the license supports EMC CEE Celerra/ VNX detec-
tion. Please visit http:/ / www.peersoftware.com or contact Sales for additional information.

EMC CEE
Is ilo n

Select this option to specify the path to a EMC CEE Isilon  filer for either
real-time or scanning scenarios. Close the So urce  Fo ld e r Co nfig ura -
tio n dialog once you have selected your desired source folder detection
mode and enter the path to the source folder in the Fo ld e r Se le c tio n
screen (i.e. \\CEEVNX1\Share\Folder).

Note: This option can only be activated if the license supports EMC CEE Isilon detection.
Please visit http:/ / www.peersoftware.com or contact Sales for additional information.

 Ne tAp p  FPo licy  Scre e ning  Op tio ns

Ena b le
CIFS

CIFS Screening is enabled by default when clicking the "Set CIFS Defaults"
button in the CIFS/NFS tab.

http://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
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Scre e ning

Ena b le
NFSv3
Scre e ning

NFSv3 is the only NetApp FPolicy Screening option supported when work-
ing with NFS.. This must be set when utilizing NFS detection and is automat-
ically selected when the "Set NFS Defaults" button is clicked in the
CIFS/NFS tab. 

Ena b le
NFSv4
Scre e ning

NFSv4 screening is presently not supported.

 Eve nt Filte ring  Op tio ns

Exc lud e
Use rs

Provide a list of semi-colon (;) delimited users to exclude when using non-
De fa ult detection mode in real-time. Real-time events from the users in
this field will be excluded. Enter the desired user names in a semi colon de-
limited format (i.e. user1;user2;user3).

Exc lud e  Ex-
te ns io ns

Provide a list of semi-colon (;) delimited file extensions to exclude when us-
ing non-De fa ult detection mode during scans or in real-time. To exclude
extensions via the command line use /Q70:s, where s  represents the
comma (,) delimited list of extensions to exclude (i.e. /Q70:tmp;dwl;dwl2).
Use %AUT O% for PeerSync to build a list of file extensions dynamically.
To use the %AUTO% option via the command line use /Q70. This is the
equivalent of using the /QR argument for FPolicy only.

Exc lud e  IP
Ad d re ss

Provide a list of semi-colon (;) delimited IP addresses to exclude when us-
ing a non-De fa ult detection mode during scans or in real-time.

Note: For bi-directional configurations that do not filter events by other means you should add
all IP addresses for the PeerSync systems involved to this list that you do not want to detect
events from to prevent oscillation. In particular, this is recommended for EMC Isilon bi-direc-
tional configurations. 

Allo w fo r re -
mo te  re a l-
time  co nfig -
ura tio n

This option indicates whether or not the selected source folder detection
method supports real-time detection for remote paths. Presently, this fea-
ture is only supported for Ne tAp p  FPo licy  Mo d e  or Ne ta p p  FPo licy
cDOT  detection modes.

Notes: 

1. NetApp CIFS real-time support requires the NetApp option.  Please visit http:/ / www.peersoftware.com or con-
tact Sales for additional information.

2. NFS real-time support requires an NFS and NetApp enabled license.  Please visit http:/ / www.peersoftware.com
or contact Sales for additional information.

3. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the syn-
chronization process (Source or Target).

http://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
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The Co nne ctio n Ma na g e r tracks and determines if connections are lost to source and/or
target folders. With this new capability PeerSync can proactively detect when a connection is
lost or reconnected, giving the ability to restart real-time and/or scan Jobs if needed.

Auto ma tica lly  use  re -
co mme nd e d  se tting s
b a se d  o n De te ctio n
Me tho d

Check this option if you wish to let the Co nne ctio n Ma ng e r
track the connection status on both the source and target loca-
tions. When a lost connection is restored, PeerSync will restart
real-time and/or scan Jobs if the option to "Scan Job once at
start" is enabled. In addition, this logic will apply to only con-
nections which are set for real-time monitoring.

Connection Manager for Failed Connections
Choose one of the following options to manually disable or enable the Connec-
tion Manger which tracks the connection status on the desired locations.

Disa b le d Disable the Co nne ctio n Ma na g e r

Ena b le d  fo r So urce
Co nne ctio ns  Only

Enable the Co nne ctio n Ma ng e r to track the connection
status only on the source location.

Ena b le d  fo r T a rg e t
Co nne ctio ns  Only

Enable the Connection Manger to track the connection status
only on the target location.

Ena b le d  fo r So urce
a nd  T a rg e t Co nne c-
tio ns

Enable the Co nne ctio n Ma ng e r to track the connection
status on both the source and target locations.

Connection Manager Options

Only  inc lud e  co nne c-
tio ns  tha t a re  se t fo r
re a l-time  mo nito ring

Set the Co nne ctio n Ma na g e r to monitor only connections
that are set for real-time detection.

Sca n re a l-time  Jo b s
o n re co nne ct if "Sca n
Jo b  o nce  a t s ta rt"  is
e na b le d

Set the Co nne ctio n Ma na g e r to scan real-time Jobs on re-
connect if the Scan Job once at start option is enabled.

Notes: 

1. NetApp CIFS real-time support requires the NetApp option.  Please visit http:/ / www.peersoftware.com or con-
tact Sales for additional information.

2. NFS real-time support requires an NFS and NetApp enabled license.  Please visit http:/ / www.peersoftware.com
or contact Sales for additional information.

3. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the syn-
chronization process (Source or Target).

http://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
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Edit or maintain default NetApp settings when selecting NetApp FPolicy 7-Mode or NetApp
FPolicy cDOT as the detection method. These options are only applicable when using the
NetApp FPolicy 7-Mode or NetApp FPolicy cDOT detection method. 

Auto ma tica lly  d e te c t
a nd  use  re co mme n-
d e d  Ne tAp p  co nfig ur-
a tio n

When using the NetApp FPolicy 7-Mode  or NetApp FPolicy
cDOT detection method, checking this option will automatically
populate the required NetApp settings with the defaults.
Uncheck this option if you wish to manually edit these settings.

NetApp Settings 

Ho st Se rve r Na me Edit the host name or IP address of the NetApp filer. 

Ro o t Pa th Pre fix Edit the local path of the NetApp share you wish to monitor.

FPo licy  Na me Edit the FPolicy name that is used to register for event notifica-
tion on the filer. By default PeerSync uses
PEERSYNC_COMPUTERNAME, where COMPUTERNAME is
the name of the host where PeerSync is running. PeerSync will
create the FPolicy name at the start of the Job.

FPolicy Options - Global

Use  cDOT  De te ctio n Check this option when using Ne tAp p  FPo licy  cDOT  detec-
tion method. 

Use  Asynchro no us
Mo d e

If enabled, PeerSync will not wait for a response from the
FPolicy server, which enhances overall performance. To en-
able Asynchro no us Mo d e  via the command line argument
use /Q74Y. This option is enabled by default for both NetApp
detection methods (7Mode and cDOT) and cannot be disable
when using cDOT detection mode. 

D isa b le  FPo licy  o n
Clo se

By default PeerSync will disable the FPolicy name it used to re-
gister for event notification when the Job is stopped. Disable
this option if you do no t want  PeerSync to delete the FPolicy
name when the Job is stopped.

Ne tAp p  FPo licy  Ad d itio na l Se tting s  - By  Ho st

Exc lud e  Vo lume s Provides the ability to exclude entire volumes from scans
and real-time detection, which enhances overall perform-
ance. Enter a list of semi-colon (;) delimited volumes to ex-
clude when using NetApp FPolicy detection during scans
or in real-time. Here is an example of excluding volumes
vol3 and vol4: vol3,vol4. To exclude volumes via the com-
mand line use /Q7-s, where s  represents the semi-colon (;)
delimited list of volumes to exclude (i.e. /Q7-vol3;vol4).
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Inc lud e  Vo lume s Provide a list of semi-colon (;) delimited volumes to include
when using NetApp FPolicy detection during scans or in real-
time. This field is visible only if the “Exclude Volumes” check
box is un-checked.  Here is an example of including volumes
vol1 and vol2: vol1;vol2. To include volumes via the command
line use /Q7+s, where s  represents the semi-colon (;) delimited
list of volumes to include (i.e. /Q7+vol1;vol2).

Notes: 

1. NetApp CIFS real-time support requires the NetApp option.  Please visit http:/ / www.peersoftware.com or con-
tact Sales for additional information.

2. NFS real-time support requires an NFS and NetApp enabled license.  Please visit http:/ / www.peersoftware.com
or contact Sales for additional information.

3. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the syn-
chronization process (Source or Target).

These options are only applicable when using the NetApp FPolicy cDOT detection method. 

NetApp FPolicy cDOT SVM Logon Settings

Use rna me Provide the user name for the account that will be used to run
the API calls against the vServer.

Pa sswo rd Provide the password for the account that will be used to run
the API calls against the vServer.

NetApp FPolicy cDOT Additional Settings

Ma na g e me nt IP Optionally, specify the IP address for the system where the
Management node is on a separate IP from the IP used to ac-
cess the shares. 

Inc lud e  Sha re s Provide a list of alternate shares to register for. Alternate
shares are automatically discovered and registered by default.
This can be disabled by unchecking the D isa b le  Alte rna te
Sha re  Lo o kup  option.  For example, use this in cases where
the alternate share points to the root level and should not be in-
cluded.

Prima ry  Se rve r This is an optional list of semi colon (;) delimited IP addresses
of the system(s) where the FPolicy server is running (i.e. the
system where PeerSync is running).  Events generated on the
SVM from this IP will be automatically filtered unless the "Dis-
able IP Filtering" option is used. Therefore it is important to note
that in order for real-time detection to work, all changes must be
made from different systems and not the system where Peer-
Sync is running. 

http://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com
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cDOT Options - Global

Asynchro no us Mo d e Enabled by default, PeerSync will not wait for a response from
the FPolicy server, which enhances overall performance. Cur-
rently, this setting must always be enabled.

D isa b le  Alte rna te
Sha re  Lo o kup

Alternate shares are automatically discovered and registered
for by default. This can be disabled by unchecking the D is-
a b le  Alte rna te  Sha re  Lo o kup  option.  For example, use
this in cases where the alternate share points to the root level
and should not be included.

System Information for Source Host

Ge t Info Click this button to display a short description about the source
host PeerSync is connecting to. This also checks if the creden-
tials provided gain access to the SVM.

Notes: 

1. NetApp CIFS real-time support requires the NetApp option.  Please visit http:/ / www.peersoftware.com or con-
tact Sales for additional information.

2. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the syn-
chronization process (Source or Target).

This screen is available when using the Default detection method.

Network Logon Settings

Provides the ability to connect to a source folder that may require a different account than
the one PeerSync is running under. 

Co nne ct As Provide the user name to allow PeerSync connection to the
source directory that is not accessible using the current service
or logged on account. Be sure to include the domain name if
applicable (i.e. MyDomain\UserName).

Pa sswo rd Enter the password information for login.

System Information for Source Host

Ge t Info Click this button to display a short description about the source
host PeerSync is connecting to. 

This screen is available when using the EMC CEE Celerra/VNX detection method.

http://www.peersoftware.com
http://www.peersoftware.com/contact.html
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Auto ma tica lly  use  re -
co mme nd e d  se tting s
b a se d  o n De te ctio n
Me tho d

Automatically use recommended settings based on the detec-
tion method selected.

Control Station Options

Co ntro l Sta tio n IP The Control Station IP address of the VNX system. 

Co ntro l Sta tio n Use r-
na me

Username used to sign into the VNX Control Station.

Co ntro l Sta tio n Pa ss-
wo rd

Password used to sign into the VNX Control Station.

Co ntro l Sta tio n Po rt The Control Station Port number of the VNX system. Default
value is 443.

CEPP Po o l Na me The CEPP Pool Name to be used by the VNX system.

Va lid a te  Co ntro l Sta -
tio n

If enabled, the VNX Control Station will be validated both on re-
gistration and periodically by a maintenance thread. 

Inc lud e  Alte rna te
Sha re s

Include Alternate Shares in detection of the VNX system.

Filtered Locations Options

Filte re d  Lo ca tio ns (Optional) String containing the locations to be filtered in the fol-
lowing format: <ServerName>:<ShareName>,<Server-
Name>:<ShareName>

Notes:
· To specify that all shared in a server are specified, use an asterisk "*" .

Example: <ServerName>:*,<ServerName>:<ShareName>
· To specify that no shares in a server are specified use a pipe instead
· The string length should not exceed 256 characters

Use  Filte re d  Lo ca -
tio ns  As - Inc lud e

(Optional) Select this option if the Filtered Locations should be
included.

Use  Filte re d  Lo ca -
tio ns  As - Exc lud e

(Optional) Select this option if the Filtered Locations should be
excluded.

This screen is available when using the EMC CEE Isilon detection method.

Auto ma tica lly  use  re -
co mme nd e d  se tting s
b a se d  o n De te ctio n
Me tho d

Automatically use recommended settings based on the detec-
tion method selected.
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Cluster Options

Cluste r IP The cluster IP address of the Isilon system. 

Clus te r Use rna me Username used to sign into the Isilon cluster.

Clus te r Pa sswo rd Password used to sign into the Isilon cluster. 

Clus te r Po rt The cluster port number of the Isilon system. Default value is
8080. 

Va lid a te  Clus te r If enabled, the Isilon cluster will be validated both on registra-
tion and periodically by a maintenance thread. 

Up d a te  Is ilo n CEE
Lo g  T ime

Update Isilon CEE Log Time upon registration. 

Filtered Locations Options

Filte re d  Lo ca tio ns (Optional) String containing the locations to be filtered in the fol-
lowing format: <ServerName>:<ShareName>,<Server-
Name>:<ShareName>

Notes:
· To specify that all shared in a server are specified, use an asterisk "*" .

Example: <ServerName>:*,<ServerName>:<ShareName>
· To specify that no shares in a server are specified use a pipe instead
· The string length should not exceed 256 characters

Use  Filte re d  Lo ca -
tio ns  As - Inc lud e

(Optional) Select this option if the Filtered Locations should be
included.

Use  Filte re d  Lo ca -
tio ns  As - Exc lud e

(Optional) Select this option if the Filtered Locations should be
excluded.

Job Scan Method - Global

CIFS - De fa ult This scan method should be selected when using Normal or
NetApp 7Mode or cDOT detection and is selected automatically
when clicking on the "Set CIFS Defaults" button at the bottom. 

NFS - Unix/Linux
rsync co mma nd

This scan method utilizes the Unix/Linux rsync algorithm to
scan folders and files. It should be selected when using NFS de-
tection and is selected automatically when clicking on the "Set
NFS Defaults" button at the bottom. 

Copy File Method - Global

CIFS - De fa ult This copy method should be selected when using Normal or
NetApp 7Mode or cDOT detection. This option is selected auto-
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matically when clicking on the "Set CIFS Defaults" button at the
bottom. 

NFS - Unix/Linux
rsync co mma nd

This copy method utilizes the Unix/Linux rsync algorithm to
sync and transfer files. It should be selected when using NFS
detection and is selected automatically when clicking on the
"Set NFS Defaults" button at the bottom. 

NFS - Unix/Linux cp
co mma nd

This copy method utilizes the Unix/Linux cp command to sync
and transfer files. It provides an alternative sync/transfer method
to rsync for NFS detection.

CIFS - Co p yFile  API
- /GFC Arg ume nt

This copy method uses a basic file transfer API call (CopyFile)
that provides no progress and therefore may be faster. 

CIFS - Co p yFile Ex API
- /GFE Arg ume nt

This copy method uses an advanced copy method via the
CopyFileEx API call that provides feedback.

CIFS - File  Stre a m
Me tho d  - /GFS Arg u-
me nt

This copy method uses an alternate file stream method to trans-
fer the files.

Ad min Ba ckup Enable this option to transfer files that the account running
PeerSync does not currently have permission to but the account
can add itself to (/Q7S Command Line Argument).

Ad va nce d  Ba ckup Enable this option for files such Symantec Enterprise Vault stub
files ( /Q7S>>Command Line Argument).

Ad va nce d  Ba ckup
with Pe rmiss io ns

Enable this option for files such as Symantec Enterprise Vault
stub files and/or to transfer files with all permissions during the
file copy (/Q7S>>> Command Line Argument).

Permissions (Security style) - Global

CIFS - De fa ult (NT FS) This security style should be selected when using Normal or
NetApp 7Mode or cDOT detection. This option is selected auto-
matically when clicking on the "Set CIFS Defaults" button at the
bottom. 

NFS - Unix/Linux d o wn
a nd  chmo d  co m-
ma nd s (UNIX)

This security style should be selected when using NFS detec-
tion. This option is selected automatically when clicking on the
"Set NFS Defaults" button at the bottom. 

Ena b le  NFS Exte nd e d
Re p o rting  a nd  D is-
p la y

Check this option to enable extended reporting and display in-
formation for permissions when working with NFS detection.
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Se t CIFS De fa ults Click this button to automatically set the global scan, copy, and
permission settings to use the CIFS protocol. This protocol is
used for Normal or NetApp 7Mode or cDOT real-time monitor-
ing. 

Se t NFS De fa ults Click this button to automatically set the global scan, copy, and
permission settings to use with NFS. 

Notes: 

1. NetApp CIFS real-time support requires the NetApp option.  Please visit http:/ / www.peersoftware.com or con-
tact Sales for additional information.

2. NFS real-time support requires an NFS and NetApp enabled license.  Please visit http:/ / www.peersoftware.com
or contact Sales for additional information.

3. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the syn-
chronization process (Source or Target).

These options are only applicable when using the NetApp FPolicy 7-Mode or NetApp
FPolicy cDOT detection method. 

FPolicy Utility Features

De le te  7-Mo d e
FPo licy

Available when using NetApp FPolicy 7-Mode detec-
tion. Click this button to delete all FPolicies that are in
an "idle" state and were created from the FPolicy sys-
tem where PeerSync is running. 

Disa b le  cDOT
FPo licy

Available when using NetApp FPolicy cDOT detection
mode. Click this button to disable any policies that
match the naming convention defined in the Profile.
The default policy naming convention is
PEERSYNC_FPOLICY-SERVER-NAME).

All
Po lic ie s

Check this option to disable all cDOT policies that
are in an "idle" state and were created from the
FPolicy system where PeerSync is running. 

Re g a rd -
le ss  o f
s ta te

Check this option to disable cDOT policies created
regardless of their state. 

Notes: 

1. NetApp CIFS real-time support requires the NetApp option.  Please visit http:/ / www.peersoftware.com or con-
tact Sales for additional information.

2. NFS real-time support requires an NFS and NetApp enabled license.  Please visit http:/ / www.peersoftware.com
or contact Sales for additional information.

3. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the syn-
chronization process (Source or Target).

http://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
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Located to the right of the Source Folder Selection Field, this button opens a "Browse for
Folder" dialog box. Once this box has opened, locate your chosen Source folder, select it us-
ing the left mouse button, and click "OK." 

Note:  This button is not available when selecting TCP Source or Target.

Exp lo re /Op e n/Cre a te  So urce  Butto n

This button provides three options to be selected from the attached drop-down list. The but-
ton label will change to reflect whichever item has been checked on this list. 

Exp lo re  When "Explore" has been selected and the button is de-
pressed, an Explorer-type window will open displaying all
available directories. By default, this window will show the
folder whose path is currently designated in the Source Field. If
the folder shown in this field does not exist, Profiler will display
a dialog alerting you to this fact and asking if you would like to
create it. You may do so by clicking the "Yes" button located at
the bottom of this dialog. Once you have done so the newly
created folder will be shown in the Explorer-type window. 

Op e n  When "Open" has been selected and the button is depressed,
a traditional MS navigation window is opened displaying the
contents of whichever folder is currently shown in the Source
Folder Field. If this folder does not exist, Profiler will display a
dialog alerting you to this fact and asking if you would like to
create it. You may do so by clicking the "Yes" button located at
the bottom of this dialog. Once you have done so the newly
created Folder will be shown in the navigation window. 

Cre a te  When "Create" has been selected and the button is de-
pressed, a "Select Directory" dialog will open allowing you to
specify a Source Folder path by using the mouse to select a
desired drive, directory, and folder. Folder paths can also be
manually entered into the "Directory Name" field. If you enter a
path for a folder that does not exist and hit the ENTER key or
click "OK," a dialog box will appear allowing you to create this
folder.

Note:  This button is not available when selecting TCP  for Source or Target.

So urce  Fo ld e r Po p up  Me nu: Us ing  No rma l Mo d e

The Source Folder PopUp Menu is activated by right clicking on the Source Folder field.
The first four features allow the user to Browse for Source Folder, Explore, Open and/or
Create the Source Folder selection. 

Co nfig ure : So urce
Fo ld e r

Selecting this option displays the Source Network Logon Set-
tings window. This allows the user to specify Network Logon
credentials for the Source Folder which enables connection to
directories that are not accessible with the current logged on
account. 
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Ed it: So urce  Va ria b le
File

This will allow the user to view/edit Variable Data Import and/or
Job Data Import files that are used in the Source Folder selec-
tion. This option is only available if using Job data import files.

Cre a te  Auto  Jo b
Na me

This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which
make it a simple task to organize the Job list. 

So urce  Fo ld e r Po p up  Me nu: Us ing  T CP Mo d e

The Source Folder PopUp Menu is activated by right clicking on the Source Folder field.
The first two features allow the user to Explore and Open the Source Folder selection. 

Co nfig ure : So urce
Fo ld e r

Selecting this option displays the Source TCP/Port Configura-
tion window. This window provides a guided method for enter-
ing the Source TCP path as well as TCP and/or Byte Replic-
ator settings (see TCP Configuration).

Cre a te  Auto  Jo b
Na me

This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which
make it a simple task to organize the Job list. 

Notes:  

1. The TCP features listed above require the TCP WAN Connector option. Please visit http:/ / www.peersoft-
ware.com or contact Sales for additional information.

2. The Browse for Source Folder and Create options are not available when using TCP Source Mode. 

T a rg e t Fo ld e r Se le c tio n

The options listed on this page can be accessed from the Folder Selection window. The
following options are available for selecting a Target folder.

Us ing  No rma l Mo d e  Select a "Normal" Target folder if you can navigate to the de-
sired Target directory via a Local Path, a UNC Path, or a
Mapped Drive. This selection requires that the machine on
which PeerSync is running has full access to the desired Tar-
get directory. In some instances Network Logon may be re-
quired. 

Select a Target Folder by typing the file path into the field
provided or by using the Select Target Folder Button. By de-
fault, the Target Folder field will contain the path in which Peer-
Sync has been installed: in most cases this will be C:\Program
Files\PeerSync\Target.  The convention outlined in this path
must be used when manually typing entries, (i.e. a drive must

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
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be specified followed by a colon, with subsequent folders sep-
arated by backslashes). This field is not case sensitive, though
spaces may only be entered where they are part of valid folder
names (i.e. "Program Files"). No space should appear
between slashes and folder names. This field also supports
File/Folder Path Variables. 

UNC names can be entered manually, or can be selected from
the Network Neighborhood using the "Browse for Folder" dia-
log box (see Select Target Folder Button). UNC names will ap-
pear in the form \\COMPUTER\SHAREDDEVICE\PATH. For
example: \\SERVER11\D\USERDATA 

Note:  We do not recommend using UNC paths for folders that
reside on the local machine, in this scenario you should use the
local path to that folder.

Folders can also be dragged and dropped from MS Windows
Explorer into the Target Folder Field for automatic insertion.

The Target Folder Field holds a folder selection History of
more then 10 entries. They can be selected by clicking on the
drop down button located to the right of the field. 

The current path will be displayed bellow the Target Folder
Selection Filed. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to cor-
rect the invalid path and you exit the Target Folder Selection
field, the application will throw a message and use the default
PeerSync installation path C:\Program Files\PeerSync\Target
instead.

The Host Name and User Name & Password values (if
provided) are displayed above the Target Folder Selection
field (see Network Logon).

Us ing  T CP Mo d e Select a "TCP" Target folder if the Target directory is outside
the scope of the machine on which PeerSync is running. TCP
enables access to machines not located on the same network
as PeerSync. As a prerequisite, the PSListener needs to be in-
stalled and running on the remote Target machine in order for
PeerSync to be able to communicate with it. This feature sup-
ports encryption and compression.

Note: We strongly recommend the use of a VPN when transferring files over
the public Internet for security purposes. Otherwise, you should use our En-
cryption feature with a user name and password to protect data and all commu-
nication as it is being transferred. 

When selecting the TCP Mode for the first time the Target
TCP/Port Configuration window will open automatically for Tar-
get Folder configuration. Otherwise, the previously entered
TCP folder path will be displayed. This path can be manually



PeerSync Help 54

Copyright © 1993-2019 Peer Software Inc. All Rights Reserved

edited by typing directly into the field provided or by using the
Configuration button. The convention outlined in this path must
be used when manually typing entries, (i.e. the key word TCP
must be specified followed by a colon, two backslashes, the
Target IP address or machine name, and subsequent folders
separated by backslashes). This field is not case sensitive,
though spaces may only be entered where they are part of
valid folder names (i.e. "Program Files"). No space should ap-
pear between slashes and folder names. This field also sup-
ports File/Folder Path Variables. 

The Target Folder Field holds a folder selection History of
more then 10 entries. They can be accessed by clicking on the
drop down button located to the right of the field. 

The current path will be displayed bellow the Target Folder
Selection Filed. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to cor-
rect the invalid path and you exit the Target Folder Selection
field, the application will throw a message and use the last
valid TCP path specified or the default path TCP:\
\127.0.0.1\C\Target. 127.0.0.1 represents the loopback IP ad-
dress of the local host (i.e. the machine on which PeerSync is
running).

The provided Host Name and User Name & Password values
are displayed above the Target Folder Selection field (see
Configuration Button).

Re la te d  Op tio ns
Target Folder Configuration Button
Select Target Folder Button
Explore/Open/Create Button
Target Folder Popup Menu
Alternate Target Path Selection

Notes: 

1. TCP (i.e.TCP WAN Connector Option) is optional modes which may not be included in your package. Please
visit http:/ / www.peersoftware.com or contact Sales for additional information.

2. Bi-directional synchronization mode as well as other non applicable features are ignored when using a TCP Tar-
get.

3. Selecting a TCP Source and a TCP Target for the same Job is not supported.

4. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the syn-
chronization process (Source or Target).

Using  No rma l Mo d e

The Target Folder Configuration Button can be activated by clicking on the Co nfig ure  button
located in right lower corner of the T a rg e t Fo ld e r panel/section. Selecting the Configure but-
ton opens the Target Network Logon Settings window. Alternatively, you may right-click on

http://www.peersoftware.com
http://www.peersoftware.com/contact.html
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the Target Folder field and select Configure: Target Folder (See Target Folder Popup Menu).
This window allows for network logon Name and Password information for a remote Target
connection. 

Us ing  T CP Mo d e  

The Target Folder Configuration Button can be activated by clicking on the Co nfig ure  button
located in right lower corner of the T a rg e t Fo ld e r panel/section. Selecting the Configure but-
ton opens the Target TCP/Port Configuration window. Alternatively, you may right-click on the
Target Folder field and select Configure: Target Folder (See Target Folder Popup Menu). 

T CP Co nfig ura tio n T a b

This window provides a guided method for entering the Target TCP path. 

Ho st Na me Enter the IP address or machine name of the Target folder into this filed.
You may use the machine name only if the remote Target machine resides
on the same network as that on which PeerSync is running. 

Pa th to
Ho st 

Provide the full path (i.e. C:\Documents and Settings\Target) to the Target
folder in this field. The path entered needs to be a local path without a ma-
chine name or UNC format. This field does not validate the existence of the
path you provide therefore you must exercise great care when doing so. If
the path does exist, PeerSync will create it during run time as long as a
valid host name or IP address has been provided and it can find the drive
letter specified.

A UNC path can be entered for the Pa th o n Ho st selection for a T CP
so urce  or T CP ta rg e t.   This gives the ability to configure non-windows to
non-windows Jobs over TCP (i.e. Ne tAp p  to  Ne tAp p  o ve r T CP).  Note:
This will make use of a new NET WORK constant in the source or target
selection. 

Example: 

TCP:\\WindowsServer\NETWORK\\NetAppSVM\vol1\Data

Care must be exercised if your PSListener contains a "Root Path". If you
specify such a path in your PSListener it will behave like an FTP server that
sets Root Paths to limit user access to the local file system. If a "Root Path"
exists on the PSListener it will limit PeerSync's ability to access directories
on the remote device. PeerSync will only be able to access directories
equal to or bellow the specified "Root Path" level provided that it meets the
Port and Encryption requirements. In no circumstances can PeerSync ac-
cess directories located above this path. If the remote path you enter in the
Path to Host  field references a directory above the "Root Path", PeerSync
will create that folder structure at runtime bellow the "Root Path". 

Example: 

PSListener "Root Path" = C:\Backup\Users\Admin
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PeerSync's "Path to Host"  = C:\Backup\My Documents
Actual Remote Target Path = C:\Backup\Users\Ad-

min\C\Backup\My Documents

Note: The "Root Path" will be ignored when performing byte-level replication using Normal
Mode (i.e. Local or UNC paths). 

Po rt Co nfig ura tio n T a b  

Provides settings to be used by both the Source and Target connections when using TCP
and/or Byte Replicator. 

T ime  Out Sets the amount of time a connection will wait to complete a data transfer
before exiting and performing the failure operation. 

Po rt This is the TCP Port used to communicate with the Listener on the remote
machine. This must match the port number that the PSListener is configured
for. By default both Listener and PeerSync use port 7333.

Note: The Profiler will not support W ell Known Port numbers 0 - 1023. You must use port
numbers that are greater than or equal to 1024. 

Co mp re s-
s io n 

Uses a lossless compression algorithm to transmit data in fewer bits. By
default Compression is disabled to achieve faster performance. 

Use r In-
fo rma tio n

This is an optional setting that allows you to specify a Use r Na me  and
Pa sswo rd  to be used for encryption as well as authentication purposes
when connecting to the remote PSListener. In order to activate encryption
or authentication, you must specify both a Use r Na me  and a Pa sswo rd
value.  Strong DES encryption will be used to encrypt the data and commu-
nication as it is being transmitted over the Internet, LAN, WAN, or VPN. 

The Use r Na me  and Pa sswo rd  entries can be arbitrarily chosen and
are not required to be valid. However, once specified, you must enter the
same User Name and Password entries in the PSListener Configuration
residing on the remote location. 

If you specify a Use r Na me  without a Pa sswo rd , the User Name entry
will be ignored and no encryption or authentication with the PSListener will
occur. 

Notes:

1. The TCP features listed on this page require the TCP WAN Connector option. Please visit http:/ / www.peersoft-
ware.com or contact Sales for additional information.

Located to the right of the Target Folder Selection Field, this button opens a "Browse for
Folder" dialog box: once this box has opened, locate your chosen Target folder, select it us-
ing the left mouse button, and click "OK." 

Note:  This button is not available when selecting TCP for Source or Target.

Exp lo re /Op e n/Cre a te  T a rg e t Butto n

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com
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This button provides three options to be selected from the attached drop-down list. The but-
ton label will change to reflect whichever item has been checked on this list. 

Exp lo re When "Explore" has been selected and the button is de-
pressed, an Explorer-type window will open displaying all
available directories. By default, this window will show the
folder whose path is currently designated in the Target field. If
the folder shown in this field does not exist, Profiler will display
a dialog alerting you to this fact and asking if you would like to
create it: you can do so by clicking the "Yes" button located at
the bottom of this dialog. Once you have done so the newly
created Folder will be shown in the Explorer-type tree.

Op e n When "Open" has been selected and the button is depressed,
a traditional MS navigation window is opened displaying the
contents of whichever folder is currently shown in the Target
Folder Field. If this folder does not exist, Profiler will display a
dialog alerting you to this fact and asking if you would like to
create it: you can do so by clicking "Yes" button located at the
bottom of this dialog. Once you have done so the newly cre-
ated Folder will be shown in the navigation window.  

Cre a te When "Create" has been selected and the button is de-
pressed, a "Select Directory" dialog will open allowing you to
specify a Target Folder path by using the mouse to select a
desired drive, directory, and folder (See image in "Source
Folder Selection" topic above). Folder paths can also be
manually entered into the "Directory Name" field. If you enter a
path for a folder that does not exist and hit the ENTER key or
click "OK," a dialog box will appear allowing you to create this
folder.

Note:  This button is not available when selecting TCP for Source or Target.

T a rg e t Fo ld e r Po p up  Me nu: Us ing  No rma l Mo d e

The Target Folder PopUp Menu is activated by right clicking on the Target Folder field.
The first four features allow the user to Browse for Target Folder, Explore, Open and/or
Create the Target Folder selection. 

Co nfig ure : T a rg e t
Fo ld e r

Selecting this option displays the Target Network Logon Set-
tings window. This allows the user to specify Network Logon
credentials for the Target Folder which enables connection to
directories that are not accessible with the current logged on
account. 

Ed it: T a rg e t Va ria b le
File

This will allow the user to view/edit Variable Data Import and/or
Job Data Import files that are used in the Target Folder selec-
tion. This option is only available if using Job data import files.

Cre a te  Auto  Jo b
Na me

This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are automatically
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generated based on their Source and Target paths which
make it a simple task to organize the Job list. 

Se t Alte rna te /Ad d i-
tio na l T a rg e ts

Selecting this menu item will open the Alternate/Additional Tar-
gets selection window. This feature allows for alternate or addi-
tional Target paths associated with the base Job. 

Fo rce  So urce  Fo ld e r
Ro o t a s  T a rg e t Fo ld e r
Ro o t

Appends the Source folder directory to the Target folder path.

T a rg e t Fo ld e r Po p up  Me nu: Us ing  T CP Mo d e

The Target Folder PopUp Menu is activated by right clicking on the Target Folder field.
The first two features allow the user to Explore and Open the Target Folder selection. 

Co nfig ure : T a rg e t
Fo ld e r

Selecting this option displays the Target TCP/Port Configura-
tion window. This window provides a guided method for enter-
ing the Target TCP path as well as TCP and/or Byte Replicator
settings (see TCP Configuration). 

Cre a te  Auto  Jo b
Na me

This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which
make it a simple task to organize the Job list. 

Fo rce  So urce  Fo ld e r
Ro o t a s  T a rg e t Fo ld e r
Ro o t

Appends the Source folder directory to the Target folder path.

1. The TCP features listed above require the TCP WAN Connector option. Please visit http:/ / www.peersoft-
ware.com or contact Sales for additional information.

2. The Browse for Target Folder and Create options are not available when using TCP Target Mode. 

Notes:  

1. The TCP features listed on this page require the TCP WAN Connector option. Please visit http:/ / www.peersoft-
ware.com or contact Sales for additional information.

2. The Browse, Explore, Create, and Set Alternate/ Additional Target options are not available when using TCP.

This link will be enabled if you are using a Normal Target Mode Selection. By selecting this
link you can set and access your current Alternate Target Path Selections. Through this fea-
ture, Jobs can now have alternate or additional Target paths associated with the base Job.
This allows for the ability to redirect data on a failed connection to the base Target and/or
easily setup, one-to-many scenarios for distribution purposes. Selecting this menu item will
open the Alternate Target Path Selection dialog.

To add an alternate or additional Target click "New," then type the desired path into the field
located at the bottom of the dialog or select the "Browse" button to select a path.. Repeat this
process for each Target path you wish to add. Entries can be deleted by selecting them from

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
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the list and clicking the "Delete" key at the bottom of the box. You can also use the "Up" and
"Down" buttons to reorder the paths.

Notes:

1. This feature requires the Enhanced Package. 

2. Alternate Target Path Selection is not available for TCP.

3. When using Alternate Target Path Selections you cannot use variables that are specific to the Job (i.e. %
JobName%, %SourcePath%, etc.) for the Move unmatched Target Files option.

If this check box is selected, all sub-folders contained within the Source Folder will be syn-
chronized to the Target.

This button reverses placement of the file paths shown in the Source and Target Folder
Fields (so that what was formerly a Source Folder now becomes a Target Folder, and vice
versa).

Represents the date/time the last scan started for the selected Job. This is the date/time of
the last bi-directional synchronization scan of a Job that will be used when comparing files
during the Bi-directional Synchronization Mode option on the File Options screen. This feature
is also displayed and can be reset from the Profile Job List Pop-Up Menu.

Represents the date/time and user when the selected Job was last saved. 

This section describes additional features related to the Folder Selection topic. The features
below apply to both the Source and Target folder selections and related configuration op-
tions. 

Re la te d  Op tio ns
File/Folder Path Variables
Variable Data Import 
Job Data Import 
Dynamic Network Drive Mapping and Unmapping

Variable file/folder paths can be used to create:

1. Dynamic archives for yearly, monthly, weekly and/or daily backups
2. Dynamic synchronization based on date
3. Dynamic synchronization based on logged on user or machine name
4. Dynamic synchronization based on personal folders or other variables read in from the

registry
5. Log file storage, manipulation and organization
6. Administrative report file storage, manipulation and organization
7. Deleted file storage, manipulation and organization

File /Fo ld e r Pa th Va ria b le s

Depending upon the argument used, these folders will be dated, named after the currently
logged user, named for the PC from which synchronization was launched, or based on a
pre-determined variable stored out and read in from the registry. The following variables
can be used in any folder path Job setting available through the Profiler:

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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Date %Date%

Time %Time% 

Date/Time %DateTime%

Minute %Minute%

Hour %Hour%

Day %Day%

Year %Year%

Month/Year %MonthYear%

Minute (all formats) %n, nn%

Hour (all formats) %h, hh%

Day (all formats) %d, dd, ddd, dddd, ddddd, dddddd%

Month (all formats) %m, mm, mmm, mmmm, mmmm%

Year (all formats) %y, yy%

Custo m Pe e r Va ria b le s

Logged On User Name %UserName%

Computer Name %ComputerName%

Job Name %JobName% 

Source Folder Path %SourcePath%

Target Folder Path %TargetPath%

Deletion Folder Path %DeletePath%

Report File Path %ReportPath%

Wind o ws Va ria b le s

Windows Directory %WinDir%

Windows %Windows% (also %SystemRoot%)

System Temp Path %Temp%

System Temp Path %Tmp%

System Drive Letter %SystemDrive%

System 32 (WIN
9x/NT/00)

%System32%

Wind o ws Va ria b le s  fro m the  "HKEY_CURRENT _USER\So ftwa re \Mi-
cro so ft\W ind o ws\Curre ntVe rs io n\Exp lo re r\She ll Fo ld e rs"  Re g is try

Desktop %Desktop%
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Favorites %Favorites%

Fonts %Fonts%

Personal %Personal%

Programs %Programs%

Recent %Recent%

SendTo %SendTo%

Start Menu %Start Menu%

Startup %Startup%

Templates %Templates%

Notes:  

You can also use any variables that are located in the registry under HKEY_CURRENT_USER. For example:

HKEY_CURRENT_USER\ Environment (used by default default)
HKEY_CURRENT_USER\ Volatile Environment (used by default) 

The HKEY_CURRENT_USERS locations can be modified in the PSDef.cfg file as follows: 

[Misc Options]
RegVarStr=\ Environment;\ Volatile Environment;

In addition, the %USERPROFILE% Environmental Variable is now also supported. 

Use the variable %Personal% to define the "My Documents" folder in Profiles that will be used on multiple operat-
ing systems such as XP and Windows 7. Since the location of the My Documents folder is different on these operat-
ing systems, using the %Personal% variable will dynamically resolve to the correct location on each system. This
simplifies configuration and keeps the Profile generic and deployable on multiple operating systems.

Note for PeerSync  Jobs link ed to PeerLoc k : PeerLock supports the usage of Windows System and Re-
gistry variables in the Source and Target fields (i.e. %UserName%, %ComputerName%). Custom PeerSync variables
such as %JobName% are currently not supported and will not work in PeerLock. 

PeerSync now contains tools for importing data from files. The ability to extract specific fields
of data from a file has been included to allow unlimited scalability. Within an organization, one
generic Profile can now be created, and utilizing text files, specific information about the user
and the desired folders to be synchronized can be imported dynamically. Variables can be
used to dynamically introduce data from a file into various fields throughout the interface in-
cluding file paths, deletion paths, log file paths, log file names, etc.

Field data is imported through: 

<<#FileName.txt [section] item#>>

In which the [section] is a defined field in a file, such as the example file content below.

[Info] 
Name=Cris Smith
Home=c:\mydocuments
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Using <<#FileName.txt [Info] Name#>> will import "Cris Smith" into the path it was used in and
using <<#FileName.txt [Info] Home#>> will import "c:\mydocuments" into the path it was used
in. 

Note: This feature requires the Enhanced Package. 

PeerSync now contains tools for importing data from files to dynamically create Jobs. Within an or-
ganization, one generic Profile can now be created, and utilizing text files, specific information
about the user and the desired folders to be synchronized can be imported dynamically. Lists can
be used in Source and Target path names as such:

Source: <<$FileNameSources.txt$>>
Target: <<$FileNameTargets.txt$>>

or: 

Source: <<$C:\Path\To\File\FileNameSources.txt$>>
Target: <<$C:\Path\To\File\FileNameTargets.txt$>>

Corresponding entries of each delimited file entry will be used to dynamically create a Job
based upon the Jobs properties.

Note: This feature requires the Enhanced Package. 

PeerSync allows for the ability to dynamically map and un-map a Source or Target folder se-
lection. The way you do this is to add a letter to the beginning of the UNC path that you wish to
map the drive to. This can be done for the Source or Target selection (i.e. n\
\COMPUTER\SHAREDDEVICE\PATH).

For Example: n\\DELLSERVER\D\USERDATA 

The example above will map the D drive on the DELLSERVER to the N drive upon start of
PeerSync and will unmap the drive when PeerSync terminates. This is a quite useful feature
especially when running PeerSync as a service in the scenario where you want to synchron-
ize to a mapped drive. This feature will allow for it to occur seamlessly. 

Note: If you are going to run PeerSync as a Service it is advised to use UNC paths or Peer-
Sync's Dynamic Network Drive Mapping and Unmapping feature instead of using mapped
drives due to the fact that mapped drives are not understood when a user is not logged on.

Ne xt/La st Ava ila b le  Drive  Ma p p ing  

This feature allows for the dynamic mapping of the next (A) or last (B) available network drive
by using the following format in the Source or Target Fields:

Map Next Available Example:  A\\COMPUTER\SHAREDDEVICE\PATH
Map Last Available Example:  B\\COMPUTER\SHAREDDEVICE\PATH

Lo ca l Drive  Ma p p ing

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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This feature allows for the dynamic mapping of a local drive by using the following format in
the Source or Target Fields:

Map Local to N Example: N\\LOCALCOMPUTER\SHAREDDEVICE\PATH

1.1.3  Automation

T o p ics
Automation Overview
Automation Options

The Automation screen allows you to apply Real-Time Monitored or Scheduled synchroniza-
tion to individual Jobs within a given Profile. Real-Time operations (also referred to as
"File/Folder Change Detection") monitor Source Folders for any changes and synchronize
them to the specified Target as they occur. Scheduled operations automatically launch syn-
chronization according to a user-specified schedule. Through these settings, PeerSync al-
lows you to build a Profile with as many as 255 different Jobs -- each run according to a
unique schedule or in Real-Time (Also see Command Line Arguments for Global Automation
Settings).

Sca nning  Op tio ns

The options listed on this page can be accessed from the Automation window. This screen
allows the user to set the frequency of scans as well as enable Real-Time replication.

Sca n Jo b  Once  a t
Sta rt

This feature directs PeerSync to run the current Job as an Auto-
matic Operation. An Automatic Operation allows you to perform
an immediate launch of the current Profile. As a non-persistent
process, Automatic Operations are run a single time upon
manual initiation by the user. We also refer to this type of run as
an Initial Sync. 
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Sca n Jo b  e ve ry  x
minute (s)

Checking this feature assigns a Scheduled operation to the se-
lected Job(s). The field associated with this feature allows you
to set an interval in minutes: after this time has elapsed the se-
lected folders will be synchronized. 5 minutes is the default set-
ting. Intervals in seconds can be specified through the use of
decimals, (i.e. 0.5, 2.5, etc.); the minimum interval is 0.01.   

Sca n Jo b  a t x Checking this feature will allow for the synchronization of Jobs
at a specific times of the day for selected days of the week.
When selected the Da ily  T ime r Op tio ns  dialog will appear
with the following options: 

Run se le c te d  Jo b s a t
Available from the "Daily Timer Options" dialog opened by
clicking on the button to the right of the "Scan Job at" field.
Selecting this feature will run the Job at the selected time of
day.

Lis t o f Jo b  Se le c tio ns
Available from the "Daily Timer Options" dialog opened by
clicking on the button to the right of the "Scan Job at" field. This
is a list of the currently selected Daily Timer selections. You
can Add New selections by selecting the New button and De-
lete existing selections by selecting the Delete button. 

Se le c t d a ys  o f we e k to  run
Available from the "Daily Timer Options" dialog opened by
clicking on the button to the right of the "Scan Job at" field. Al-
lows you to turn on/off which days to run this schedule.

Se le c tio n Op tio ns
Available from the "Daily Timer Options" dialog opened by
clicking on the button to the right of the "Scan Job at" field. This
feature will give you the option to run the selected daily timer
schedules in a Recurring mode (synchronization will run every
time according to the set scheduled options) or Run Once (syn-
chronization will run only once).

Use  Enha nce d  Sca n-
ning  (Enhanced Scan-
ning)

The Enhanced Scanning option is required for this feature to be
enabled. Enhanced Scanning provides the ability to build mul-
tiple dynamic Jobs for parallel processing of folders during
scans.   This will significantly improve the time PeerSync takes
to scan trough directories.  By default PeerSync scans through
a Job sequentially, one folder at a time. With the Enhanced
Scan option enabled PeerSync will spawn a Job Thread for
each folder or subfolder encountered during a scan. 

When the Use  Enha nce d  Sca nning  checkbox on the Auto-
mation window is checked the  Enha nce d  Sca nning  dialog
will open. By default the slider in the Enhanced Scanning dia-
log is set to the Off position all the way to the left side. To en-
able the Enhanced Scan feature move the slider to the right.
Each slide position represents a depth level of 1, 2, 3, 4, and 5

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
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respectively. Each value represents the depth level at which
PeerSync will spawn a Job thread for each folder it encounters.

Exa mp le :

If you set the Enhanced Scanning slider to Level 3, then Peer-
Sync will spawn 7 dynamic Jobs for the Users directory depic-
ted bellow. It will in essence create a dynamic Job for each of
the folders at Level 3 (Folder1, Folder2, Folder3, and Folder4).
It will then create a Job for the folders at Level 2 (Users1 and
User2) but will exclude all their subfolers. Lastly, it will create a
Job for the directory at Level 1 (Users) and exclude all the sub-
folders. 

Notes: 

1. The Enhanced Scanning and the Multi-Threading add-on options are re-
quired for this feature. Please visit http:/ / www.peersoftware.com or con-
tact Sales for additional information.

2. When using this option be sure you make available a large pull of Job
Threads to be used by PeerSync so that dynamic Jobs can be created for
each folder during a scan.

3. This feature is not supported when using the Enhanced Bi-directional op-
tion.

Re a l-T ime  Eve nt De te ctio n Op tio ns

The options listed on this page can be accessed from the Automation window. This screen
allows the user to set the frequency of scans as well as enable Real-Time replication.

Use  Re a l-T ime  Mo nit-
o ring

Selects the current Job(s) for Real-Time Monitoring.

Re a l-T ime  Op tio ns... This button opens an "Additional Options" dialog box. Once
this box has opened, it allows you to choose from two Real-
Time operations. The first is a Folder Replication feature, which
monitors for changes to the Source Folder and synchronizes
the Target accordingly. The second, a Folder Restoration fea-
ture, monitors for changes to the Target Folder and restores

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
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files on the Target accordingly. To properly use the restore
feature, you will need to select the "Always overwrite Target
files" option. 

Notes:

1. Bi-directional will be ignored for Real-Time Jobs.

Enha nce d  Re a l-T ime  Mo nito ring

This feature allows the Real-Time feature in PeerSync to de-
tect individual changes to files and synchronize only the file
which has changed without scanning the entire folder where the
change occurred. Normally, synchronization software scans
and compares all files into a folder which is being synchron-
ized. This feature does not scan folders unless the change is
indeterminate. If a file or folder is renamed, PeerSync will re-
name the corresponding Target File or folder using rename
functions as opposed to copying the newly renamed Source
Folder to the Target and then subsequently deleting the out-
dated Target file/folder. This feature greatly reduces the time
required to synchronize files and also reduces network band
width requirements.

With this option enabled PeerSync will continue to detect real-
time events even during a scan. 

Notes:

1. Bi-directional, During comparison subtract/add x minute(s)
from Target, and Trigger Selections, as well as, other non ap-
plicable features may be ignored during Enhanced Real-Time.

2. It is recommended either use the Enhanced Real-Time op-
tion for all or none of your Real-Time Jobs within a Profile.

3. Using Enhanced Real-Time will produce a different file out-
put format for all modes of reporting and message logging (Re-
porting, Admin Reporting and Email Reporting). The output will
NOT contain a start and stop section or a summary, each entry
will also be initially marked with a date and time stamp. If use
summary is selected for Admin or Email reporting then the
standard selection will be used. The reason this is done is due to the fact

that processes will be running in parallel.

Use  Sta nd a rd  Re a l-T ime  Mo nito ring

When the Real-Time feature detects a change to synchronize,
this method will cause a scan to run on the root folder, but not
the subfolders. For folder manipulations such as renames, the
entire folder including its subfolders will be scanned. 
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Glo b a l Se tting s See Source Folder Global Options. 

1.1.4  Blackout Settings

T o p ics
Blackout Settings Overview

Bla cko ut Pe rio d

This screen will enable you to set a Blackout period during the daily synchronization. This
is a period in which the synchronization will stop and wait until the blackout period has ex-
pired according to the specified settings. This would be a useful feature if you wish to stop
all the synchronization activities during a particular time when the Network Bandwidth is
busy with other activities (such as during working hours).

Susp e nd  a ctive  sca ns
whe n a  Bla cko ut
p e rio d  s ta rts

Enabling this option will pause all the scheduled scans during
the specified Blackout and will resume after the Blackout
period ends.

What happens if PeerSync is performing a scan when it enters the Blackout
period?
If the option to "Suspend active scans when a Blackout period starts" is enabled the scan will
be suspended and resumed at the point it was left off after the Blackout period ends. If this op-
tion is not enabled, the scan will be stopped during the Blackout period and will be restarted
from the beginning after the Blackout period ends.  

What happens if PeerSync was in the middle of transferring a large file
when it entered the Blackout period?
PeerSync will allow the transfer to complete but suspend any new events from being pro-
cessed until the Blackout period ends. The suspended events or scans will be processed
after the Blackout period ends.

What happens if a scan is scheduled to run during the Blackout period?
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Regardless if the option to "Suspend active scans when a Blackout period starts" is enabled
the scan that is scheduled to run during the Blackout period will run after the Blackout period
ends. Multiple suspended scans for a single Job will be compiled into a single scan that will
run at the end of the Blackout period. 

1.1.5  Scan Limitations

T o p ics
Maximum Duration of Scans
Initiate Scan on trigger File Change

Note:  Features listed on this page require the Enhanced Package.

Enabling the Se t ma ximum d ura tio n to  x minute s  option allows you to specify a max-
imum duration for each Job. This gives you the ability to limit the run time of a Job during ini-
tial, interval, and scheduled scans. 

T rig g e r File s

These settings ensure that the Target Folders always remain updated to their correspond-
ing Source by comparing dates indicated by individual Trigger Files. For example, if a
Source Trigger is found to be newer than a corresponding Target Trigger, a synchroniza-
tion process will be allowed to proceed for the selected Job(s). If the files date and time
stamps match then the synchronization will not be processed. Therefore, the run of the sync
process is in essence, determined by the trigger files.

Use  T rig g e r File s This feature is used to activate or trigger synchronization
based upon date comparison between an individual Source
Trigger File and a separate Target Trigger File. If the Target
Trigger File is older then the Source Trigger File, the entire
Source Folder(s) will be synchronized. 

De fa ult File  Na me Displays the Default Global Trigger File Name: GLBCHG.000

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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So urce  T rig g e r File This field allows you to specify a Global Trigger File by enter-
ing it manually, or by selecting it using the browse button loc-
ated at the right side of the field. 

Use  Curre nt Pa ths Automatically selects the current Trigger Files associated with
the Source and Target Folders.

T a rg e t T rig g e r File This field allows you to specify a Global Trigger File by enter-
ing it manually, or by selecting it using the browse button loc-
ated at the right side of the field.

Note:  During Enhanced Real-Time, Trigger Selections will be ignored. 

1.1.6  File Options

T o p ics
Mode Selection
Event Options

Mo d e  Se le c tio n

The options listed on this page can be accessed from the File Options window.

Sta nd a rd  (up d a te  T a r-
g e t File s  if So urce  is
ne we r)

With this mode selection, PeerSync will update files on the Tar-
get only if the Source is newer.

Alwa ys o ve rwrite  (Up -
d a te  T a rg e t File s  if
the  So urce  is  ne we r o r
o ld e r)

This feature automatically overwrites any files in the Target
Folder that have a different date\time stamp than their corres-
ponding Source File, even if the Target File is newer. This fea-
ture can be used to restore folders to a previous state either for
backup/restore operations or to reset files after training opera-
tions.  
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Bi-d ire c tio na l (b o th
d ire c tio ns)

With this feature selected, PeerSync will merge the data of the
Source and the Target folders during Scan at Start, interval and
scheduled scans. This feature may be ignored during Real-
Time and Enhanced Real-Time modes. The following will hap-
pen when this feature is selected with the Replicate - Delete un-
matched files/folders option enabled:  

If a  File  e xis ts  in b o th So urce  a nd  T a rg e t Fo ld e rs
PeerSync will compare the Modified date/time of the files and
update/overwrite the older file with the newer file. If the modified
date/time is identical PeerSync will not perform any action. 

If a  File  e xis ts  in o nly  the  So urce  o r T a rg e t Fo ld e r
PeerSync will compare the Modified, Created and Accessed
date/time of the file with the stored Last Run On date/time of the
Job. If any of the three file date/times are newer than the stored
Last Run On date/time the file will be added, otherwise the file
will be deleted.  

If a  Sub -Fo ld e r e xis ts  in o nly  the  So urce  o r T a rg e t
Fo ld e r
The Source will be seen as the primary folder and any sub-
folders with content existing on the Source will be added to the
Target. If the folder is empty or exists on the Target, PeerSync
will compare the Modified, Created and Accessed date/time of
the folder with the stored Last Run On date/time of the Job. If
any of the folder date/times are newer than the stored Last Run
On date/time the folder and all of its contents will be added, oth-
erwise the folder will be deleted. 

Note: 

PeerSync now also supports real-time or scheduled bi-directional replication us-
ing our TCP replication mode. To achieve real-time bi-directional replication
across TCP, PeerSync and PSListener would need to be installed on both the
Source and the Target machines. For scheduled bi-directional replication
across TCP, PeerSync would need to be installed on one side, while the
PSListener on the other. This feature is not supported when using a TCPTar-
get.

Re la te d  Op tio ns
Global Bi-directional Options

Notes: 

1. The Bi-directional feature is only supported when working with a Normal Source and a Normal or TCP Target.

2. The Bi-directional feature may be ignored when using TCP Source.

3. The Bi-directional feature is only valid during scans and will be ignored during Real-time monitoring.

4. Non NTFS partitions may behave differently using the Bi-directional mode. You may notice files being retained for up to
one day, even if you delete a file from the Source or Target.

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
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5. Modifications, such as renames and deletes, of Target Folders are subject to restoration in the Bi-directional mode.

Eve nt Op tio ns

The options listed on this page can be accessed from the File Options window.

Ad d  - synchro nize
ne w fi le s  to  T a rg e t

If the Source contains files not found within the Target and this
feature is selected, those files will be added to the Target
Folder during synchronization. This feature is selected by de-
fault. 

Up d a te  - synchro nize
e xis ting  fi le s  in T a rg e t

If this feature is selected, Target Folder files which are also
found within the Source will be updated to match those Source
files during synchronization. This feature is selected by default. 

Re p lica te  - De le te  un-
ma tche d  fi le s

If this feature is selected, any unmatched files found in Target
Folders will be deleted automatically. 

CAUT ION:  Use this feature carefully. If not configured prop-
erly, needed files may be permanently deleted. A deletion
warning is NOT displayed by default: Profiler must be first set to
display this warning through the "Deletion Warning Message"
check box.

Re la te d  Op tio ns

Deletion Options
Move Options

De le te  Op tio ns

The options listed on this page can be accessed by clicking on the De le tio n Op tio ns
button from the File Options window. Once the Replicate - Delete unmatched files option is
turned on the De le tio n Op tio ns  button will be enabled for further configuration. Clicking on
the Deletion Options button opens the "Additional Options" dialog box which contains the
following features:

De le tio n Wa rning
Me ssa g e

The upper section of this screen allows you to enable or dis-
able a Deletion Warning Message, as well as set the number
of seconds for which a Message will be displayed (a message
is NOT enabled by default and is not available during En-
hanced Real-Time). In addition, you can also choose to dis-
play a message requiring manual intervention in order to activ-
ate deletions. 

The Re q uire  ma nua l inte rve ntio n option is only used dur-
ing single threaded operations and/or standard real-time. It will
also be ignored during real-time when using:
· Multiple Job Threads
· Multiple Copy Threads
· Enhanced Scanning
· FastSync
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This option will also be ignored during real-time when using En-
hanced Real-time monitoring (File Level Change Detection).
However, it will be used (when not using the items listed above)
for Standard Real-time monitoring (Folder Level Change
Detection).

Mo ve  Op tio ns

By clicking on the Mo ve  Op tio ns  button in the File Options window you will be able to ac-
cess the Move Deleted File Options dialog which has the following settings available:

Mo ve  De le te d  File s
Op tio ns

This section provides a field where the user can designate an
alternate folder to which unmatched files will be moved in order
to avoid permanent deletion. This folder path can be typed
manually, or selected using the browse button provided to the
right of the field. If the designated folder exists, all unmatched
files will be moved there, allowing you the opportunity to re-
cover files deleted from the Target. This field also supports
File/Folder Path Variables and when used, the current path will
be displayed above the field. Beneath this field are path op-
tions.

We strongly recommend using a Deletion Folder that is loc-
ated on the Target host computer. Relocation to an alternate
drive or host adds unnecessary processing and bandwidth
overhead. For this reason PeerSync uses the following Dele-
tion Folder variables: 

%T ARGET ROOT %
This variable resolves to the root directory of the target path.
For example if the target path is \\machine1\c$\Target\Docs,
the deletions path %TARGETROOT%\Deletions will resolve to
\\machine1\c$\Deletions. This variable is used by default. 

%T ARGET PARENT %
This variable resolves to the parent directory of the target path.
For example if the target path is \\machine1\c$\Target\Docs,
the deletions path %TARGETPARENT%\Deletions will re-
solve to \\machine1\c$\Target\Deletions.

Re la tive  Pa ths This feature will move files deleted by PeerSync from the root
folder to the root of the selected folder. Files deleted from sub
folders will be moved to corresponding sub folders below the
root selected deletion folder. This feature is intended (works
best) for a Profile with a single Job. 

E
x
a
m
p
l

Source Folder: C:\ MyDocs\ Files\
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e
:

Target Folder: D:\ MyDocs\ Files\  

Move Path: C:\ DeleteFolder\

If you delete: C:\ MyDocs\ Files\ Sub\ File.txt

PeerSync will
move:

D:\ MyDocs\ Files\ Sub\ File.txt

To: C:\ DeleteFolder\ Sub\ File.txt

Pre se rve  Pa ths This feature will recreate the original path of the deleted file un-
der the specified path. Therefore, a file deleted by PeerSync
will be moved into a folder that corresponds to the file's original
location: under the selected deletion folder. This feature is in-
tended (works best) for a Profile with Multiple Jobs.

E
x
a
m
p
l
e
:

Source Folder: C:\ MyDocs\ Files\

Target Folder: D:\ MyDocs\ Files\  

Move Path: C:\ DeleteFolder\

If you delete: C:\ MyDocs\ Files\ Sub\ File.txt

PeerSync will
move:

D:\ MyDocs\ Files\ Sub\ File.txt

To: C:\ De-
leteFolder\ D_MyDocs\ Files\ Sub\ File.txt 

Use  Re cyc le  Bin This feature allows you to specify the Windows Recycle Bin as
a location for unmatched files. This feature is not intended for
use when file deletions made by PeerSync may occur on a
non-local machine or device. Only files deleted from a local
drive can be moved to the Recycle Bin, if this feature is used all
network files will be permanently deleted. 

De le te  unma tche d
T a rg e t File s  o ld e r
tha n x d a ys

This feature is intended for the cleanup of files that were can-
didates for deletion but were selected to be moved to an un-
matched folder. By use of this feature, PeerSync can be used
to temporarily store files setup for deletion and then have the
files deleted after a specified number of days. By default dele-
tion folders are checked every 24 hours or immediately after
the initial scan (if Scan Job Once at Start is enabled). This inter-
val can be modified by using the /LH:n argument where n is
represented in minutes. 

Notes: 

1. Only one copy of any file can exist in your designated Recovery folder.

2. To avoid filling up your hard drive unnecessarily, you should periodically check this folder and delete unwanted
files or use the  Delete unmatched Target Files older than x days option.



PeerSync Help 74

Copyright © 1993-2019 Peer Software Inc. All Rights Reserved

3. Only files deleted from a local drive can be moved to the Recycle Bin, if this feature is used, all network files will
be permanently deleted.

4. The Deletion Warning Message option is not available during Enhanced Real-Time.

5. When using the Alternate Target Path Selections feature you cannot use variables that are specific to the Job
(i.e. %JobName%, %SourcePath%, etc.) for the Move unmatched Target Files option.

1.1.7  NFS Settings

T o p ics
Use Unix/Linux system for Job Scans, Copy File and/or setting Permissions
Use Optional Target Unix/Linus system for use with rsync daemon
Modify NFS Default Options

Note: 

Features on this screen require an NFS and NetApp enabled license.  Please visit http:/ / www.peersoftware.com or
contact Sales for additional information.

Use  Unix /  Linux sys te m fo r Jo b  Sca ns, Co p y File  a nd /o r se tting  Pe rmiss io ns

IP Ad d re ss Enter the IP address of a Unix/Linux system to use (i.e. Ubuntu
or Red Hat) for processing NFS commands.

Use r Na me Provide the user name for a Unix/Linux system to use (i.e.
Ubuntu or Red Hat) for processing NFS commands.

Pa sswo rd Provide the password for a Unix/Linux system to use (i.e.
Ubuntu or Red Hat) for processing NFS commands.

Co nfig ure ... Click this button to access the CIFS/NFS configuration dialog.

Mo unt Fo ld e rs Click this button to mount the current Source and Target Folder
selection on the selected Unix/Linux system.

http://www.peersoftware.com
http://www.peersoftware.com/contact.html
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Unmo unt Fo ld e rs Click this button to unmount the current Source and Target
Folder selection on the selected Unix/Linux system.

Note: 

Features on this screen require an NFS and NetApp enabled license.  Please visit http:/ / www.peersoftware.com or
contact Sales for additional information.

Use  Op tio na l T a rg e t Unix/Linux sys te m fo r use  with rsync d a e mo n

IP Ad d re ss Enter the IP address of a target Unix/Linux system to use with
rsync daemon (optional target side).

Use r Na me Provide the user name for a target Unix/Linux system to use
with rsync daemon (optional target side).

Pa sswo rd Provide the password for a target Unix/Linux system to use with
rsync daemon (optional target side).

Se tup /T e st rsyncd Click this button to setup optional rsyncd (optional target side).

Mo unt T a rg e t Pa th Click this button to mount the current Source and Target Folder
selection on the selected Unix/Linux system (optional target
side).

Unmo unt T a rg e t
Fo ld e rs

Click this button to unmount the current Source and Target
Folder selection on the selected Unix/Linux system (optional
target side).

Note: 

Features on this screen require an NFS and NetApp enabled license.  Please visit http:/ / www.peersoftware.com or
contact Sales for additional information.

Mo d ify  NFS De fa ult Op tio ns

Check this option if you wish to modify the mo unt or rsync commands used by PeerSync.
Modifying the defaults should be done with caution as changes can drastically affect ex-
pected results. 

NFS mo unt Op tio ns Lists the NFS mount options to be used when creating source
and target folder mounts on selected Unix/Linux system. Please
use caution if making changes to the defaults:

soft,intr,posix,actimeo=5,rsize=65536,ws-

ize=65536,vers=3

NFS rsync Op tio ns Additional options to use when executing rsync commands.
Some options may be dynamically added based on Profile
and/or Job settings such as: -a, -r, -l, -t, -D, -A, --update, --par-
tial, --inplace, --exclude, --include and -n. The defaults are:

http://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
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--progress -v -i -z -H

Note: 

Features on this screen require an NFS and NetApp enabled license.  Please visit http:/ / www.peersoftware.com or
contact Sales for additional information.

1.1.8  Permissions

T o p ics
File/Folder Permission Options
Related Global Settings

Note: 

Some features on this screen require an NFS and NetApp enabled license.  Please visit http:/ / www.peersoft-
ware.com or contact Sales for additional information.

File /Fo ld e r Pe rmiss io n Op tio ns

T ra nsfe r File  a nd
Fo ld e r Pe rmiss io ns

Enable this option to transfer File and Folder Permissions
(NTFS security style via CIFS or UNIX security style via NFS).
When enabled, the NT FS Op tio ns  and Global Settings link
will be enabled for further configuration.  

NT FS Op tio ns Click this button to open the ACL Op tio ns  dialog. The options
in this dialog allow you to specify the types of permissions you
want PeerSync to detect and transfer. The options include
Owner, DACL: Discretionary Access Control List (enabled by
default), and/or SACL: System Access Control List.

http://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
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Glo b a l Se tting s Click this link to open the Global Settings dialog and set the
global permission settings.

Notes: 

1. Care must be exercised when using ACL options to synchronize files and folders between different domains. File
security transfers could make the target file inaccessible after transfer/ update.

2. When you use a local drive letter (either for the source or target path) you need to make sure the drive is as-
signed as an administrative share (i.e. D$) in order for ACLs to work properly.

3. This feature may be ignored when using an TCP Source or Target.

4. Some features on this screen require an NFS and NetApp enabled license.  Please visit http:/ / www.peersoft-
ware.com or contact Sales for additional information.

Re la te d  Glo b a l Se tting s

This section identifies the security style that has been globally set. The choices are NTFS
style (via CIFS) or UNIX style (via NFS).

Se curity  s ty le Click the Se curity  s ty le  link to change the security style per-
missions in the CIFS/NFS tab. 

Note: 

Some features on this screen require an NFS and NetApp enabled license.  Please visit http:/ / www.peersoft-
ware.com or contact Sales for additional information.

1.1.9  Open Files

T o p ics
Open Files Overview
Managed Files
Global Settings

http://www.peersoftware.com
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
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Op e n File s

The options listed on this page can be accessed from the Open Files window.

Inc lud e  o p e n fi le s  (a l-
lo w re a d  & write  a c-
ce ss  to  so urce  fi le
d uring  tra nsfe r)

Use this option when you want to include open files and allow
users to modify them while they are being transferred. For
locked files such as database files, PeerSync will first attempt
to process them using the Managed Files setting if enabled.  If
this process is not enabled or fails, locked files will be retried
based on the retry open/inaccessible files setting.

Note:  If PeerSync is able to synchronize files which are in use by other applic-
ations, access to those applications may in certain instances be temporarily lost
during synchronization. 

Inc lud e  o p e n fi le s  (a l-
lo w re a d  a cce ss to
so urce  fi le  d uring
tra nsfe r)

Use this option when you want to include files that are open for
read-only access. Users will be able to open source files for
read-only access while they are being transferred.   For files
that are being modified or are locked PeerSync will first attempt
to process them using the Managed Files setting if enabled.  If
this process is not enabled or fails, these files will be retried
based on the  retry open/inaccessible files setting.

Exc lud e  o p e n fi le s
(a llo w re a d  a cce ss to
so urce  fi le  d uring
tra nsfe r)

Use this option when you want to replicate only files that are
closed. Files that are opened or locked will be retried based
on the  retry open/inaccessible files setting. Users will be
denied write access to source files that are being transferred
but may have the option to open them in read-only mode. 

We recommend you use this option when doing replication/col-
laboration from one source to multiple destinations. This option
allows PeerSync to replicate files from one source to multiple
destinations, in parallel, while at the same time protecting the
source files from write access during their transfer. 

Exc lud e  o p e n fi le s
(d e ny a ll a cce ss to
so urce  fi le  d uring
tra nsfe r)

Use this option when you want to replicate only files that are
closed. Files that are opened or locked will be retried based
on the  retry open/inaccessible files setting. Users will be
denied complete access to the source files that are being
transferred. 

We recommend you use this option when doing real-time bi-
dirrectional synchronization/collaboration between two hosts.
For collaboration between more then two machines we recom-
mend you use the Exc lud e  o p e n fi le s  (a llo w re a d  a cce ss
to  so urce  fi le  d uring  tra nsfe r) option. 

Re la te d  Op tio ns
Managed Files
Global Settings
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Note: In order to replicate locked files you will require the VSS add-on module. If you do not configure the Managed
Files setting to use VSS, locked files will be retried based on the  retry open/ inaccessible files setting. 

1.1.10  Managed Files

T o p ics
Managed Files Options
Managed Files - Global Settings

Note:  Features listed on this page require the VSS option.

Ma na g e d  File s

The options listed on this page can be accessed from the Managed Files window. 

Ena b le  Ma na g e d  File
Acce ss (So urce  File s
Only)

Enabling this option will allow you to reliably backup open and
locked files while users continue to work on them. For this fea-
ture to be available you will require the Volume Shadow Copy
Service (VSS) add-on module. This technology has been in-
tegrated with PeerSync to allow synchronization of critical data
such as system files and databases. By default this feature is
enabled at the end of a manual synchronization and is run
every 2 hours during persistent (Real-Time or scheduled)
modes. This interval can be modified from the Global Settings
screen via the Global Managed Files Options link to a min-
imum interval of 30 minutes. For more features on configuring
this option please view the Managed Files Arguments.

Synchro nize
o p e n/ lo cke d  fi le s  v ia
Ma na g e d  File s

Through the use of this feature PeerSync will enable pro-
cessing of the Open and Locked Files from the local machine,
through the use of the Volume Shadow Copy Service (VSS)
technology. Please note VSS will delay processing of files to
the specified interval.  VSS is an add-on module.

http://www.peersoftware.com/products/recommended_options/vss.aspx
http://www.peersoftware.com/products/recommended_options/vss.aspx
http://www.peersoftware.com/products/recommended_options/vss.aspx
http://www.peersoftware.com/products/recommended_options/vss.aspx
http://www.peersoftware.com/products/recommended_options/vss.aspx
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Synchro nize  ALL fi le s
v ia  Ma na g e d  File s
(inc lud ing  fi le s  tha t
a re  no t o p e n/ lo cke d )

Through the use of this feature, you can force PeerSync to
send all the file processing through the Volume Shadow Copy
Service (VSS) technology. Please note VSS will delay pro-
cessing of files to the specified interval. VSS is an add-on mod-
ule.

Re la te d  Op tio ns
Global Settings

Notes: 

1. These options require the VSS add-on module. Please visit http:/ / www.peersoftware.com or contact Sales for addi-
tional information.

1.1.11  Performance

T o p ics
Performance Overview
Options/Commands

Pe rfo rma nce  Op tio ns

The options listed on this page can be accessed from the Performance window. 

File  Re a d /Write  Buffe r
Size

This feature allows you to change the read/write buffer sizes to
optimize performance/speed across various network environ-
ments or on the local machine. In most cases this will increase
performance dramatically but you will probably need to test this
feature in your environment to determine what advantages can
be gained from altering this size.

The minimum value is 256 bytes.
The default value is 64 KB.

http://www.peersoftware.com/products/recommended_options/vss.aspx
http://www.peersoftware.com/products/recommended_options/vss.aspx
http://www.peersoftware.com/products/recommended_options/vss.aspx
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
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The maximum value that can be set using the track bar is 128
KB.
The maximum value that can be set using the up arrow or by
manually typing in the spin edit field is 128 KB

Buffe r Size  Up p e r
Limit (* Multi Threading
Optionng Option)

A higher upper limit of 1 MB is available with the Multi Thread-
ing Option option. This value can be set using the up arrow or
by manually typing a set value into the spin edit field. 

T hro ttle  b a nd wid th -
Use  x p e rce nt o f
a va ila b le  b a nd wid th

This feature is designed to limit or slow down the pulse of
reads and writes performed by PeerSync, at the percentage
specified, in order to keep bandwidth available for other ap-
plications to use. This is done at the file level and is performed
by each Copy Thread during the transfer of each file. As we
copy a file we track how long it takes to read and write data
from the source to the target. Every 100 milliseconds from the
start of a file transfer we calculate how much time to allot for pro-
cessing and sleeping based on the percentage set for the op-
tion.

Examples:

100% Always Process
90% Process for 90 milliseconds Sleep for 10 milliseconds
every 100 milliseconds 
50% Process for 50 milliseconds Sleep for 50 milliseconds
every 100 milliseconds
10% Process for 10 milliseconds Sleep for 90 milliseconds
every 100 milliseconds

In summary, PeerSync determines bandwidth throttling by cal-
culating the amount of time required to send a packet of data
across your network and then applying a delay based on the
throttling percentage specified. 

T ime  & Da y Op tio ns
Limit Bandwidth Trottling between the hours and days defined
for the selected Job. Using a W+ switch in the /Q8B argument
(i.e. /Q8BW+) will display/report bandwidth % used for file add
and update events as part of the remarks field.

Notes: 
1. This methodology should dynamically allow for PeerSync to transfer data at

a fast pace when no other applications are using bandwidth and allow it to
back off when other applications are using bandwidth.

 
2. This methodology is more accurate when using smaller Read/ Write Buffer

settings. 

3. This methodology does not include small files that take less than 100 milli-
seconds to process. 

Ena b le  inte ll ig e nt ne t-
wo rk  lo a d  b a la nc ing
(whe n a p p lica b le )

The network load balancing option will automatically set a
read/write buffer size based on recommendation from NIC net-

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
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work cards (Installed network cards must also support this fea-
ture).

Se t ma ximum numb e r
o f co p y thre a d s to  x (*
Multi Threading Option)

This feature will limit the number of copy threads to be
spawned and used for the selected Job during folder scans.
This thread limit does not apply to enhanced Real-Time
events. By using limits for scanning, it helps the Profile to better
process Enhanced Real-Time events during heavy scan oper-
ations.

Re la te d  Op tio ns
Options/Commands

Note:  Some features described on this page require the Multi Threading Option. Please visit http:/ / www.peersoft-
ware.com or contact Sales for additional information.

1.1.12  Byte Replicator

T o p ics
Byte Replicator Options 

Note:  Features listed on this page require the Byte Replicator options.

<%REPLICAT OR%> Op tio ns

The Byte Replicator screen enables and configures Block/Byte level synchronization for
the selected Job. Through the use of this feature PeerSync will be able to transmit only the
bytes/blocks of a file that have changed instead of transferring the entire file. 

Use  b lo ck/b yte  le ve l
synchro niza tio n

Select this option to enable/disable block/byte level replica-
tion. If this is disabled, PeerSync will use the standard copy

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
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method to synchronize the file. If the Byte Replicator fails to syn-
chronize a file, i.e. On Failure, PeerSync will either: 
1. Log Messages & Use Recovery Intervals (if applicable)
2. Use Default File Copy for Synchronization 

Blo ck  Size  Se le c tio n This slider controls whether either Performance or Bandwidth
Utilization is most important. Files synchronized with the slider
set Lo w will take longer to complete than with the slider set
H ig h. 

File  Exc lus io ns Clicking on the Exc lus io ns  button in the Byte Replicator win-
dow opens theByte Replicator File  Exc lus io ns  dialog. Files
that match types in the exclusion string (types by file extension)
or files that have a size lower than the Minimum File Size will
use the default file copy method instead of the Byte Replicator
feature.

Exc lud e d  File  T yp e s b y  Exte ns io n
Field containing a list of file types that will use the default file
copy method instead of the Byte Replicator. This feature can
be configured by clicking the button to the right of this field. For
example, to exclude files with the extension LOG you may add
either .lo g  or lo g  to the exclusion list. Multiple entries need to
be semicolon (;) delimited.

Minimum File  Size
Files with sizes lower than the value in this field will be copied
using the default file copy method instead of using the Byte
Replicator. 

Po rt Co nfig ura tio n Clicking on the Po rt Co nfig ura tio n button in the Byte Replic-
ator window displays the Po rt Co nfig ura tio n dialog. This win-
dow allows for a common TCP and/or Byte Replicator configur-
ation option for both the Source and Target paths (see the TCP
Port Configuration tab for more information). 

Note: The TCP WAN Connector (TCP) is an optional feature which may not
be included in your package. Please visit http:/ / www.peersoftware.com or
contact Sales for additional information. 

Note: The Profiler will not support W ell Known Port numbers 0 - 1023. You
must use port numbers that are greater than or equal to 1024. 

Notes: 

1. The Byte Replicator is an optional feature which may not be included in your package. Please visit http:/ / www.peer-
software.com or contact Sales for additional information. 

2. When you use a local drive letter (either for the source or target path) you need to make sure the drive is assigned as
an administrative share (i.e. D$) in order for the Byte Replicator to work properly.

3. In order for Byte Replicator to be enabled, the following criteria must be present:  
· The PS Listener Service has been installed on the remote machine
· The PeerSync license has the Byte Replicator add-on feature

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
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1.1.13  Revisioning

T o p ics
Revisioning Options

Re vis io ning

The options listed on this page can be accessed from the Revisioning window. Through
the use of this feature, you can use PeerSync to keep multiple versions of each file. This is
a great feature for recovering a previously saved version of a file. 

Re v is io ning  - Ke e p
b a ckup  fi le s  o f o ve r-
writte n T a rg e t File s

Select this option to enable/disable the use of Revisions. 

Numb e r o f b a ckup
file s  to  ke e p

Designates the number of revisions to keep for each file. Peer-
Sync revisions each file by adding a ".PSBAK1" extension to
the existing Target File before replacing it with the updated
Source File.

Exa mp le :  "MyFile.txt" will become "MyFile.txt.PSBAK1"

If more than one backup is selected, each file will be renamed
to the next revision when an update occurs:

Exa mp le :  "MyFile.txt.PSBAK1" is renamed to
".MyFile.txt.PSBAK2" 

The newest revisions (backup files) will bear the lowest number
while the oldest will have the higher number:

Exa mp le :  Newer... PSBAK1, PSBAK2, PSBAK3, PSBAKn
...Older
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Note:  If the "Delete Unmatched" option is selected and the Source File that
has corresponding PSBAK files deleted, all associated PSBAK files will also be
deleted.

Ke e p  fi le s  in T a rg e t
Fo ld e r

By default, revisions will be stored in the Target Folder where
the updated Target Files reside. 

Ke e p  fi le s  in De le tio n
Fo ld e r

You also have the option of using the Deletion Folder for stor-
ing revisions. This is quite useful when used in conjunction with
the Delete unmatched Target Files older than x days option,
which is used for automatic cleanup of old revisions. 

Ke e p  fi le s  in Alte rna te
Fo ld e r

You may specify the folder path where you would like the revi-
sions stored to. This option will give you the ability to specify a
separate revision folder per Job. We strongly recommend us-
ing a Revisions Folder that is located on the Target host com-
puter. Relocation to an alternate drive or host adds unneces-
sary processing and bandwidth overhead. For this reason
PeerSync uses the following Revisions Folder variables: 

%T ARGET ROOT %
This variable resolves to the root directory of the target path.
For example if the target path is \\machine1\c$\Target\Docs,
the revision path %TARGETROOT%\Revisions will resolve to
\\machine1\c$\Revisions. This variable is used by default. 

%T ARGET PARENT %
This variable resolves to the parent directory of the target path.
For example if the target path is \\machine1\c$\Target\Docs,
the revisions path %TARGETPARENT%\Revisions will re-
solve to \\machine1\c$\Target\Revisions.

1.1.14  Miscellaneous
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T o p ics
Temp Files
Source File/Folder Alterations
Additional Event Options

T a rg e t File /Fo ld e r Alte ra tio ns

These options can be found in the Miscellaneous window. 

Use  inte rme d ia te  fi le
d uring  co p y

If this box is checked, a temporary file will be created in the Tar-
get Folder: the contents of the Source File will then be copied
into this temporary file. After a successful copy, the Target File
will be deleted and the temporary file will be renamed to bear
the Target File name. This feature ensures that the updated file
will only replace the Target File if copy is successful. If the copy
process should be interrupted because of some outside factor
(network down, power outage, etc), the original Target file will
still be preserved. This option is enabled/disabled automatic-
ally when the Bi-directional or Revisioning options are en-
abled/disabled.

T rig g e r a d d itio na l
e ve nt a fte r succe ssful
co p y

When this option is checked PeerSync will apply the time
stamp of the target file after successfully completing the file
transfer in order to trigger an event on the target side. This ac-
tion will cause the PeerSync installed on the Target to take fur-
ther action with the file such as transferring it to another location
that is not accessible from the originating machine. 

Fo rce  ta rg e t fi le  a ttrib -
ute  se tting s

If this feature is selected, the File  Attrib ute s  Op tio ns  dialog
will be displayed. In this dialog, you may select to force any at-
tribute on or off for the Target files that are synchronized within
the selected Job(s).

File  Attrib ute  Op tio ns  This dialog provides the user the selection to ignore, force on,
or force off attribute settings on Target files that are synchron-
ized within the selected Job(s). 

Re la te d  Op tio ns
Global Settings

So urce  File /Fo ld e r Alte ra tio ns

These options can be found in the Miscellaneous window. 

Mo ve  File s  - De le te
so urce  fi le  a fte r suc-
ce ssful co p y to  ta rg e t

This feature will delete the Source file after the file is copied to
its corresponding Target folder. 

Note:  This feature should not be used with the Delete Un-
matched Target Files option on the File Options screen be-
cause conjunct use of the two options will greatly increase the
chance of data loss.
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T urn fi le  a rchive  a t-
trib ute  o ff a fte r syn-
chro niza tio n

This feature resets the archive flag on the Source and Target
file after synchronization. The Windows file system automatic-
ally sets the archive bit for every file that has changed; nor-
mally, this is used to indicate that a given file has been modi-
fied since the last time its archive bit was set. Most tape back-
up programs use this flag to determine which files have
changed since the last backup. This option will alter Source
files. PeerSync uses this feature to reduce the number of files
that are checked on the Source drive. 

Notes: 

1. Source files that are not being synchronized to Target folders will NOT have their archive flags reset. This process
only occurs after successful synchronization of a changed file.

Hint: To reset all Source file archive flags, use the "Always Overwrite Target Files" feature.
This configures all files for synchronization and consequently qualifies them for the reset of
archive flags. This feature only needs to be selected once to be applied to existing sync op-
erations.

Ad d itio na l Eve nt Op tio ns

This option can be found in the Miscellaneous window.

Inc lud e  a ttrib ute
cha ng e  a s  synchro n-
iza tio n crite ria

This feature allows for the synchronization of files that have dif-
ferent attributes. If this feature has been selected, a Source file
whose attributes do not match the Target will still be included in
the synchronization process. 

Notes:

1. By default this option only works during scans. Use the / LA command line
argument if you wish to enable attribute detection in real-time. 
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1.1.15  Additional Features

T o p ics
Additional Options
Validation Options
File Time Change Options

Note:  Features listed on this page require the Enhanced Package.

Ad d itio na l Op tio ns

The options on this page can be accessed from the "Additional Features" window, avail-
able only with the Enhanced Package.

Ena b le  fi le  re co ve ry This enables the file recovery option to continue a file copy
which may have been interrupted. If the Source and Target file
name and date match but the Target file is smaller, PeerSync
will start the copy operation from the last byte that was sent the
next time a sync operation is executed on the folder. 

Re p la ce  in-use  fi le s
up o n re b o o t

If this feature is selected, once a file is open and locked on the
Target Folder, it will be set to be replaced the next time the ma-
chine is rebooted. 

Note:  This option is only applicable for Jobs with a local Tar-
get Folder.

Re b o o t Op tio ns  But-
to n

This button opens the Reboot Options dialog box. The default
option is "Do not reboot", you may also choose to "Display re-
boot dialog", or to "Automatically reboot".

Note:  Features described on this page require the Enhanced Package.

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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Va lid a tio n Op tio ns

These settings can be accessed from the "Additional Features" window, available only
with the Enhanced Package.

Pe rfo rm b ina ry  co m-
p a riso n o n a ll fi le s
(us ing  CRC32)

Option to check all Source and Target files for binary match
during folder scan/compare cycle (using CRC32). This check
ensures that what is on the Target matches the Source at a bin-
ary level.

Va lid a te  ta rg e t fi le
(us ing  CRC32)

Option to validate file using CRC32 binary comparison after
successful file copy operation. Clicking on the Retry Options...
button opens the Validate File Copy Options dialog box. In this
window you may set PeerSync to continue re-validating a file a
set number of times. 

Retry file copy until CRC of target files is validated
Checking this option will enable the CRC Retry cycle, where, if
a file is not validated, PeerSync will retry the CRC32 validation
x times. The default retry value is 1. 

Set maximum number of tries to
Specify the number of times PeerSync will perform CRC32 val-
idation on a file if the initial validation fails. The default retry
value is 1. 

Note:  Features described on this page require the Enhanced Package.

File  T ime  Cha ng e  Op tio ns

These settings can be accessed from the "Additional Features" window, available only
with the Enhanced Package.

During comparison sub-
tract/add x minute(s) from
target

Option to add or delete time from Target file during folder com-
parison. This allows for synchronization of files between dis-
similar time zones or to allow for some time difference between
Source and Target in case Target machine date is slightly dif-
ferent from Source.

Note:  This feature may be ignored during Enhanced Real-
Time.

Convert file times to GMT
for comparison between
time zones

Option to convert file times to GMT for comparison between
time zone differences of the Source and Target folders. This
feature is quite useful way of synchronizing data between ma-
chines located in different parts of the world. 

After synchronization sub-
tract/add x minute(s) from
target

This option can add or delete time from Target file after syn-
chronization. This allows for synchronization of files between
dissimilar time zones, or to allow for some time difference
between Source and Target in case Target machine date is
slightly different from Source.

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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Note:  Features described on this page require the Enhanced Package.

1.1.16  Exceptions

T o p ics
Exceptions Overview
Include Files
Exclude Files

Exclude Folders
Exclude File by Size
Exclude Files by Attributes
Exclude Selected File Dates

The Exceptions screen is used after you have selected a Job or Multiple Jobs from the Pro-
file Job List and then created an associated Source and Target Folder on the Folder Selec-
tion screen. Through Exception options, PeerSync allows you to selectively apply synchron-
ization to files contained within the Source Folder according to a wide range of explicit cri-
teria. 

Inc lud e  File s

The options on this page can be accessed from the Exceptions window. 

Inc lud e  File s Use this field to determine which file types will be included as
part of synchronization. File Type Inclusions are specified by a
star command followed by the file extension (i.e. *.doc). You
can also specify specific file names and/or sub strings using
the * wildcard character. 

The default setting * includes all files. 

Multiple Inclusions can be used and are semicolon delimited
(i.e. *.doc;*.txt;*.exe). 

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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Inclusions are not case sensitive, (i.e. "A" = "a"). 

Exampl
es

*.doc  - includes any file ending with the extension
.doc 

docs - includes any file that contains the string docs
copy*   - includes any file starting with the string copy
file;dat
a;   

- includes any file containing the strings file or
data 

You may also use the ? wildcard character to further narrow
down your inclusions. The ? wildcard character can be used to
substitute any single character in the file name including num-
bers. 

Exampl
es

????.*   - includes files that have extensions and contain
only 4 characters in the name

June??
??.*   

- includes files that have extensions, start with
the word June, and are  followed by 4 charac-
ters

??
ne????
* 

- includes files that have the characters ne in the
3rd and 4 th positions followed by at least 4
characters

Inclusions can be typed manually, or can be specified using
either the Include File Types button or drop-down list located to
the right of the field.

Inc lud e  File s  Butto n Opens an "Exceptions" dialog box into which file extensions
may be entered. The "include all files" command * will be
shown by default. 

To add an extension, click "New." Next, type the desired exten-
sion into the field located at the bottom of the dialog. Repeat
this process for each desired file type. Inclusions can be de-
leted by selecting them from the list and clicking the "Delete"
key at the bottom of the dialog box. Once you have finished,
click the "OK" button. The dialog will close and all of the Inclu-
sions you have specified will automatically appear in the In-
clude File Types field in the proper format (separated by semi-
colons). 

The drop-down list located to the right of this field will be dy-
namically populated with Inclusions as they are set through the
"Exceptions" dialog described above. They are also added to
the list when you exit the field after manually editing the Include
File Types field. Inclusions can then be specified by selecting
them from this list. This provides a way to store and/or retrieve
sets of Inclusions for later use with other Jobs.

Exc lud e  File s
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The options on this page can be accessed from the Exceptions window. 

Exc lud e  File s Through this field, files can be selectively excluded from syn-
chronization using sub strings or using wild cards.  Exclusions
are set by specifying individual characters (i.e. ~), sets of char-
acters (i.e. copy*), or file extensions (i.e. *.tmp) which, if found
within a file name, will exclude that file from synchronization.

Multiple characters and strings can be used and are semicolon
delimited (i.e. ~;*.tmp;copy*) 

These settings are not case sensitive, (i.e. "A" = "a")

Exampl
es

~          - excludes any file containing the character ~

tmp - excludes any file that contains the string tmp
copy* - excludes any file starting with the string copy
*.tmp    - excludes any file ending with the extension

.tmp
.tmp;.b
ak;~ 

- excludes any file bearing the strings .tmp, .bak
or the character ~

You may also use the ? wildcard character to further narrow
down your exclusions. The ? wildcard character can be used to
substitute any single character in the file name including num-
bers. 

Exampl
es

*tmp?
*.*    

- excludes all files that contain the string tmp fol-
lowed by at least one character before the ex-
tension

Exclusions can be typed manually, or can be specified using
either the Exclude Files Button or drop-down list located to the
right of the field.  

Exc lud e  File s  Butto n Opens a dialog box into which Exclusions may be entered.

To add an Exclusion click "New," then type the desired charac-
ter or string into the field located at the bottom of the dialog.
Repeat this process for each Exclusion. Entries can be deleted
by selecting them from the list and clicking the "Delete" key at
the bottom of the box. Once you have finished, click the "OK"
button. The box will close and all of the Exclusions you have
specified will automatically appear in the Exclude Files field. 

The drop-down list located to the right of this field will be dy-
namically populated with Exclusions as they are set through the
dialog box described above. They are also added to the list
when you exit the field after manually editing the Exclude Files
field. Exclusions can then be specified by selecting them from
this list. This provides a way to store and/or retrieve sets of Ex-
clusions for later use with other Jobs. 
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Exclud e  Fo ld e rs

The options on this page can be accessed from the Exceptions window. 

Exc lud e  Fo ld e rs Use this field to exclude folders from synchronization by spe-
cifying a folder name in file path format, (i.e. \TEMP\ or C:
\WINDOWS\). These examples will exclude any folder path
that contains these strings including sub-folders. 

If you wish to exclude only a specific or root folder such as "C:
\WINDOWS\" but include sub-folders you must include a "#" in
front of the complete folder path (i.e. "#C:\WINDOWS\"). This
example will exclude any files in this directory but include any
files in its sub-folders. A semicolon separates multiple folder
exclusions. 

If you wish to exclude multiple folders that contain the same
string do not include the "\" at the end of the folder exclude (i.e.
\Docs). 

These settings are not case sensitive, (i.e. "A" = "a")

Exampl
es

\Docs - excludes files and sub-folder in folders starting
with Docs (i.e. Docs, Docs1, DocsA, etc.)

\Docs\ - excludes files and sub-folder in folders named
Docs

C:
\Docs\

- excludes files and sub-folder in the folder C:
\Docs\

#C:
\Docs\

- excludes files in the folder C:\Docs\ but in-
cludes files in its sub-folders

Exclusions can be typed manually, or can be specified using
either the Exclude Folders Button or drop-down list located to
the right of the field. 

Exc lud e  Fo ld e rs  But-
to n

Opens a dialog box into which Folder Exclusions may be
entered. 

To add an Exclusion, click "New," then type the desired folder
name into the field located at the bottom of the dialog. Repeat
this process for each Exclusion. Entries can be deleted by se-
lecting them from the list and clicking the "Delete" key at the
bottom of the box. Once you have finished, click the "OK" but-
ton. The box will close and all of the Exclusions you have spe-
cified will automatically appear in the Exclude Folders field.
The drop-down list located to the right of this field will be dy-
namically populated with Exclusions as they are added. Exclu-
sions can then be specified by selecting them from this list.
This provides a way to store and/or retrieve sets of Exclusions
for later use with other Jobs.

Exc lud e  e mp ty  so urce
fo ld e rs

This feature will exclude and will not sync empty Source
Folders to the Target.
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Exclud e  File  b y  Size

The options on this page can be accessed from the Exceptions window. 

Exc lud e  File  Size s Use the "Less Than" or " Greater Than" fields to exclude files
based on their size in bytes. Zero, by default, includes all files.

Inc lud e  File s  b y  Da te

The options on this page can be accessed from the Exceptions window. 

Se le c te d  File  Da te s Use this field to specify files set for synchronization according
to their date stamp. The default setting includes all file dates.
Clicking the button to the right of this field opens a "Select File
Dates" screen. This screen allows you to include all files, in-
clude files more than x days old, include files bearing the cur-
rent and past x day's date, or specify a range of the dates. The
Set Today's Date button automatically updates the existing
range to reflect the current day.

Inc lud e  File s  b y  Attrib ute s

The options on this page can be accessed from the Exceptions window. 

Curre nt Attrib ute s This field displays "Default" or "Customized" to indicate
whether the default attributes have been changed. Clicking the
button to the right of this field opens a window from which
file/folder attributes may be included. All attributes are selected
by default. Uncheck the file/folder attributes you do not wish to
be used as criteria for synchronization. 

Exc lud e  File s  b y  Attrib ute s

The options on this page can be accessed from the Exceptions window. 

Curre nt Attrib ute s This field displays "Default" or "Customized" to indicate
whether the default attributes have been changed. Clicking the
button to the right of this field opens a window from which
file/folder attributes may be excluded. All attributes are un-
checked by default. Select the file/folder attributes you wish to
be used as criteria for exclusion. 
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1.1.17  Reporting

T o p ics
Reporting Overview
Report File Content
Log File Size/Content
SNMP Options

Re p o rting

The options listed on this page can be accessed from the Reporting window. PeerSync
automatically generates Log Files providing a detailed history of all synchronization
events. This screen is used to view Log Files and set their reporting characteristics. 

Use  Lo g  File This feature enables or disables Log file generation. The de-
fault file, PeerSync.Log, is located in the path in which Peer-
Sync has been installed. This field also supports File/Folder
Path Variables and when used the current path will be dis-
played above the field.

Ove rwrite  Exis ting  Lo g
File

Use this feature to report only the most recent PeerSync activity
in the Log File. If this feature is not selected, all PeerSync pro-
cesses will be reported in succession. 

Vie w Lo g  File This button allows you to view Log reports by opening the file in
a text editor. 

Cle a r Lo g  File This button allows you to clear Log reports. 

Re p o rting  File  Co nte nt

The options listed on this page can be accessed from the Reporting window. Using the
check boxes provided in this section of the Reporting screen, you can specify what will be
reported in the Log File. The Default setting is to include all items except Folder Names.
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Ad d e d  File s This feature adds an entry for any file that has been added to
the Target.

File  Da te Includes date associated with each file contained in the Log.

File  Size Includes size of each file contained in the Log.

Up d a te d  File s This feature adds an entry for any file that has been updated in
the Target.

File  T ime Includes time associated with each file contained in the Log.

T ra nsfe r T ime Includes time it takes to transfer the file in milliseconds.

Summa ry Appends a summary of activity to the end of the report.

Fo ld e r Na me s Indicates the names of synchronized folders.

Fo ld e r Cre a tio n This feature creates an entry for any folders that did not exist in
the Target and had to be created during the synchronization
process.

Me ssa g e s This feature logs any messages or application errors found
during synchronization.

Exce p tio ns This feature logs any file/folder exclusion found during syn-
chronization. 

ACLs This feature logs any file/folder ACL updates during scans and
real-time.

Note:  Application errors are additionally written to a file called "PS Error.log,"  regardless of whether or not that op-
tion has been selected.

Lo g  File  Size /Co nte nt

The options listed on this page can be accessed from the Reporting window.

Se t the  ma ximum lo g
file  s ize  to  x b y te s

By entering an amount into this field you can limit the size of Log
Files created by PeerSync. When this limit is reached, the next
reporting session will first rename the existing file to
FILENAME.BAK1.Log and then create a new, blank Log File to
which subsequent data will be added. Two backups
FILENAME.BAK1.Log and FILENAME.BAK2.Log will be kept
for each unique Log file. To customize the number of log files to
backup add the following entry in the PSDef.cfg file:

[Misc Options]
LogBackUpFileCount=3

Unico d e  co nte nt This option will enable the reporting of Unicode content.

SNMP Op tio ns
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The options listed on this page can be accessed from the Reporting window, available
only with the Enhanced Package.

Use  SNMP re p o rting
(e rro rs  o nly )

Use Simple Network Management Protocol error reporting.

SNMP Op tio ns  Butto n This button opens the SNMP Options dialog box. Once this box
has opened, it allows you to select the Destination IP and Trap
Prefix to be used for SNMP reporting. Please refer to your
SNMP management software for more details. 

Note: To properly use the installed mib file you need to rename
the psi_def.mib to psi.mib.

Note:  Features described on this page require the Enhanced Package.

1.1.18  Admin Reporting

T o p ics
Admin Reporting Overview
Report File Content
Report File Name
Report File Path
Admin Report Cycle Options
Advanced Settings

Ad min Re p o rting

The options listed on this page can be accessed from the Admin Reporting window. This
screen allows you to create a unique report for administration purposes. Admin Reports
generated during sync operations can be saved to a specific administrative folder (in a
local or network path). Admin Reports are made uniquely identifiable through a choice of
naming conventions, (i.e. Computer Name or User Name with date\time stamps). 

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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Cre a te  a d minis tra tive
re p o rt fi le s

This feature enables or disables the Administrative Reporting
feature.

Note:  Admin reporting files do not display Unicode characters.

Re p o rt File  Co nte nt

The options listed on this page can be accessed from the Admin Reporting window. 

Summa ry/Me ssa g e s
o nly

Appends a summary of activity to the end of the report. This op-
tion will also log messages.

Sta nd a rd  re p o rt fi le
co nte nt

This feature directs Report content to follow those conventions
also utilized in PeerSync Log Files. 

Me ssa g e s o nly Only reports messages and application errors. 

Note:  When in enhanced Real-Time or when using Multiple Job Threads standard reporting will be used if summary
is selected. 

Re p o rt File  Na me

The options listed on this page can be accessed from the Admin Reporting window. 

Re p o rt fi le  na me Allows you to choose between a "Local Computer" or
"Logged-On User" Administrative Report. The reports will bear
the selected name as a prefix, followed by the created date
and time of the Report (i.e.  COMPUTER-
111507172625011_00001.RPT). 

Re p o rt File  Pa th

The options listed on this page can be accessed from the Admin Reporting window. 

Re p o rt fi le  p a th This field displays the location of Admin Report files. This field
also supports File/Folder Path Variables and when used the
current path will be displayed above the field.

Ad min Re p o rt Cyc le  Op tio ns

The options listed on this page can be accessed from the Admin Reporting window. 

Cre a te  a  re p o rt fo r
e ve ry  e ve nt

This option allows for a report to be generated on every event
(Add/Update/Delete/Message).

Cre a te  a  re p o rt o n a n
inte rva l

This option allows for a report to be generated at a specific in-
terval. You may specify the interval from the input field to the
right of this option.

Cre a te  a  re p o rt o nce
a  d a y

This option allows for a report to be generated once a day.
You may specify the time of the day from the input field to the
right of this option.
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Cre a te  a  re p o rt o nce
a  we e k

This option allows for a report to be generated once a week.
You may specify the day of the week from the drop down list to
the right of this option.

Only  use  Ad va nce d
Se tting s

This option allows for a report to be generated based on the
configuration of the Advanced Settings only. 

Ad va nce d  Se tting s

The options listed on this page can be accessed on the "Advanced Settings" button from
the Admin Reporting window. 

At the  s ta rt o f this  Pro -
fi le

This option allows for a report to be created at the start of the
Profile.

At the  s to p  o f this  Pro -
fi le

This option allows for a report to be created at the stop of the
Profile.

Fo r e a ch ind iv id ua l
e rro r me ssa g e  a s  it
o ccurs

This option allows for a report to be created for each error.

Afte r e a ch sca n (lo g
a ll no n-sca n e ve nts
o n the  cyc le  sp e -
c ifie d )

This option allows for a report to be created once a day. You
may specify the time of the day from the input field to the right of
this option.

Afte r e a ch sca n/cyc le
e ve n if no  e ve nts  o c-
curre d

This option allows for a report to be created after each scan
even when no events occurred.

1.1.19  Email Reporting

T o p ics
Email Reporting Overview
Report File Content
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Report File Name
Email Configuration
Email Report Cycle Options

Ema il Re p o rting

The options listed on this page can be accessed from the Email Reporting window. This
screen allows you to create a unique report for administration purposes. Email Reports
generated during sync operations can be sent to an administrator, shared mailbox or a
specified user. Email notification of synchronization activity can be sent upon completion of
entire Profile or during persistent synchronization operations. Email Reports are made
uniquely identifiable through a choice of naming conventions, (i.e. Computer Name or User
Name with date\time stamps). 

Cre a te  a d minis tra tive
Ema il me ssa g e s

This feature enables or disables the Email Reporting feature.

Note:  Email reporting messages do not display Unicode characters.

Re p o rt File  Co nte nt

The options listed on this page can be accessed from the Email Reporting window.

Summa ry/Me ssa g e s
o nly

Appends a summary of activity to the end of the report. This op-
tion will also log messages.

Sta nd a rd  re p o rt fi le
co nte nt

This feature directs Report content to follow those conventions
also utilized in PeerSync Log Files. 

Me ssa g e s o nly Only reports messages and application errors.

Note:  When in enhanced Real-Time or when using Multiple Job Threads standard reporting will be used if summary
is selected. 

Re p o rt File  Na me

The options listed on this page can be accessed from the Email Reporting window.

Re p o rt fi le
na me

Allows you to choose between a "Local Computer" or "Logged-On User"
Administrative Report. The emails will bear the selected name as part of
the Subject filed. For example: "PeerSync Summary Report for
COMPUTER (PeerSync Started)". 

Ema il Co nfig ura tio n

The options listed on this page can be accessed by clicking on the "Email Configuration"
button from the Email Reporting window.

Attach log
files

Allows you to attach the reporting section log file to emails generated by
this application.
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Delete after
successful
send

Deletes the log file after a successful email attached send.

Email Config-
uration Button

This button opens the Ema il Co nfig ura tio n dialog box:  Once this box
has opened, it allows you to select the SMTP Host, User ID, Port, who to
send to, and who to send Carbon Copies to and what email address to
send from.

SMT P Ho st
The host name or IP address of the SMTP mail server to send alert emails
to.

Use r ID
The username to authenticate with the SMTP mail server. This is normally
not needed. (Optional)

Po rt 
TCP/IP connection port. It is recommended that you leave the default set-
ting unless your email server requires otherwise.

T o
The email address of the person who is to receive the email.  This user
sometimes needs to be a valid user on the SMTP mail server. You may
add multiple email addresses in this field. Use a semicolon (;) as a delim-
iter. 

CC
The email address of the person who is to receive a Carbon Copy of the
email. You may add multiple email addresses in this field. Use a semi-
colon (;) as a delimiter. 

Fro m 
The email address that will appear in the From field of the email. This email
does not need to be a valid email. For example it can be used to identify
the Job that generated the email by using the %JobName% variable (i.e.
%JobName%@MyCompany.com).

Se nd  T e st Ema il
Clicking on the Test Connection button will send a test email to the con-
figured email address(es) and let you know if PeerSync was able to suc-
cessfully connect and send an email via the configured SMTP mail server.
It is highly recommended that you test the configuration before saving the
options.

Ema il Re p o rt Cyc le  Op tio ns

The options listed on this page can be accessed from the Email Reporting window.

Cre a te  a  re -
p o rt fo r
e ve ry  e ve nt

This option allows for an Email to be sent on every event (Add/Update/De-
lete/Message)
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Cre a te  a  re -
p o rt o n a n
inte rva l

This option allows for an Email to be sent at a specific interval. You may
specify the interval from the input field to the right of this option.

Cre a te  a  re -
p o rt o nce  a
d a y

This option allows for an Email to be sent once a day. You may specify the
time of the day from the input field to the right of this option.

Cre a te  a  re -
p o rt o nce  a
we e k

This option allows for an Email to be sent once a week. You may specify
the day of the week from the drop down list to the right of this option.

Only  use
Ad va nce d
Se tting s

This option allows for an Email to be sent based on the configuration of the
Advanced Settings only. 

Se nd  Ema il Re p o rts

The options listed on this page can be accessed by clicking on the "Advanced Settings"
button on the Email Reporting window.

At the  s ta rt
o f this  Pro -
fi le

This option allows for an Email to be sent on every event (Add/Update/De-
lete/Message).

At the  s to p
o f this  Pro -
fi le

This option allows for an Email to be sent at a specific interval. You may
specify the interval from the input field to the right of this option.

Fo r e a ch in-
d iv id ua l e r-
ro r me s-
sa g e  a s  it
o ccurs

This option allows for an Email to be sent at a specific interval. You may
specify the interval from the input field to the right of this option.

Afte r e a ch
sca n (se nd
a ll no n-
sca n e ve nts
o n the  cyc le
sp e c ifie d )

This option allows for an Email to be sent once a day. You may specify the
time of the day from the input field to the right of this option.

Afte r e a ch
sca n/cyc le
e ve n if no
e ve nts  o c-
curre d

This option allows for an Email to be sent after each scan even when no
events occurred.

Ema il Re p o rt Co nte nt

The options listed on this page can be accessed by clicking on the "Advanced Settings"
button on the Email Reporting window.
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Se nd  co n-
te nt in the
b o d y o f the
Ema il

This option will write the content for the email report into the body of the
email.

Se nd  co n-
te nt a s  a n
a tta chme nt
to  the  Ema il

This option will generate a file with the content of the email report and attach
the file to the email.

Pla ce  co n-
te nt in a  fi le
a nd  se nd  a
link  in the
Ema il

This option will generate a file with the content of the email report and a link
to the file will be sent within the body of the email.

1.1.20  Pre/Post Process

T o p ics
Pre/Post Process Overview

Pre /Po st Pro ce ss

The options listed on this page can be accessed from the Pre/Post Process window. This
screen allows the user to choose external applications / scripts to be run before and after
the processing of a given Job. 

Be fo re Use this field to specify (by file path) which application or script you would
like to run before processing a Profile. File paths can be manually entered,
or the open folder icon can be used to locate files.  You may also use pre
defined configuration commands. See our support page for a list of avail-
able options.

Afte r Use this field to specify (by file path) which application or script you would
like to run after processing a Profile. File paths can be manually entered, or
the open folder icon can be used to locate files. You may also use pre

http://www.peersoftware.com/support/knowledgebase.html
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defined configuration commands. See our support page for a list of avail-
able options.

Wa it fo r a p -
p lica tio n to
e nd  b e fo re
co ntinuing

Check this feature if you want PeerSync to wait for the applications spe-
cified in the "Before" and "After" fields to close before processing addi-
tional tasks. 

Use  ma x-
imum wa it
time  o f x
se co nd s

Selecting this feature sets a limit (in seconds) for how long PeerSync will
wait for the applications specified in the "Run Before" and "Run After" fields
to close. In order to activate this function, the "Wait for Application to Ter-
minate" function must be checked. The default, when this feature is not
checked, is to wait indefinitely.

1.2  Advanced Options

Ad va nce d  Op tio ns
Migrate Shares
NetApp Settings
Global Migrate Shares Options
Global Advanced File Xfer Options 

1.2.1  Migrate Shares

Mig ra te  Sha re s

The following settings can be accessed from the Advanced Options window. 

Ad d  Sha re s: Do  No t
Up d a te  o r De le te

Copy shares from the source folder to the relative target folder,
where non-matching shares within the target folder are left on
the target. 

Ma tch Sha re s: Ad d ,
Up d a te  a nd  De le te

Copy shares from the source folder to the relative target folder,
where non-matching shares within the target folder are re-
moved. 

http://www.peersoftware.com/support/knowledgebase.html
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Re p la ce  Sha re s: Ad d
a nd  Ove rwrite

Copy shares from the source folder to the relative target folder,
where existing matching shares on the target system are over-
written.

Ad d  Sha re s  with the
se le c te d  Pre fix

Copy shares from the source folder to the relative target folder,
with the selected prefix.

Ad d  Sha re s  with the
se le c te d  Suffix

Copy shares from the source folder to the relative target folder,
with the selected prefix.

1.2.2  NetApp Settings

Ne tAp p  Se tting s

The following settings can be accessed from the Advanced Options window. 

So urce  Co nfig ura tio n Provide the Username and Password log on settings for the
Source cDOT system. Optionally, the Management IP ad-
dress can also be provided. Click the Get Info button to validate
the source system information. These settings are necessary if
trying to Migrate Shares from a cDOT source system. 

T a rg e t Co nfig ura tio n Provide the Username and Password log on settings for the
Target cDOT system. Optionally, the Management IP ad-
dress can also be provided. Click the Get Info button to validate
the target system information. These settings are necessary if
trying to Migrate Shares to a cDOT target system. 

1.2.3  Global Migrate Shares Options

Glo b a l Mig ra te  Sha re s  Op tio ns  (Fo r All Jo b s with Mig ra te  Sha re s  Ena b le d )

The following settings can be accessed from the Advanced Options window. 

Pro ce ss Mig ra te
Sha re s  a fte r e a ch
sca n

If the Migrate Shares option is checked, this setting will pro-
cess the selected share migration setting after each scan.

Pro ce ss Mig ra te
Sha re s  e ve ry  x
minute (s)

If the Migrate Shares option is checked, this setting will pro-
cess the selected share migration setting every x minutes. 

1.2.4  Global Advanced File Xfer Options

Glo b a l Ad va nce d  File  Xfe r Op tio ns  (Fo r All Jo b s)

The following settings can be accessed from the Advanced Options window. 

Ad min Ba ckup Provides the ability to replicate files and folders that are denied
access because of their current ACL settings.

Ad va nce d  Ba ckup Select this option to replicate files such as Symantec Enter-
prise Vault stub files or files/folders which may be Reparse
Points, Sparse, Offline, Stub Files, etc.
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Alte rna te  Da ta  Stre a m
(ADS) Ba ckup

Replicate hidden Alternate Data Streams (ADS) which may be
stored behind a filename. 

1.3  PeerSync Global Settings

Pe e rSync Glo b a l Se tting s
Global Recovery/Offline Options
Global Performance Options
Global ACL Options
Global Bi-directional Options
Global Managed Files Options
Current Command Line Argument Selection
Options/Commands

1.3.1  Global Recovery/Offline Options

Re try  Op e n a nd  Ina cce ss ib le  File s

The following settings can be accessed from the Global Settings window. Alternatively you
can access them from the Options > "Global Settings" > "Global Recovery/Offline Options"
menu. 

Re try  o p e n/ ina cce ss-
ib le  fi le s  e ve ry  x
se co nd (s)

Use this feature to specify, in seconds, how often PeerSync will
attempt to synchronize Source Files that are in use. If the "In-
clude open files" option on the File Options screen has not
been checked and "Retry" is selected, PeerSync will continue
attempting to synchronize files that are opened by other applic-
ations. "Retry" will also work when "Include open files" has
been checked and a file is read-locked by another application.
When the "Retry" option is on, PeerSync will synchronize the
open file within x seconds after the file has been closed.

Se t ma ximum numb e r
o f re trie s  to  x

This feature sets a limit indicating how many times to attempt to
process open files. If the maximum number of retries gets ex-
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ceeded for a particular file PeerSync will remove it from the
retry-list until another real-time event occurs on the file or a scan
detects that the file needs to be added/updated. Setting the
retry cycle to 0 will check the file indefinitely.  

Fa ile d  Eve nt Re p ro ce ss Op tio ns

The following settings can be accessed from the Global Settings window. Alternatively you
can access them from the Options > "Global Settings" > "Global Recovery/Offline Options"
menu. 

Re p ro ce ss Fa ile d
Eve nts  e ve ry  x
minute (s)

Use this feature to specify, in minutes, how often PeerSync will
reprocess failed events.

Re p ro ce ss Fa ile d
Eve nts  o nce  a  d a y a t

Use this feature to specify the time each day for PeerSync to
reprocess failed events.

Re p o rt Le ve l Specify the Failed Event Reprocess Report level:
0 - Report a message to all log files 
1 - If Failed Events are reprocessed
2 - Always: Even if no Failed Events needed to be repro-
cessed

Pre  Fa ile d  Co nd itio n Op tio ns

The following settings can be accessed from the Global Settings window. Alternatively you
can access them from the Options > "Global Settings" > "Global Recovery/Offline Options"
menu. 

Wa it b e fo re  fa il ing
co nne ctio n fo r x
se co nd (s)

Use this feature to specify, in seconds, how long PeerSync will
wait before failing connections. 

Numb e r o f time s to
wa it a nd  che ck

This feature sets a limit indicating how many times to wait and
check for failing connections. 

Fa ile d  Co nne ctio n Op tio ns

The following settings can be accessed from the Global Settings window. Alternatively you
can access them from the Options > "Global Settings" > "Global Recovery/Offline Options"
menu. 

Re try  fa ile d  co nne c-
tio ns  e ve ry  x
minute (s)

PeerSync monitors persistent Jobs (Real-Time, scheduled, in-
terval) for connectivity, and suspends the Job until a connection
is resumed. This allows PeerSync to ensure that synchroniza-
tions are only attempted when a connection exists. This feature
is set by default to a 1 minute interval and can be modified or
disabled. 
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Alwa ys run a  sca n o n
re co nne ct

This feature will initiate a full scan on every reconnect to pro-
cess any file/folder changes which may have occurred during
the connection failure. May be useful for Laptop bi-directional
scenarios and/or to pull missed data from the target system on
reconnect.

Run a  sca n o n re co n-
ne ct (if ne e d e d )

This feature will initiate a full scan at reconnect to process any
file/folder changes which may have occurred during the con-
nection failure. A scan will be performed only if a failure occurs
in the middle of scan or if a scan was missed when the connec-
tion was lost. 

Sto re  misse d  e ve nts
a nd  p ro ce ss o n re -
co nne ct

This feature pertains to any Job running in a Real-Time mode.
Having this option enabled will store Real-Time events during
failed connections and will process these events at Reconnect,
eliminating the Source/Target Folder scan. This associates
with the /YW command line argument. 

Note: This action will run a scan on reconnect (if needed), if a
failure occurs in the middle of scan or a scan was missed when
the connection was lost.

Note: These settings are Global. Global Settings are global to the current Profile. These settings and options pertain
to all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen. 

1.3.2  Global Performance Options

Glo b a l Pe rfo rma nce  Op tio ns

The options listed on this page can be accessed by clicking on the "Global Performance
Options" link on the PeerSync Global Settings window as well as the Options/Commands
window and the Options menu. Please visit Global Performance Options for more informa-
tion on this topic.

Ap p lica tio n Prio rity
Se le c tio n

Move the slider to adjust the Application Priority allowing Peer-
Sync to run at a higher or lower priority then other applications. 

Exc lud e  Co mmo n Jo b
Exce p tio ns  in Eve nt
Pro ce ss ing

This option checks the global exclusions list before file hits
such as before event processing and before adding the event
to the visual list.The command line argument for this option
is /QR. 

Pe rfo rma nce  Op tio ns

The options listed on this page can be accessed by clicking on the "Global Performance
Options" link on the PeerSync Global Settings window as well as the Options/Commands
window and the Options menu. Please visit Global Performance Options for more informa-
tion on this topic.
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Use  Enha nce d  Eve nt
Pro ce ss ing

This option provides the ability to parallel process real-time,
retry or any other non-scan events. Enabling this feature will im-
prove the speed of synchronization during real-time or any
other non-scanning scenarios. 

Exc lud e  Co mmo n Jo b
Exce p tio ns  in Eve nt
Pro ce ss ing

This option checks the global exclusions list before file hits
such as before event processing and before adding the event
to the visual list.The command line argument for this option
is /QR. 

Notes: 

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen. 

2. Some features described on this page require the Multi Threading Option. Please visit http:/ / www.peersoft-
ware.com or contact Sales for additional information.

3. Using Multiple Job Threads will produce a different file output format for all modes of reporting and message log-
ging (Reporting, Admin Reporting and Email Reporting). The output will NOT contain a start and stop section or
a summary, each entry will also be initially marked with a date and time stamp. If use summary is selected for Ad-
min or Email reporting then the standard selection will be used. The reason this is done is due to the fact that
processes will be running in parallel.

4. We have exhaustively tested PeerSync operations using 50 Job threads and 10 Copy threads. Setting your
threads over this limit may lead to potential operational issues.  We strongly discourage the use of more then 50
threads, however, you do have the option to exceed this limit by placing a greater than symbol ">" before your
desired thread value (maximum allowed is 200).  We  recommend you test your setting to ensure PeerSync con-
tinues to operate acceptably in your environment. 

5. The Include open files (if possible) option should be used if you are using the Performance Options: Multiple Job
Threads and Multiple Copy Threads. 

6. When setting the Application Priority to High, PeerSync will use more then average CPU, you may want to use
the Set Processor Affinity argument in this scenario.

1.3.3  Global Permission Options

Glo b a l Pe rmiss io ns  Op tio ns

This screen is activated by clicking on the Glo b a l Se tting s  link located to the right of the
NT FS Op tio ns  ... button in the Permissions window as well as from the PeerSync Global
Settings window or the Options menu. This window has the following features:

Mo nito r File  Pe rmis-
s io n cha ng e s d uring
re a l-time

This global feature will enable real-time monitoring to detect
and process file permission changes. 

Mo nito r Fo ld e r Pe r-
miss io n cha ng e s d ur-
ing  re a l-time

This global feature will enable real-time monitoring to detect
and process folder permission changes. 

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
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Che ck fo r Pe rmiss io n
cha ng e s d uring  sca ns

This global feature will validate and apply file and folder per-
mission during scans.

Notes:

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen.  

2. The Monitor Folder Permission c hanges during real-t ime option turns on/ off the / LG1 command line
argument. 

3. If you enable or disable Inheritance at the folder level, these changes will only get replicated during a scan.  

1.3.4  Global Bi-directional Options

Glo b a l Bi-d ire c tio na l Op tio ns

This screen is activated by clicking on the Glo b a l Se tting s  link located to the right of the
Bi-d ire c tio na l option in the File Options window as well as from the PeerSync Global Set-
tings window or the Options menu. This window has the following features:

Alwa ys cre a te  a  su-
p e r-se t d uring  b i-d ir-
e c tio na l synchro niza -
tio n

This feature will alter the way the Enable bi-directional syn-
chronization mode option functions by always creating a super-
set of the data on the source and target. In this mode folders
and files will always be added and not deleted. 

Use  e nha nce d  b i-d ir-
e c tio na l synchro niza -
tio n mo d e  o p tio ns

This feature will alter the way the Enable bi-directional syn-
chronization mode option functions by using enhanced features
to track all file and folder adds, updates, deletions, renames
and moves between scan cycles. In this mode, PeerSync will
use a hidden system trigger file within each sub-folder to store
information about the last scan cycle for that sub-folder. Using
this trigger file, PeerSync can determine if a Folder was added,
deleted, renamed or moved since the last scan.

Note: This feature is not supported when using the Enhanced Scan-
ning option.

Notes:

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen. 

2. Please refer to our White Papers page for step-by-step tutorials to achieve real-time or scheduled bi-directional
synchronization. 

3. When the "Always create a super-set during bi-directional synchronization" option is NOT selected (i.e. doing
standard or enhanced bi-directional synchronization) we recommend you add / YO- and / QYD:0 to your list of
command line arguments. These options will ensure that during standard or enhanced bi-directional synchroniza-
tion, deleted files from one side are not re-added by the other side. These arguments should NOT be used if
there are more than two machines involved in a bi-directional synchronization.  

http://www.peersoftware.com/support/knowledgebase.html


PeerSync Help111

Copyright © 1993-2019 Peer Software Inc. All Rights Reserved

1.3.5  Global Managed Files Options

File  Ma na g e r Inte rva l

By clicking on the Global Settings link from the Managed Files window you will be able to
configure the File  Ma na g e r Inte rva l option. Alternatively you can access this screen
from theGlobal Settings window or from the Options menu. 

PeerSync uses the Volume Shadow Copy Service (VSS) in order to allow synchronization
of open/locked files. In order to enable this feature you will require the Managed Files add-
on module. Developed by Microsoft, VSS is a storage management framework designed
to create a point-in-time copy/snapshot of a volume. This method works well with applica-
tions that are VSS compliant. VSS does not support Novell NetWare systems.

Run Ma na g e d  File s
Lis t Ma na g e r e ve ry  x
minute s

By default the Managed Files is set to run on an interval of 120
minutes. This interval may be changed by simply changing the
interval time. By default, Managed Files will run at the end of the
initial scan if Scan Job once at start is enabled. Subsequent
open and locked files detected in real-time or during scans will
be thrown into the Managed Files list to be processed based
on the Managed Files interval.

Notes: 

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen. 

2. These options require the VSS add-on module. Please visit http:/ / www.peersoftware.com or contact Sales for addi-
tional information.

3. The minimum Managed Files interval is 30 minutes.

4. This feature only works for local Source folders.

1.3.6  Current Command Line Arguments

Glo b a l Co mma nd  Line  Arg ume nts  Lis t

From the Options/Commands window, double-clicking on the "Command Line Arguments"
filed or selecting the button to the right of it will open the Command Line Arguments dialog.
The Command Line Arguments dialog can also be accessed from the PeerSync Global
Settings window as well as from the Options/Commands window or the Options menu. 

Co mma nd  Line  Arg u-
me nts

In this dialog you can modify, add or delete arguments to be
used when launching PeerSync through any of the modes de-
scribed in the Startup/Service screen or via the Run/View Cur-
rent Profile Activity screen. This dialog displays the current ar-
guments selected for the Profiler and will also allow for the se-
lection and modification of additional Command Line Argu-
ments by double-clicking this field or selecting the Current Ar-
guments Button to the right of the field.

http://www.peersoftware.com/products/recommended_options/vss.aspx
http://www.peersoftware.com/products/recommended_options/vss.aspx
http://www.peersoftware.com/products/recommended_options/vss.aspx
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
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Note: These settings are Global. Global Settings are global to the current Profile. These settings and options pertain
to all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen. 

1.3.7  Global Display Options

Pro file r Op tio ns  

Options located on this screen can be accessed from the  Options/Commands > D isp la y
Op tio ns  window and the Options > Glo b a l Se tting s  > D isp la y  Op tio ns  menu.

Ena b le
Ba s ic  D is-
p la y

This feature will have PeerSync open the Profiler, if it is not already open,
and send status messages to be displayed on the Run/View PeerSync
screen. 

Ena b le  Ad -
va nce d  D is-
p la y

This option activates the Sho w Ad va nce d  D isp la y  link at the bottom
right corner of the  Run/View PeerSync screen. When this link is clicked, the
Pe e rSync Ad va nce d  D isp la y  panel will be shown. The advanced dis-
play contains a Jo b s Sta ts  panel on the top and an Ad va nce d
Run/Vie w Pe e rSync  panel at the bottom. The command line argument
to disable this option is /QQ<<.

Pe e rSync Op tio ns  (Ap p lica tio n Runs Only)

Options located on this screen can be accessed from the  Options/Commands > D isp la y
Op tio ns  window and the Options > Glo b a l Se tting s  > D isp la y  Op tio ns  menu.

D isp la y
s ta tus  in
Pe e rSync

This feature will show the Pe e rSync Sta tus  D isp la y  dialog box during
synchronization to view activity, status and other information while Peer-
Sync is running. 

D isp la y
s ta tus  in
Pe e rSync
up o n co m-
p le tio n

This feature will have PeerSync pop-up the Pe e rSync Sta tus  D isp la y
dialog at the end of synchronization (only in non-persistent modes) to view
activity, status and other information upon completion. 

 Pro file r/Pe e rSync Op tio ns

Options located on this screen can be accessed from the  Options/Commands > D isp la y
Op tio ns  window and the Options > Glo b a l Se tting s  > D isp la y  Op tio ns  menu.

Jo b  Sta ts This feature allows for the Jo b s Sta ts  panel in the Pe e rSync Ad va nce d
Disp la y  to get updated. Use /QP to disable this option via the command
line.

Jo b  Sca ns When enabled, this option adds a Jo b  Sca ns tab to the Ad va nce d
Run/Vie w Pe e rSync panel. This table lists Base/Root, Enhanced/Ex-
panded, and RT/Sub-folder scans with statistics and progress for all the
Jobs or only the selected Job. The command line argument for this option
is /Q8BJ+.
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File  Co p y
Pro g re ss

This feature will show the progress of a file transfer in the PeerSync Sta tus
Disp la y  or the Ad va nce d  Run/Vie w Pe e rSync panel. This feature re-
quires the Multi-Threading Option. The command line argument for this op-
tion is /QQ.

H is to rica l
Da ta  

When enabled, this option adds a H is to rica l Da ta  tab to the Ad va nce d
Run/Vie w Pe e rSync panel. This tab contains a subset of data from the
PeerSync Jo b s Sta ts  panel (Xfer Rate, Bytes and Event Averages) and
is broken down into total, hourly, daily, and weekly statistics for all the Jobs
or only the selected Job. The command line argument for this option
is /Q8BH+.

Pe e r Ad minis tra to r Op tio ns

Options located on this screen can be accessed from the  Options/Commands > D isp la y
Op tio ns  window and the Options > Glo b a l Se tting s  > D isp la y  Op tio ns  menu.

Se nd  s ta tus
info rma tio n
to  Pe e r Ad -
minis tra to r

This will send statistical information about the current Profile to the Peer Ad-
ministrator if it is installed/available. This utility allows for the ability to mon-
itor PeerSync activity across the LAN for the centralized viewing of all Peer-
Sync activity on the network.

Re la te d  Op tio ns
Performance Options
Command Line Arguments

Notes:  

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen. 

2. Some features described on this page require the Multi Threading Option. Please visit http:/ / www.peersoft-
ware.com or contact Sales for additional information.

1.3.8  Global Reporting Options

Me ssa g e s By Pro file

Options located on this screen can be accessed from the  Options/Commands > Re p o rt-
ing  Op tio ns  button and the Options > Glo b a l Se tting s  > Re p o rting  Op tio ns... menu.

Cre a te  a
me ssa g e
lo g  fi le  fo r
this  Pro file

Use Profile message log file.

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
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Me ssa g e s By Jo b s

Options located on this screen can be accessed from the  Options/Commands > Re p o rt-
ing  Op tio ns  button and the Options > Glo b a l Se tting s  > Re p o rting  Op tio ns... menu.

Cre a te  a
me ssa g e
lo g  fi le  fo r
e a ch Jo b

Use Job message log file.

Glo b a l Ad min/Ema il Re p o rting  Op tio ns

Options located on this screen can be accessed from the  Options/Commands > Re p o rt-
ing  Op tio ns  button and the Options > Glo b a l Se tting s  > Re p o rting  Op tio ns... menu.

Se nd  me s-
sa g e s fo r
fa ilure s
o nly

When sending messages for admin/email reports filter on failures only (F
switch in the /Q8E argument - i.e. /Q8EF).

Ap p e nd
Glo b a l
Sta ts  In-
fo rma tio n

Append Global Stats to admin/email reports (G switch in the /Q8E argu-
ment - i.e. /Q8EG).

Ap p e nd
Jo b  Sta ts
Info rma tio n

Append or attach Job Stats information to admin/email reports (S+ switch in
the /Q8E argument - i.e. /Q8ES+). Note: To attach a csv file instead use a
V+ switch in /Q8E argument - i.e. /Q8ES+V+

Ap p e nd
His to rica l
Da ta  In-
fo rma tio n

Append or attach Historical Data information to admin/email reports (H+
switch in the /Q8E argument - i.e. /Q8EH+). Note: To attach a csv file in-
stead use a V+ switch in /Q8E argument - i.e. /Q8EH+V+.
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1.3.9  Options/Commands

T o p ics

Display/Reporting Options
Performance Options
Command Line Arguments

D isp la y /Re p o rting  Op tio ns  - All Jo b s

Options located on this screen can be accessed from the  Options/Commands window.

Sho w tra y
ico n

If enabled, PeerSync will display an icon in the system tray for PeerSync.

Ena b le  d is -
p la y  o p -
tio ns

If enabled, the following Command Line arguments will be set: /Pro-
gress, /GO, /GL, /TD, /QP, and /QQ.

Ena b le  re -
p o rting  o p -
tio ns

If enabled, one of the following Command Line arguments will be set: /YLP
or /YLF

Se t Acce ss
Pa sswo rd ...

Sets a password for access to the Profiler. Once set, the password must be
entered in order to make changes to the Profiler, 

D isp la y  Op -
tio ns...

See Global Display Options for details.

Re p o rting
Op tio ns...
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Pe rfo rma nce  Op tio ns  - All Jo b s

Options located on this screen can be accessed from the  Options/Commands window.

Ena b le
Fa stSync

Enable FastSync for improvement in scan performance (/GFX>Y>... Com-
mand Line Argument)

Use  Mul-
tip le  Jo b
T hre a d s -
Se t ma x-
imum num-
b e r o f
thre a d s to

Enable this option to allow multiple Job threads to be used for parallel pro-
cessing of Jobs. Without this feature each Job will run sequentially in the or-
der it is listed, scheduled to run, or in the order that events are received.

Use  Mul-
tip le  Co p y
T hre a d s -
Se t ma x-
imum num-
b e r o f
thre a d s to

Enable this option to allow multiple Copy Threads to copy multiple files in
parallel processes (i.e. Simultaneous Distribution - Synchronizing from one
server to multiple servers simultaneously in a Web Farm type environ-
ment).

Se t Ap p lic -
a tio n Prio r-
ity

Adjust the Application Priority allowing PeerSync to run at a higher or lower
priority then other applications. 

Re la te d  Op tio ns
Performance Options
Command Line Arguments

Notes:  

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen. 

2. Some features described on this page require the Multi Threading Option. Please visit http:/ / www.peersoft-
ware.com or contact Sales for additional information.

Fa stSync Le ve l o f Ag g re ss ive ne ss

Options located on this screen can be accessed from the  Options/Commands > Ena b le
Fa stSync option.

Ag g re ss-
ive ne ss
Slid e r

Select the level of aggressiveness to be used by FastSync sessions. The
slider controls background threads, folder depth level, and maximum RAM
allowance. 

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
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Re ta in
Fa stSync
d a ta  fi le s
(fo r
tro ub le sho o
ting )

When enabled, this will leave behind FastSync data files (configuration and
reporting) for each FastSync session in the INSTALLPATH\FastSync\Runs
folder to be used for analysis, extended reporting and/or troubleshooting.

Ena b le  d e -
ta ile d  re -
p o rting /d is -
p la y  (will
imp a ct p e r-
fo rma nce )

When enabled, you will see normal reporting and display at the expense of
performance. 

Note: When disabled, there will be no tracking, reporting, or display of individual add/ update
events during scans as seen when not using FastSync. 

2.  PeerLock

2.1  PeerLock Job Settings

T o p ics
PeerLock Job Settings Overview

2.1.1  PeerLock Job Settings Overview

Pe e rLo ck Jo b  Se tting s

If you are running PeerLock v2.0.1 or newer on the same machine as PeerSync you will now
be able to configure PeerLock directly from the PeerSync Profiler.  The following options al-
low you to link the selected Job to PeerLock as well as append the PeerSync exceptions
to PeerLock. The options in this window can be accessed from the PeerLock > PeerLock
Job Settings window.

Inc lud e  this  Jo b  in
Pe e rLo ck

Select this checkbox to automatically add the selected Job to
PeerLock. This option can be enabled automatically when se-

http://www.peersoftware.com/solutions/file-locking-for-ms-dfsr.html
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lecting the Bi-directional setting. In general PeerLock is used in
a collaboration environment where PeerSync is configured for
real-time bi-directional synchronization. 

Ap p e nd  De fa ult
File /Fo ld e r Exc lu-
s io ns  fro m Pe e rLo ck

This option is enabled by default. When checked, the Peer-
Sync Exception settings (Include Files, Exclude Files, and Ex-
clude Folders) will be appended to the default/existing list of
Exceptions in PeerLock. 

Note: PeerLock supports the usage of Windows System and Registry variables in the Source and Target fields (i.e.
%UserName%, %ComputerName%). Custom PeerSync variables such as %JobName% are currently not supported
and will not work in PeerLock. 

2.2  PeerLock Global Settings

T o p ics
PeerLock Global Settings Overview

2.2.1  PeerLock Global Settings Overview

Pe e rLo ck Glo b a l Se tting s

If you are running PeerLock v2.0.1 or newer on the same machine as PeerSync you will now
be able to configure PeerLock directly from the PeerSync Profiler.  The following options al-
low you to add the selected PeerSync Jobs to PeerLock and launch the PeerLock applica-
tion or Global Options for configuration. The options in this window can be accessed from
the PeerLock > PeerLock Global Settings window.

Link  this  Pro file r to
Pe e rLo ck

If this global setting is enabled, all the Jobs that have the "In-
clude this Job in PeerLock" option selected will be added to
PeerLock. These Jobs in PeerLock  will be managed by Peer-
Sync and cannot be edited/removed directly from the Peer-
Lock interface.  Un-checking this option will remove all Peer-
Sync managed Jobs from the PeerLock interface. 

http://www.peersoftware.com/solutions/file-locking-for-ms-dfsr.html
http://www.peersoftware.com/solutions/file-locking-for-ms-dfsr.html
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Disa b le  Jo b s tha t a re
No t Co nfig ure d  fro m
this  Pro file r

Selecting this option then saving the PeerSync Profiler or click-
ing on the "Save Changes in PeerLock" link will remove/delete
any existing Jobs from the PeerLock configuration. Only Jobs
that are managed by PeerSync will be maintained.

Sa ve  Cha ng e s in
Pe e rLo ck

Click on this link to commit your PeerSync Job/Profile updates
to PeerLock. This link becomes available when you make Job
or Profile changes that need to be saved and applied to Peer-
Lock (i.e. Source/Target path update, Exceptions, ...). This can
be achieved also by clicking on the Save button from the Tool-
bar or File Menu. If there are no Profile updates to be saved,
this link will be unavailable. 

Glo b a l Op tio ns Selecting this link will open the PeerLock Global Options dia-
log that contains the configuration settings for all the Jobs in
PeerLock. When the application is terminated/closed this link
will become available. 

Sho w Pe e rLo ck You can run PeerLock as an application or as a service. Click-
ing on this link will launch the PeerLock interface where you can
start PeerLock to run as an application or as a service. You
can also start/stop the PeerLock service directly from the Peer-
Lock Run/View window in the PeerSync Profiler. 

Through the PeerLock interface  you will be able to view the
files that are Locked or Released by PeerLock when it is run-
ning as an application.  This status information is not available
when PeerLock is running as a Service. The PeerLock Jobs
that are managed by PeerSync will be un-editable. When the
application is terminated/closed this link will become avail-
able. 

Note: You will need the Peer Administrator product In order to view the Peer-
Lock status while running as a service. 

Notes: 

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the current Profile.

2. PeerLock supports the usage of Windows System and Registry variables in the Source and Target fields (i.e. %
UserName%, %ComputerName%). Custom PeerSync variables such as %JobName% are currently not supported
and will not work in PeerLock. 

http://www.peersoftware.com/products/management-monitoring/peer-administrator.html
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3.  Startup/Service

3.1  PeerSync Startup/Service

T o p ics
PeerSync Startup/Service Overview

3.1.1  PeerSync Startup/Service Overview

Pe e rSync Sta rtup /Se rv ice  Op tio ns

The options in this window can be accessed from the "Startup/Service" > PeerSync Star-
tup/Service window. This screen allows the user to specify whether or not PeerSync will be
run upon startup of the active PC, while also defining its interaction with the network (if ap-
plicable). This screen provides shortcuts for installing PeerSync as a service, adding it to
the Windows StartUp list, or to the Windows registry for automatic loading upon startup. 

D isa b le  a ll Sta rtup
Op tio ns

Check this feature to prevent PeerSync from automatically
loading at Windows startup/logon.

Cre a te  Sho rtcut o n
De skto p

This button will place the current Profile into a shortcut on your
desktop (See "Scan at Start of Profile List," Options/Com-
mand). A Profile Shortcut will need to be created through this
feature in order to use PeerSync's Command Line Mode.

Ad d  to  W ind o ws
Sta rtUp

This button opens the Windows StartUp folder, showing links to
files and programs that open automatically upon user logon.
This button is only accessible when "Add to Windows Startup
Folder" is checked.

Ad d  to  W ind o ws re -
g is try

Check this feature if you want PeerSync to run automatically
when Windows boots through specification in the Windows re-
gistry.

Run Re g Ed it This button opens the Windows Registry Editor. This button is
only accessible when "Add to Windows registry to run at boot"
is checked.  

Ins ta ll a s  a n NT  Se r-
v ice

Check this feature if you want PeerSync to run automatically as
a service under Windows NT. Click here for a Tutorial on how
to install PeerSync to run as an NT Service.

http://www.peersoftware.com/support/knowledgebase/item/setup-peersync-to-run-as-a-service.html
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To configure and run the service you must go to "Services" loc-
ated in the "Control Panel" and select "PeerSync Professional
Series Software." By default the service is installed with the
"Local System account" selected for the service "Log on as:"
option. 

Caution: If any of your Source or Target Folder Selections are not located on
the local machine, then you will have to configure the service to "Log on as:"
an alternate (Domain Admin) account on your domain so that the service has
the rights to access the remote machines and/ or devices.  If you do not do this
the service may not run properly.

Notes: 
 
1. If PeerSync is running as a Service it is advised to use UNC paths or Peer-

Sync's Dynamic Network Drive Mapping and Unmapping feature instead
of using mapped drives do to the fact that mapped drives are not under-
stood when a user is not logged on.

2. You can add the argument / LSE (Log Service Events to NT Application
Log) to the following entry in the registry (HKEY_LOCAL_MACHINE\ Soft-
ware\ PeerSoftware\ PeerSync\ Service\ Parameters). This will have Peer-
Sync log all changes to be reported to application log in addition to the
normal logging of the start, stop, pause and continue of the service.

3. If PeerSync is running in Real-Time mode as a service, subsequent real-
time Profiles will interfere with service operation and should not be em-
ployed. Both Scheduled Operations and Manual (non-persistent) opera-
tions should perform without interference to a service installation of Peer-
Sync.

4. The service can run without any Jobs configured or selected.

De ta ils This button is used to view the details of the currently installed
PeerSync service. 

Re mo ve This button is used to remove the currently installed PeerSync
service.

Cre a te  SNC e xte ns io n
a sso c ia tio n fo r Pro -
fi le r

Checking this feature causes any file with the extension .SNC to
be associated with PeerSync: PeerSync Profiles bear this ex-
tension by default. Once this feature has been selected,
double/clicking on any SNC file will open Profiler and load that
particular file. 

Ad d  Quick-Sync
Fo ld e r o p tio n to  Ex-
p lo re r me nu

Checking this feature adds or removes the Quick-Sync Folder
selection from Windows Explorer. This feature is a quick and
easy way to synchronize folder(s) on the fly to backup loca-
tion(s) with the option to modify your Job settings at a later time.

Pe e rSync Ap p lica tio n
Pa th

This field is used to specify the location of the PeerSync ex-
ecutable file. You can use the open folder icon to browse
drives in order to locate this executable file.

Sta rting  Pro file s
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The following describes ways in which PeerSync can be launched or started. 

Fro m the  Pro file r By using the Launch Profile Menu Item in the Run Menu
By using the Launch Current Profile button on the Tool Buttons
Toolbar
By using the Launch Current Profile button on the Run/View Cur-
rent Profile Activity screen

Exte rna lly  witho ut the
Pro file r

Setup/run from a Shortcut on the Desktop
Setup/run from the Startup Folder
Setup/run at boot from the Registry
Setup/run as a NT Service
Setup/run using the Windows Task Scheduler

Notes:

1. Individual Jobs can be synchronized using the 'Synchronize Selected Jobs' feature, found in the Profile Job List
Popup Menu. 

2. Another way of running PeerSync is by using the Quick-Sync Folder feature by right-clicking on a folder from MS
Windows Explorer.

3.2  PeerLock Startup/Service

T o p ics
PeerLock Startup/Service Overview

3.2.1  PeerLock Startup/Service Overview

Pe e rLo ck Sta rtup /Se rv ice s  Op tio ns

If you are running PeerLock v2.0.1 or newer on the same machine as PeerSync you will now
be able to configure PeerLock directly from the PeerSync Profiler.  This window provides a
way in which you can install the PeerLock service directly from the PeerSync Profiler inter-

http://www.peersoftware.com/solutions/file-locking-for-ms-dfsr.html
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face.  The options can be accessed from the "Startup/Service" > PeerLock Startup/Service
window.

Ins ta ll Pe e rLo ck Se r-
v ice

Check this feature if you want PeerLock to run automatically as
a service under Windows NT. To configure and run the service
you must go to the Services window by clicking on the "Details"
> "Show Services" button and select "PeerLock Utility Soft-
ware" item.  By default the service is installed with the "Local
System account". If your Source or Target folder is not located
on the local machine, then you will have to configure the ser-
vice to "Log on as:" an alternate (Domain Admin) account on
your domain so that the service has the rights to access the re-
mote machines and/or devices.  Otherwise the service may not
run properly.

Note: It is advised to use UNC paths if you plan to run PeerSync or PeerLock
as a Service do to the fact that mapped drives are not understood when a user
is not logged on.

De ta ils This button is used to view the details of the currently installed
PeerLock service. 

Re mo ve This button is used to remove the currently installed PeerLock
service.

Pe e rLo ck Pa th This field is used to specify the location of the PeerSyncPeer-
Lock executable file. You can use the open folder icon to
browse drives in order to locate this executable file.

Note: 

PeerLock supports the usage of Windows System and Registry variables in the Source and Target fields (i.e. %User-
Name%, %ComputerName%). Custom PeerSync variables such as %JobName% are currently not supported and will
not work in PeerLock. 

4.  Run/View

4.1  PeerSync Run/View

T o p ics
Basic Display
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Advanced Display

4.1.1  Basic Display

Run/Vie w Pe e rSync - Ba s ic  D isp la y

PeerSync can be run as an Application or as an NT Service, if available and installed from
the Startup/Service screen.

This screen is used to launch the current Profile and to view current Profile activity. If the Dis-
play Status in Profiler option is turned on from the Options/Commands screen this screen
will be shown upon execution of a Profile and will dynamically show the status of synchron-
ization of the current Profile as the process occurs. This screen will also be shown upon us-
ing the Synchronize Selected Jobs feature, found in the Profile Job List Popup Menu to dis-
play the Current Activity of the Jobs sent to PeerSync as a temporary Profile.

Pro file Displays the name of the Profile actively being processed.
This label may not match the name of the Profile currently be-
ing configured through Profiler.

Jo b This indicator will dynamically display the name of whichever
Job is presently being processed for the Active Profile.

Mo d e This indicator will dynamically display the name of whichever
Job is presently being processed for the Active Profile.

La unch Curre nt Pro -
fi le /T e rmina te  Active
Pro file

This button allows you to launch the current Profile. Once a
Profile has been launched, its processing may also be termin-
ated through this button (the label will change to read "Termin-
ate Active Profile"). This button offers one of three ways to initi-
ate an Automatic Operation. 

Vie w Active  Pro file This button allows you to connect to and view the Active Pro-
file. 

Run a s  a  se rv ice If PeerSync is installed as a Service you have the option of
running it as an Application or as a Service from this screen.

Sta rt/Vie w Se rv ice This button allows you to start the current Profile as a Service
or view the Active Profile. It is only visible if PeerSync was in-
stalled as a service. 

Sto p  Se rv ice This button allows you to stop the current Profile as a Service. 
It is only visible if PeerSync was installed as a service. 

Pa use  Se rv ice This button allows you to pause the current Profile as a Ser-
vice. It is only visible if PeerSync was installed as a service. 

Re sume  Se rv ice This button allows you to resume the current Profile as a Ser-
vice.  It is only visible if PeerSync was installed as a service. 

Sca nne d  Fo ld e rs Displays the total number of folders that have been scanned
using a representation of X of Y, where X indicates the number
of folders that have been scanned so far and Y represents the
total number of folders that need to be scanned. When the X
and Y values match, the scan is considered as complete. The
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progress bar to the right of these values is a visual represent-
ation of the folders that have been scanned. These values are
reset on subsequent scans if applicable and do not include
excluded folders.

Sca nne d  File s Displays the total number of files that have been scanned us-
ing a representation of X of Y, where X indicates the number of
files that have been scanned so far and Y represents the total
number of files that need to be scanned. When the X and Y
values match, the scan is considered as complete. The pro-
gress bar to the right of these values is a visual representation
of the files that have been scanned. These values are reset
on subsequent scans if applicable and do not include ex-
cluded folders.

Sca nne d  Byte s Displays the total number of bytes that have been scanned
using a representation of X of Y, where X indicates the number
of bytes that have been scanned so far and Y represents the
total number of bytes that need to be scanned. When the X
and Y values match, the scan is considered as complete. The
progress bar to the right of these values is a visual represent-
ation of the bytes that have been scanned. These values are
reset on subsequent scans if applicable and do not include
excluded folders.

La rg e  File  o r Co m-
p re ss io n Sta tus

This caption will be displayed to the right of the file name that
is currently synchronized for large files and during compres-
sion. The caption will show the size of the file that has been
copied to the Target and/or compression status.

Che cke d This indicator displays the total number of files contained in
the selected Source Folders. 

Exc lud e d Indicates the number of files that were excluded from syn-
chronization (See Exceptions). 

Me ssa g e s Indicates the number of error messages generated during
Profile processing. 

Up d a te d Indicates the number of Target Files that were updated during
synchronization of Profile Jobs. 

Ad d e d Indicates the number of new files added to Target Folders dur-
ing synchronization of Profile Jobs. 

De le te d Indicates the number of files deleted (or moved) during syn-
chronization of Profile Jobs. 

Curre nt Jo b  Sta tus This indicator displays the status of the active Job. The indic-
ator may display one of the following: Blackout, Source/Tar-
get disconnected (Job name), Connecting to Target Folder
(Folder), or Normal.

Pe nd ing  Eve nt Sta tus This indicator displays the number of pending items.The indic-
ator may display one of the following: Pending Items (Events:
n) (Managed Files: x) or No Pending Items
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Curre nt Eve nt Sta tus This indicator display the status of the events pertaining to
Job/Copy thread information or Job automation (such as next
scheduled interval, daily timer info etc.). The indicator may
display one of the following: Running Items (Job Scans: x)
(Copy Threads: y) (Failed Events: z)

T o ta l T ra nsfe rre d Indicates the the total amount of bytes transferred for the entire
running Profile. 

Ela p se d  T ime Indicates the amount of time that has elapsed during the cur-
rent Profile activity.

Sho w Ad -
va nce d /No rma l D is-
p la y

Click on this link to toggle between the No rma l and Ad -
va nce d  Run/Vie w Pe e rSync  panels.

Re fre sh Click on this link to force a manual reload of the Run/View
PeerSync panel and the statistics that are being displayed.

4.1.2  Advanced Display

Jo b s Sta ts

To see this panel, click on the Show Advanced Display link at the bottom right corner of the
Run/View PeerSync window. The Enable Advanced Display option must be checked in or-
der for this link to be active. The Jobs Stats display is the top panel and contains runtime
statistics for all the Jobs configured within the Profile. Clicking on a Job will update the bot-
tom Advanced Run/View PeerSync panel. Click on the All Jobs entry to display all the
Job statistics, cumulatively, in the bottom panel.

# Represents the automatically assigned Job number for
each Job. An icon represents the state of the Job (Green,
Yellow, or Red):

Green
 

Running with no failed events

Yel-
low

Warning state indicates the Job is running with
failed events

Red Failed connection and/or offline/stopped

Jo b  Na me Lists the unique name for each Job.

So urce Displays the path to the source folder.

T a rg e t Displays the target path.

La st Sca n (Sta tus :
Dura tio n)

Displays the date and time of the last scan along
with a description of the scan state and duration.
For example: 11/17/2011 4:28:31 PM (Completed
Successfully: 00:06:05)

In Sync Displays whether each Job is in sync. In order for the In Sync
state to be set to Yes, the following criteria needs to be sat-
isfied:
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1. There should be zero Failed Events
2. The status starts should be Normal (i.e. source/target not

disconnected and/or not in a Blackout etc.)
3. The Last Scan (Status: Duration) for the Job has Completed

Successfully and does not contain messages
4. There are zero active events for the Job
5. The In Queue stats for the Job starts with [Processing: 0]

==> [Event File: DNE and contains [In Queue: 0
6. The Scan Needed column value is set to No

Examples of possible In Sync states:

· Yes
· Yes (As of Last Scan)
· Yes (Job Stopped - Manually)
· Yes (Job Stopped - Manually; As of Last Scan)
· No (Failed Events: 1)
· No (See Status for Details)
· No (Scan Running)
· No (Scan Pending)
· No (See Last Scan for Details)
· No (Last Scan has Messages)
· No (Active Events)
· No (Items In Queue)
· No (Scan Needed)
· No (Scan Running; Items In Queue)

T re nd ing Displays information regarding the trending state of the In Sync
column (Up, Down, or Flat). If the number of events within a
cycle is 500 or less, the Trending status will be Flat. If the
number of events increased by 1,000 or more within a cycle,
then the Trending status will be Up. If the number of events de-
creased by 1,000 or more within a cycle, then the Trending
status will be Down. 

Notes:
1. The column will show N/ A if you have not reached the cycle yet and/ or

there is no difference in events within the last cycle.
2. The TrendingUpValue and TrendingDnValue items are event differences

per second for Processing and In Queue event items from the In Queue
stats.

3. To adjust the default values based on desired results (i.e. you may be
stuck in the Flat state too often if you are looking for a difference in
changes), modify the TrendingDnValue and TrendingUpValue values in

the PSDEF.cfg file. 

[Misc Options]
TrendingCycle=60
TrendingUpValue=10
TrendingDnValue=10
TrendingAlwaysShowUpDnValue=0

Ne xt Sca n (Run in) Count down to the next scan for scheduled or interval scans.
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Xfe r Ra te Determines the transfer rate in megabits per second for each
Job. Takes into account the Event Averages rate and Total
Transferred and Total Saved bytes (bottom right corner of
Run/View PeerSync) to determine the transfer rate for each
Job. The more events and the larger the average file size calcu-
lated in the Event Averages the more accurate the transfer rate
will be.  This also shows a cumulative transfer rate for all Jobs. 

Byte s  Displays the total number of bytes that were transferred for the
specific Job or all the Jobs.

Eve nts Shows the total number of events detected for the Job or all the
Jobs as well as number of active events currently being pro-
cessed.

Eve nt Ave ra g e s Displays the average number of events that occurred per minute.
The average size of the events are also noted.

In Que ue : Sca n The number of files in queue that are generated by a scan. 

In Que ue : RT The number of files in queue that are real-time events.

In Que ue The total number of files in queue. The queue represents the
backlock of real-time events for each job. When the queue is
empty the In Sync column is set to Yes.

Up d a te d Counter indicating the total number of files that were updated
and their size in bytes.

Ad d e d Counter indicating the total number of files that were added and
their size in bytes.

De le te d Counter indicating the total number of files that were deleted and
their size in bytes.

Exclud e d Counter indicating the total number of files that were excluded
and their size in bytes.

Me ssa g e s Counter indicating the total number of messages. 

Fa ile d  Eve nts The number of failed events for each Job or all Jobs.

Re a l-T ime Displays the state of Real-Time detection (On or Off).

Inte rva l Sca ns Information when the next interval scan is to occur.

Da ily  T ime r Sca ns Information when the next scheduled scan is to occur.

Sta tus Shows the status of each Job or all Jobs.

Sca n Ne e d e d Lets you know if a scan is needed (Yes) or not (No) after a con-
nection failure. 

Lo g  File  Pa th Displays the location of the log file. Used in pop-up menu.

Jo b s Sta ts  (R ig ht-Click  Po p -Up  Me nu)
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To see this menu, right-click on the Jo b  Sta ts  panel.

Se le c t Co lumns.... Add or remove columns from the Jobs Stats display.

Sca n Jo b : Jo b Na me Issues a one-time scan of the selected Job.

Sca n All Jo b s Issues a one-time scan of all the enabled Jobs in the Profile.

Sto p  Jo b : Jo b Na me Stop the selected Job without stopping or interrupting any other
potentially running Jobs in the Profile. 

Vie w Lo g  File View the log file for the selected Job.

Op e n So urce  Fo ld e r:
Pa th

Opens the source folder in a Windows Explorer window.

Op e n T a rg e t Fo ld e r:
Pa th

Opens the target folder in a Windows Explorer window.

Sa ve  As Saves the current Jobs Stats list into a CSV file format (i.e.
PSJobStats.csv). 

Re p ro ce ss Fa ile d
Eve nts

If the Job is running in a Warning state (Yellow), the Job has
failed events. Selecting this option will notify PeerSync to re-pro-
cess any failed events. This option is also available in the Run
menu.

Ad va nce d  Run/Vie w Pe e rSync

To see this panel, click on the Show Advanced Display link at the bottom right corner of the
Run/View PeerSync window. The Enable Advanced Display option must be checked in or-
der for this link to be active. The Advanced Run/View PeerSync display is the bottom
screen. In addition to containing the same information as the Basic Display, the Advanced
Display contains the following additional tabs:

Sta tus Containing the same information as the Basic Display
view/panel.

Up d a te d Lists the total number of files that were updated for the selected
Job or all the Jobs. Right-click and select Save As to export the
list into a CSV file format (PSUpdated.csv).

Ad d e d Lists the total number of files that were added for the selected
Job or all the Jobs. Right-click and select Save As to export the
list into a CSV file format (PSAdded.csv).

De le tio ns Lists the total number of files that were deleted for the selected
Job or all the Jobs. Right-click and select Save As to export the
list into a CSV file format (PSDeleted.csv).

Exclud e d Lists the total number of files that were excluded for the selec-
ted Job or all the Jobs. Right-click and select Save As to export
the list into a CSV file format (PSExcluded.csv).
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Me ssa g e s Lists the total number of messages for the selected Job or all
the Jobs. Right-click and select Save As to export the list into a
CSV file format (PSMessages.csv).

Jo b  Sca ns Lists how many scans are running at a Job level either for the
selected Job or for all the Jobs. Right-click and select Save As
to export the list into a CSV file format (PSJobScans.csv).

Ma na g e d  File s  Lis t Lists the total number of files that are in the Managed Files
List for the selected Job or all the Jobs. Right-click and select
Save As to export the list into a CSV file format (PSMan-
agedFilesList.csv).

Fa ile d  Eve nts Lists all the failed files for the selected Job or all the Jobs. You
can right-click the list and select Reprocess Failed Events to
notify PeerSync to re-process them for all the Jobs (not Job
specific). To reprocess only a specific file, you can click the Re-
process Selected button from the Failed Events tab within the
PeerSync Status Display (when running as an application
only).  Right-click and select Save As to export the list into a
CSV file format (PSFaileEvents.csv). 

File  Co p y Pro g re ss Visually displays the file copy progress for each file for the se-
lected Job or all the Jobs. Right-click and select Save As to ex-
port the list into a CSV file format (PSFileCopyProgress.csv).

His to rica l Da ta This panel displays a subset of the Job Stats table (Xfer Rate,
Bytes and Event Averages) in an hourly, daily, weekly, and total
format for all the Jobs or only the selected Job. Furthermore, it
displays a Running Event Count, a Running Event Average and
Peak Count, and a Running Job Count. Right-click and select
Save As to export the list into a CSV file format (PSHistoric-
alData.csv).

Jo b  Co ntro l This tab is available from the Advanced Run/View PeerSync
panel. It shows the Job Control Bar which allows every Job to
be stopped, started, or restarted individually. In addition, this
tab displays all Pending Jobs in a grid from where they can be
individually selected and started. This tab can also be seen in
the PeerSync Status Display panel under the Jo b  Sta ts  a nd
Co ntro l tab. 

Notes:  

For efficiency purposes, only when you click on the screens/ tabs within the Adv anc ed Run/ View PeerSync
panel will the values get updated. A Cac he folder within the PeerSync installation folder maintains the necessary
event files that will be loaded into the advanced display screens/ tabs.
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4.2  PeerLock Run/View

T o p ics
Basic Display
Advanced Display

4.2.1  Basic Display

Run/Vie w Pe e rLo ck  - Ba s ic  D isp la y

If you are running PeerLock v2.0.1 or newer on the same machine as PeerSync you will now
be able to configure PeerLock directly from the PeerSync Profiler. This window will allow
you to start/stop/pause/resume the PeerLock service. Click here for information on how to
install the PeerLock service or run PeerLock as an application. The following options can
be found in the Startup/Service window.

La unch Pe e rLo ck This button allows you to launch the PeerLock application and
monitor the files that are Locked or Released by PeerLock.
When the application is terminated this button will become
available. 

Run a s  a  se rv ice This option is available only if the PeerLock service has been
installed and the Run as a Service option is enabled. Check
this option to run PeerLock as a Service. When checked, you
will have the options to Start, Stop, Pause and Resume the
Service. Uncheck the "Run as a service" option run PeerLock
as an Application. When this option is uncheck you will have a
"Launch PeerLock" button available. 

Sta rt Se rv ice This button allows you to start PeerLock as a Service. This op-
tion is available if the PeerLock service has been installed,
the Run as a Service option is enabled, and the PeerLock
service is stopped or not running. 

Sto p  Se rv ice This button allows you to stop the PeerLock Service.  This op-
tion is available if the PeerLock service has been installed,

http://www.peersoftware.com/solutions/file-locking-for-ms-dfsr.html
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the Run as a Service option is enabled, and the PeerLock
service is running. 

Pa use  Se rv ice This button allows you to pause the PeerLock Service. This
option is available if the PeerLock service has been installed,
the Run as a Service option is enabled, and the PeerLock
service is running. 

Re sume  Se rv ice This button allows you to resume the PeerLock Service.  This
option is available if the PeerLock service has been installed,
the Run as a Service option is enabled, and the PeerLock
service is paused. 

Sho w Ad -
va nce d /No rma l D is-
p la y

Click on this link to toggle between the No rma l and Ad -
va nce d  Run/Vie w Pe e rLo ck panels.

Re fre sh Click on this link to force a manual reload of the Run/Vie w
Pe e rLo ck panel and the statistics that are being displayed.

4.2.2  Advanced Display

Jo b s Sta ts

To see this panel, click on the Show Advanced Display link at the bottom right corner of
the Run/View Pe e rLo ck  window. The Enable Advanced Display option must be checked
in order for this link to be active. The Jobs Stats display is the top panel and contains
runtime statistics for all the Jobs configured within the Profile. Clicking on a Job will update
the bottom Advanced Run/View Pe e rLo ck  panel. Click on the All Jobs entry to display all
the Job statistics, cumulatively, in the bottom panel.

# Represents the automatically assigned Job number for each
Job. An icon represents the state of the Job (Green, Yellow, or
Red):

Green
 

Running with no failed locks

Yel-
low

Warning state indicates the Job is running with
failed locks

Red Failed connection and/or offline/stopped

Jo b  Na me Lists the unique name for each Job.

Lo cks (Active ) Represents the total number of locks created by the specific
Job. The total number of locks that are actively being held are
also shown.

Re le a se s Shows the total number of releases created by the specific
Job.

Lo ck Ave ra g e Represents the number of locks that are created on average
ever minute for the specific Job.

Re le a se  Ave ra g e Represents the number of locks that are released on average
ever minute for the specific Job.
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Fa ile d  Lo cks Shows the total number of locks that failed to be created for the
specific Job.

Sta tus Displays the status of the Job (i.e. Stopped, Starting and
Normal).

So urce The folder which is monitored for open activity.

T a rg e t The folder which is contains the files for PeerLock to lock.

Jo b s Sta ts  (R ig ht-Click  Po p -Up  Me nu)

Se le ct Co lumns.... Add or remove columns from the Jobs Stats display. 

Vie w Lo g  File : Pa th Open the log file in the default editor for the selected Job.

Op e n So urce  Fo ld e r:
Pa th

Opens the source folder in a Windows Explorer window.

Op e n T a rg e t Fo ld e r:
Pa th

Opens the target folder in a Windows Explorer window.

Sa ve  As Saves the current Jobs Stats list into a CSV file format (i.e.
PLSelectionList.csv). 

Ad va nce d  Run/Vie w Pe e rLo ck

To see this panel, click on the Show Advanced Display link at the bottom right corner of
the Run/View Pe e rLo ck  window. The Enable Advanced Display option must be checked
in order for this link to be active. The Advanced Run/View Pe e rLo ck  display is the bot-
tom screen. In addition to containing the same information as the Basic Display, the Ad-
vanced Display contains the following additional tabs:

T a rg e t File  Pa th Shows the file name complete with folder path for a target file
that is locked, if the file exists and/or can be locked.

Lo cke d Display the date/time when the target file was locked.

Dura tio n Displays the amount of time that the source file has been
opened.

Acce sse d  By The name of the user who has opened the file or accessed the
resource.

T a rg e t Acce ss Al-
lo we d

Displays the permissions that are allowed on the opened target
file which are applied by PeerLock.

So urce  File  Pa th Displays the file name complete with folder path for the source
file that has been detected as an open file.

Jo b  Numb e r Represents the automatically assigned Job number for each
Job.
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# Lo cks Displays the number of locks on the source.

Ap p lica tio n Displays the application that has been detected as opening the
source file. 

De te ctio n T yp e This column represents the PeerLock detection mode used to
detect what source files are locked/opened. This will either be
File Server Mode Detection or Local Detection. 
Note: Starting with version 3.0, PeerLock supports File Server
Mode Detection only.

Id le  T ime Shows the amount of time the target file will remain locked
once the source file has been released. When the source file is
closed PeerLock will wait the number of Idle Time seconds
specified before releasing the target file. During the Idle Time
period the file entry in the Locked list will be highlighted Yellow.
The Idle Time value can be set in the Release Options dialog.
This feature is intended to protect the releasing of files during
file opens and saves. Certain applications may temporary re-
lease files during these procedures. With this feature enabled
PeerLock will wait the set period of time to make sure the file
is fully released before unlocking the corresponding target files

Lo ck File  Ha nd le Displays the handle value created that is being used to lock the
temporary Lock File created by PeerLock to Interact with other
Peer Software Products. If the Interact features are disabled
then this will display 'None'.

Re le a se  De te cte d Shows the date and time when PeerLock detected the source
file was closed. This value will be cleared if the file is reopened

within the Idle period and the target file handle is not released. 

So urce  Acce ss Al-
lo we d

Displays the permissions that are allowed on the opened
source file. 

So urce  Attrib ute s Shows the attributes of the source file. 

So urce  Ha nd le Displays the handle value created when the source file was
opened.

So urce  Mo d ifie d Shows the modified date/time of the source file when it was de-
tected as being open.

So urce  Op e n Mo d e Displays the permissions that were used to open the source
file.

T a rg e t Ha nd le Display the handle value created that is being used to lock the
target file by PeerLock. 

T a rg e t Op e n Mo d e Displays the permissions that were granted when the target file
was locked by PeerLock.

T e mp o ra ry  Re le a se s Shows the number of times the source file was closed during
the Idle period. 
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Notes:  

For efficiency purposes, only when you click on the screens/ tabs within the Adv anc ed Run/ View PeerLoc k
panel will the values get updated. A Cac he folder within the PeerSync installation folder maintains the necessary
event files that will be loaded into the advanced display screens/ tabs.

Command Line Arguments

PeerSync's Command Line Mode offers users the ability to configure a truly "hands-off" in-
stallation, where operation and distribution occurs from within an easily manageable, admin-
istrative environment. This mode allows Profiles to be executed from logon scripts, system
batch (BAT) or command (CMD) files, detailed shortcuts, and shell commands -- while also
providing full access to the Profiler features through command line arguments.

Profiles will need to be created through the Profiler first in order to be further modified through
the arguments described in this topic (See Profiler Overview and related Help Topics).  

Command Line Arguments are entered into a Profile shortcut, created during build through the
"Add to Desktop" button found on Profiler's Startup/Service screen.

Notes:  

1. For the command line arguments described in this topic, note that attention is paid to punctuation, to the order in
which arguments are entered, and that appropriate spaces are used to separate these arguments. Follow the
format outlined in the examples provided.

2. Profile .SNC file names are the only command line variables associated with operation of the Profiler. All other ar-
guments described in this topic are used to configure operation of the PeerSync and its execution of Profiles.   

Pro file r Co mma nd  Line  Arg ume nts

As noted above, Profile (.SNC) file names are the only variables associated with operation
of Profiler. To change an .SNC file name through the command line: 

1. Right click the Profile shortcut you created during build (see StartUp/Service, "Add to
Desktop" button). 

2. Select the "Properties" item from the pop-up menu. 
3. Select the "Shortcut" tab. As shown in the following sample, the "Target" field will contain

a command line for the Profile, where "Profile One" represents a sample Profile name: 
" C:\ Program Files\ PeerSync\ PeerSync.exe"  " C:\ Program Files\ PeerSync\ Profile

One.SNC"  / USEPROFILEARG
4. Manually change the Profile Name to reflect that of the new .SNC file
5. Click the "OK" button

Pe e rSync Co mma nd  Line  Arg ume nts

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M).

T o p ics
Configuration Arguments
Performance Arguments
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Reporting and Display Arguments
Automation Arguments
Synchronization Arguments
Real-time Arguments
Managed Files Arguments
Bi-directional Arguments

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Some features described on this page may require the Enhanced Package. 

3. Command line arguments can also be identified through hints displayed on the Profiler. 

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will dis-
play both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:/ / www.peersoftware.com/ support/ submit-a-case.html. 

1.  Configuration Arguments

Co nfig ura tio n Arg ume nts

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M). 

/0:Pro file
Se t SNC File  to  Lo a d  (Profile = File ):  If the /0 argument is used in a shortcut or from the
command line, PeerSync will load the Job information specified in the file.

Examples:
/ 0:" C:\ My SNC\ MyBac k ups.snc "
/ 0:MyBac k ups.snc
MyBac k ups.snc

Full path to file
Will use install directory
Will use install directory (Must be first argument)

/1:so urce
Se t So urce  Pa th (sourc e = Fo ld e r):  If the /1 argument is used in a shortcut or from the
command line, PeerSync will use it in conjunction with /2 to define a Source and Target
path for a Job.

Example:
/ 1:c :\ sourc e / 2:c :\ target c:\ source to c:\ target

/2:ta rg e t
Se t T a rg e t Pa th (target = Fo ld e r):  If the /1 argument is used in a shortcut or from the
command line, PeerSync will use it in conjunction with /2 to define a Source and Target
path for a Job.

Example:
/ 1:c :\ sourc e / 2:c :\ target c:\ source to c:\ target

/C:c fi le

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/support/submit-a-case.html
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Lo a d  Alte rna te  Co nfig ura tio n File  (c file = File ):  If the /C argument is enabled, Peer-
Sync will use the values specified in c file for synchronization information instead of using
the default configuration file: PSDef.cfg which is located in the install directory.

Example:
/ C:C:\ PeerSync \ c onfigs\ altc on-
fig.c fg 

Use alternate configuration file 

/USEPROFILEARG
Use  Arg ume nts  fro m Pro file :  If the /USEPROFILEARG argument is used in conjunc-
tion with a /0:Pro file , PeerSync will use the arguments specified in Pro file ,  for synchroniz-
ation. By default, when you create a shortcut on the desktop or in the startup folder from the
StartUp Options screen this argument is used.

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Some features described on this page require the Enhanced Package.

3. Command line arguments can also be identified through hints displayed on the Profiler. 

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will dis-
play both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:/ / www.peersoftware.com/ support/ submit-a-case.html.

2.  Performance Arguments

Pe rfo rma nce  Arg ume nts

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M). 

/GE:x
Se t Sha re d  Pro ce ss De la y :  The /GE argument is used to set the shared process
delay to allow more/less CPU utilization. This value ranges from 0 -10 where 0 (less CPU)
will use the most delay and 10 (more CPU).will use the least amount of delay.

/GK:x
Co p y T hre a d  Util iza tio n:  If the /GK argument is enabled, PeerSync will allow up to x

threads to watch the queue that manages changes allowing for increased Copy Thread util-
ization.

/GP:x
Se t Ema il T hre a d s:  If the /GP argument is enabled, PeerSync will allow up to x threads
to be used for email tasks.

/LK:x
Se t Multita sk ing  De la y :  The /LK argument is used to adjust the delay during multitask-
ing. This value may be set between 1 and 10 where 10 is the highest amount of delay and 1
is the least amount of delay. The default value is 4.

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/support/submit-a-case.html
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/LN:x
Se t Pro ce sso r Affinity :  If the /LN argument is enabled, PeerSync will allow you to limit
which CPUs to use in a multi-processor environment, where each CPU is represented by 2
to the x value:

/LN:1 = Use CPU 1 /LN:16 = Use CPU 5
/LN:2 = Use CPU 2 /LN:32 = Use CPU 6
/LN:4 = Use CPU 3 /LN:64 = Use CPU 7
/LN:8 = Use CPU 4 /LN:128 = Use CPU 8

Exa mp le s:
/LN:1 Use CPU 1
/LN:3 Use CPU 1, CPU 2 (/LN:1 + /LN:2 = /LN:3)
/LN:4 Use CPU 3
/LN:5 Use CPU 1, CPU 3 (/LN:1 + /LN:4 = /LN:5)
/LN:15 Use CPU 1, CPU 2, CPU 3,

CPU 4
(/LN:1 + /LN:2 + /LN:4 + /LN:8
= /LN:15)

Note: By default all CPUs will be used. 

/MCT :x  
Se t Co p y T hre a d s:  If the /MCT  argument is enabled, PeerSync will allow up to x file
copy threads to be spawned for file copy tasks. These copy threads will be shared by one
or more Jobs during the synchronization process. 

Note: This item is selectable from the Profiler via the Options/ Commands Screen.

/MFT :x  
Se t Jo b  T hre a d s:  If the /MFT  argument is enabled, PeerSync will allow up to x Job
threads to be spawned for managing Job tasks.

Note:  This item is selectable from the Profiler via the Options/ Commands Screen.

/OPT IMIZE
Op timize  Pe rfo rma nce :  If the /OPT IMIZE argument is enabled, PeerSync will disable
status screen windows used for outputting status information. This will minimize memory al-
location for the User Interface.

/PERFORMANCE:x
Se t Ap p lica tio n Prio rity :  If the /PERFORMANCE argument is enabled, PeerSync will
set the application's priority based on the following value of x

0: Lowest Priority
1: Below Average Priority
2: High Priority. 

Notes: 

1. This item is selectable from the Profiler via the Options/ Commands Screen.

2. If the / PERFORMANCE argument is not used, PeerSync will use a default priority.

3. When setting the Application Priority to High, PeerSync will use more then average CPU, you may want to use
the Set Processor Affinity argument in this scenario.

/YK:n  



PeerSync Help139

Copyright © 1993-2019 Peer Software Inc. All Rights Reserved

Se t Re a l-time  Co p y T hre a d  Po o l: Used to set the percentage of Copy Threads to re-
serve for Real-Time events, where n can be set between the values of 1 and 99. The de-
fault value is 10.

/YX:n  
Se t File  Re a d /Write  Buffe r De la y :  Used to set a delay in n milliseconds between
each file read/write cycle to allow the limiting of CPU usage and system resources during
file transfers. The higher the delay value, the less CPU used but the slower the performance
or speed of PeerSync. 

/QR
Exc lud e  Co mmo n Jo b  Exce p tio ns  in Eve nt Pro ce ss ing : Checks the global exclu-
sions before file hits such as before event processing and before adding the event to the
visual list. This option creates a global file exclude list based on the file exclude list from all
the Jobs. The filter applies to real-time add and update events. Since they are applied
early in event processing there are no log entries for these exclusions. Remove the /QR
option to achieve logging. 

/Q70
Exc lud e  Co mmo n Jo b  Exce p tio ns  in Eve nt Pro ce ss ing  fo r FPo licy  Jo b s Only :
This argument is the equivalent of the /QR option but applies to FPolicy Jobs only. In the
user interface, set the Exclude Extensions list to %AUT O% to achieve the same result. 

/Q70:s
Exc lud e  Exte ns io ns: Provide a list of comma (,) delimited file extensions to exclude
when using NetApp FPolicy detection during scans or in real-time. This can be done in the
user interface or via the command line. Use use /Q70:s , where s  represents the comma (,)
delimited list of extensions to exclude (i.e. /Q70:tmp,dwl,dwl2). 

/Q7-s
Exc lud e  Vo lume s: Provide a list of comma (,) delimited volumes to exclude when using
NetApp FPolicy detection during scans or in real-time. This can be done in the user inter-
face or via the command line. Use /Q7-s , where s  represents the comma (,) delimited list of
volumes to exclude (i.e. /Q7-vol3,vol4).

/Q7+s
Inc lud e  Vo lume s: Provide a list of comma (,) delimited volumes to include when using
NetApp FPolicy detection during scans or in real-time. This can be done in the user inter-
face or via the command line. Use /Q7+s, where s  represents the comma (,) delimited list
of volumes to include (i.e. /Q7+vol1,vol2).

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Some features described on this page may require the Enhanced Package or Multi Threading Option. Please
visit http:/ / www.peersoftware.com or contact Sales for additional information.

3. Command line arguments can also be identified through hints displayed on the Profiler. 

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will dis-
play both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:/ / www.peersoftware.com/ support/ submit-a-case.html.

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
http://www.peersoftware.com
http://www.peersoftware.com/contact.html
http://www.peersoftware.com/support/submit-a-case.html
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3.  Reporting and Display Arguments

Re p o rting  a nd  D isp la y  Arg ume nts  

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M). 

/AP
Run Pre -Sync Re p o rt:  If the /AP argument is used a Pre-Sync Report will be gener-
ated and files/folders will not be synchronized. If you add an O to the /AP then the previous
Pre-Sync report will be Over written, if you exclude the O then the file will be appended to an
existing Pre-Sync report. If you add an S to the /AP then the Pre-Sync report will be Shown
at the end of the run (i.e.: /AP, /APO, /APOS or /APS). 

Note: This item is selectable from the Profiler via the Options/ Commands Screen.

/GL[S]  
D isp la y  s ta tus  in Pro file r:  If the /GL argument is used, PeerSync will open the Profiler,
if it is not already open, and send status messages to be displayed on the Run/View Cur-
rent Profile Activity screen using mail slot messaging to communicate with the Profiler. By
adding an S you can suppress the initial connection of PeerSync to the Profiler upon activ-
ation of PeerSync.

Note: This item is selectable from the Profiler via the Options/ Commands Screen.

/GM:x
Ena b le  MSMQ me ssa g ing :  If the /GM argument is used, PeerSync will use x as the
location to manage messages in the queue. 

Example: / GM:DIRECT=TCP:209.51.171.142\ PRIVATE$\ MYQUEUE

/ GO[F:y] [C:group]
Ena b le  Pe e r Ad minis tra to r Bro a d ca sts :  If the /GO argument is used, PeerSync will
use mail slots to broadcast activity across the LAN to the Peer Administrator utility for the
centralized viewing of all PeerSync activity on the network. You can launch the Peer Admin-
istrator utility, if it is installed/available from the View Menu.

y: Identifies the number of seconds between each broadcast. The default is 3 seconds.
group: Identifies a group for the current Profile. The default is the Profile Name.

Example: / GOF:5C:MyProfiles Enabled and broadcasted every 5 seconds with a group name of

/GQ:[ f ile] [maxsize]
Cre a te  a nd  Ap p e nd  Summa rie s  into  One  Re p o rt:  If the /GQ argument is used,
PeerSync will append summaries into one log file.

/GR
Re p o rt No n Sta nd a rd  Eve nts :  If the /GR argument is used, PeerSync will report non -
add,update, and delete actions.

/GS:x
Ena b le  Summa ry  Sta tis tics  Co lle c tio n:  If the /GS argument is used, PeerSync will
use x as the file location to save summary statistics.

/H  

http://www.peersoftware.com/products/management-monitoring/peer-administrator.html
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Hid e  Sp la sh Scre e n:  Available through all registered versions of PeerSync, this argu-
ment will suppress and hide the splash screen from the Taskbar for both the PeerSync and
Profiler applications.

/H-
Only  H id e  the  a b o ut scre e n:  Available through all registered versions of PeerSync,
this argument will suppress and hide the About screen for both the PeerSync and Profiler
applications.

/H+
Skip  se tting  o f ma in fo rm v is ib le : Available through all registered versions of Peer-
Sync, this argument will no set the main form visible and always hide the application from
the Taskbar for both the PeerSync and Profiler applications.

/LSE 
Lo g  Se rv ice  Eve nts  to  the  Eve nt Vie we r:  If the /LSE argument is used, PeerSync
will log events to the Event Viewer. The following options are available for this argument:

/LSEE Log messages as errors
/LSEEW  Log messages as warnings
/LSEEM  Only log messages and log them as errors

/LSEEWM  Only log messages and log them as warnings

/M 
Sho w T ra y  Ico n:  If the /M argument is used, PeerSync will display an icon in the system
tray for PeerSync. 

Note: This item is selectable from the Profiler via the Options/ Commands Screen.

/PROGRESS 
D isp la y  s ta tus  in Pe e rSync:  This feature will show the PeerSync Status Display dialog
box during synchronization so the user can see activity, status and other information while
PeerSync is running. 

Note: This item is selectable from the Profiler via the Options/ Commands Screen.

/SNMP
Ena b le  SNMP Erro r Re p o rting :  If the /SNMP argument is used, PeerSync will use
SNMP reporting to report any errors that occur during the synchronization process.

/T D 
D isp la y  s ta tus  in Pe e rSync up o n co mp le tio n:  This feature will have PeerSync show
the PeerSync Status Display dialog box at the end of synchronization (only in non-persist-
ent modes) so the user can see activity, status and other information upon completion. 

Note: This item is selectable from the Profiler via the Options/ Commands Screen.

/YL 
Lo g  Me ssa g e s Only  to  a  Lo g  File  b y  Filte r a nd /o r b y  Pro file :  If the /YL argument
is used, PeerSync will log messages only to a log file based on the Filter and/or Profile.
The following options are available for this argument:
 
/YL   
/YLF 
/YLP   

Log messages for Both
Log messages by Filter Only
Log messages by Profile Only
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When logging by Filter (/YL or /YLF), the Filter message log file will reside in the same dir-
ectory as the primary log file, with the same file name as the primary log file but with a
"flt.lo g " file extension. 
When logging by Profile (/YL or /YLP), the log file will reside in the same directory as the
Profile, with the same file name as the Profile but with a "snc.lo g " file extension. 

/QP
Do n' t D isp la y  Jo b  Sta ts : If the /QP argument is used, PeerSync will not display any Job
statistics in the Status Display window. Disabling this option reduces the amount of over-
head work PeerSync is doing. 

/QY7
XML File  Cre a tio n Inte rva l: By default PeerSync stores Profile and Job related statist-
ics into an easily readable XML files on an interval of every 60 seconds (if applicable) as
well as during the completion of a Job scan. This interval can be adjusted using
the /QY7:n command line argument where n represents the interval in seconds of how of-
ten you want PeerSync to update the Profile related XML statistics. 

/QY7:(T -)(C-)(A-))(n)

n (Interval to write out statistics (60 is the default))

T
-

(Suppress .tot file creation)

C
-

( Suppress .cur file creation)

A
-

(Suppress all XML file creation and new logic for tracking file extensions)

/YB:x
D isa b le  T ra y  Ico n Me nu Ite ms: If the /YB argument is enabled, PeerSync will allow
you to limit which T ra y  Ico n menu items to be disabled, where each menu item is repres-
ented by 2 to the x value. 

No te : To disable multiple menu items simply add the /YB values together for the items
you wish to disable. 
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EXAMPLES
/YB:512 Disables the Exit Pe e rSync menu option

/YB:24 Disables the Op e n So urce  Fo ld e r and Op e n T a rg e t Fo ld e r
options
8+16=24

/YB:767 Disables All Menu Options except Ab o ut Pe e rSync
1+2+4+8+16+32+64+128+512=767

/QP
Disa b le  Jo b  Sta ts : If the /QP argument is enabled, the Jo b  Sta ts  option will be un-
checked, resulting in no Job statistics being shown in the PeerSync Advanced Display
panel. 

/Q8BJ+
Ena b le  Jo b  Sca ns T a b : If the /Q8BJ+ argument is set, a Jo b  Sca ns tab will be cre-
ated in the Advanced Run/View PeerSync panel showing Base/Root, Enhanced/Expan-
ded, and RT/Sub-folder scans with statistics and progress for all the Jobs or the selected
Job.

/QQ
Ena b le  the  File  Co p y Pro g re ss  T a b : If the /QQ argument is set the File  Co p y Pro -
g re ss  tab will be created in the Advanced Run/View PeerSync panel to show the progress
of a file transfer.  This feature requires the Multi-Threading Option.

/Q8BH+
Ena b le  the  H is to rica l Da ta  T a b : If the /Q8BH+ argument is set, the Historical Data tab
will be shown in the Advanced Run/View PeerSync panel. This tab contains a subset of
data from the PeerSync Jobs Stats panel (Xfer Rate, Bytes and Event Averages) and is
broken down into total, hourly, daily, and weekly statistics for all the Jobs or only the selec-
ted Job. 

/QQ<<
Disa b le  the  Sho w Ad va nce d  D isp la y  link at the bottom right corner of the  Run/View
PeerSync screen.

/Q7O
Sha re  Mig ra tio n re p o rting  le ve ls : The default behavior with no arguments is to report
Share Errors, Share Totals, Share Actions and Share Permission Errors. 

/Q7OR- Report Share Errors and Share Totals only
/Q7OR Report Share Errors, Share Totals, Share Actions, Share Permission Er-

rors and Extended Share Information
/Q7OR+ Report Share Errors, Share Totals, Share Actions, Share Permission Er-

rors, Extended Share Information, Get and Set of Shares, Share Permis-
sion Matches and Share Permission Skips 

/Q7OR++ Share Errors, Share Totals, Share Actions, Share Permission Errors, Ex-
tended Share Information, Get and Set Share Information, Share Permis-
sion Matches, Share Permission Skips and Share Permission Actions

/Q7OV Report source and target system information
/Q7O- Use previous Share Migration Logic from v9.0
/Q7OR- - Same as /Q7OR- and disables share migration starting information

http://www.peersoftware.com/products/sync-backup/peersync-for-servers.html
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/Q7OI- Disable share migration starting information
/Q7OE Report all activity at the end of share migration, instead of during

/Q8B:
In Que ue  D isp la y  Op tio ns: Track pending events at the Job level and help determine if
a Job is in sync. 

Q+ Enable real-time stats (including RT Scans: x/y where x is RT Scans Pending and y is
RT Scans Running)

Q- Disable collection of RT Scan stats
Q++ Get the file size for RT Stats and display Bytes. This option may decrease perform-

ance. If this is disabled (i.e. no Q++ switch in /Q8B) then bytes will show as N/A
Q> Enable scan stats. This option may slightly decrease performance
R+ Track and display In Queue Retries
M+ Track and display In Queue Managed Files
>>
o r
>>>

Enable all Scan, RT, Retry and Manged Files stats, as well as other debug stats

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Some features described on this page require the Enhanced Package.

3. Command line arguments can also be identified through hints displayed on the Profiler. 

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will dis-
play both a description of the feature as well as its related command line argument (if any). For more information
on the latest features and how to implement specific scenarios please goto our support page at:
http:/ / www.peersoftware.com/ support/ submit-a-case.html 

4.  Automation Arguments

Auto ma tio n Arg ume nts

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M). 

/A 
Sca n a t Sta rt:  If the /A argument is appended to the command line, the Profile can be run
through its associated shortcut. As non-persistent processes, Automatic Operations are run
a single time upon manual initiation by the user. 

Note: This item is selectable from the Profiler via the Options/ Commands Screen.

/D(H):x
De la y  Sta rt o f Pro file r:  If this argument is used, PeerSync will delay the load/start of
PeerSync by  x seconds. With this option enabled synchronization can be canceled via a
dialog box if done within the designated interval. For example, /D5 would provide you with
a 5 second delay during which the operation can be canceled. If the /D  argument includes
an H, i.e. /DH60, then the delay timer dialog will be hidden. This argument is useful for al-
lowing PeerSync to begin after other applications have been loaded if you are running
PeerSync at Windows startup.

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/support/submit-a-case.html
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/R [OyCz]  
Re a l-time  Mo nito ring  Arg ume nt:   The /R  argument activates Real-Time Mode.
The Oy and Cz arguments are optional and specify the following retry values during Real-
Time Mode:

y = The retry count if the file is open or network is unavailable 
z = The retry count maximum 

Note: This item is selectable from the Profiler via the Options/ Commands Screen.

/S 
Run Sche d ule d  Op e ra tio n:  The /S argument enables or disables Scheduled Opera-
tion Mode for the entire Profile. This feature must be selected in order for all Scheduled
Operations set for individual Jobs to be recognized. Scheduled Mode does not apply a
global schedule to the entire Profile: rather, it enables those schedules set for all individual
Jobs on to run at their specified intervals. 

All Scheduled Operations set for individual Jobs will be ignored if this mode is not selected.
If none of the Jobs within a Profile are set for Scheduled Operation and this mode is selec-
ted, all active Jobs within the Profile will be assigned a default synchronization schedule of
five minutes. 

/Sx 
Synchro niza tio n T ime r Arg ume nt:  The /Sx option is used to run PeerSync automatic-
ally at regular intervals. This argument sets PeerSync to synchronize the selected Profile
every x minutes. Through this feature PeerSync remains persistent and will not terminate
upon completion.

Examples: / S10 Synchronization will be performed every 10 minutes

/T IME
Da ily  T ime r:   This argument will allow for scheduling of PeerSync for specific times of the
day down to the minute for selected days of the week and selected Jobs within a Profile.  If
you use a /T IMEF argument all selections at the Job level from the Automation screen will
be used. You can also specify Global Daily Timer selections for the entire Profile from the
Options/Commands Screen or by using the following format:

1. Selec t the t ime of day (by default all Jobs will be run all days)

/ T IME:HH:MM
Where HH is replaced with the value of 00-23 in military time and MM is replaced with 00-59 in minutes

Examples:
Every Day at
12:00 am:
Every Day at
1:00 am: 
Every Day at
8:00 am: 
Every Day at
12:00 pm: 
Every Day at
8:00 pm: 

/ T IME:00:00
/ TIME:01:00
/ TIME:08:00
/ TIME:12:00
/ TIME:20:00

2. (Optional) - To selec t the days of week  to run append the following:

D:SMTWTFS where the days are substituted with 1 (On) and 0 (Off)
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Sunday:
Monday: 
Tuesday: 
Wednesday:
Thursday: 
Friday: 
Saturday: 

D:1000000
D:0100000
D:0010000
D:0001000
D:0000100
D:0000010
D:0000001

Examples:
M, W & F at 8:00
am:
Sat & Sun at
5:15 pm: 
Mon - Fri at 3:30
am: 

/ T IME:08:00D:0101010
/ TIME:17:15D:1000001
/ TIME:03:30D:0111110

3. (Optional) - To selec t the Jobs to run append F:f1;f2;f3

Where f1-fn are the Job numbers.

Examples:
Job 1 Every day
at 6:00 am:   
Jobs 1 - 5 Every
day at 8:25 pm:
Jobs 1, 3 & 5
Mon - Fri at 3:30
am: 

/ T IME:06:00F:1
/ TIME:20:25F:1;2;3;4;5
/ T IME:03:30D:0111110F:1;3;5

Note: Will accept multiple command lines.

Example:
Job 1 Every day at 8:00 am, Jobs 1 - 5 Every day at 8:25 pm and Jobs 1, 3 & 5 Mon - Fri at 3:30 am
/ TIME:08:00F:1 / T IME:20:25F:1;2;3;4;5 / T IME:03:30D:0111110F:1;3;5

Sample: 
Complete command line to run PeerSync with Test.snc, all Jobs, at 3:00 am Mon -Fri, (M)inimized on the tray.
" C:\ Program Files\ PeerSync \ PeerSync .exe"  " C:\ Program Files\ Peer-
Sync \ test.snc "  / T IME:3:00D:0111110 / M 

Note: This item is selectable from the Profiler via the Options/ Commands Screen.

/UDD 
Use  De v ice  Drive r me tho d :   This argument uses of the Windows NT device driver for
real-time detection. When using this argument PeerSync can detect changes made to re-
mote Source folders but only when the changes are made by the machine where PeerSync
is installed.

/< 
Ap p lica tio ns  to  Ig no re :  If using the Device Driver method for Real-Time detection you
can select applications to ignore by appending application names (semicolon delimited)
to the /< argument.

Example: / <Ex-
plorer.exe;W ord.exe

 Will ignore any Real-Time changes made by Explorer.exe and Word.exe.

Note: When using this option and monitoring a remote Source folder, the Transfer NT security descriptions
(ACLs) is ignored in Real-Time.
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/X 
D isa b le  Initia l Synchro niza tio n During  Sta rtup :  The /X command line argument dis-
ables initial synchronization during /A /M /R  operations at PeerSync startup. 

/Q0
Sa ve  Eve nts  Op tio ns: On close of a Profile, if there are failed, pending, and/or running
events, a dialog will prompt the user to store the events and process them on restart. The
following options can be configured:

/Q0 Do not prompt the user.
/Q0+ Always prompt the user.
/Q0? (Default) Ask only if running as an application and off as a service.
/Q0S+ Ask only if running as an application and on as a service.

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Some features described on this page require the Enhanced Package.

3. Command line arguments can also be identified through hints displayed on the Profiler. 

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will dis-
play both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:/ / www.peersoftware.com/ support/ submit-a-case.html.

5.  Synchronization Arguments

Synchro niza tio n Arg ume nts

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M). 

/GC:x
Se t File  Co mp a riso n Va lue :  If the /GC argument is used, PeerSync will add x seconds
to the Target File date and time stamp to use during comparison.

/GD:n,z:n,z 

Se t Jo b  Co mp a riso n De lta :  If the /GD argument is used, PeerSync will add or subtract
z seconds from the Target File date and time stamp during a comparison for Job number
n.

Example: / GD:1,+30:2,-60:

/GF 
Use  Alte rna te  Co p y File  Me tho d s:  The following copy file methods may be invoked:

/GFC Use CopyFile API method
/GFS Use File Stream method
/GFE Use CopyFileEX method

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/support/submit-a-case.html


PeerSync Help 148

Copyright © 1993-2019 Peer Software Inc. All Rights Reserved

/GFA Transfer Alternate Data Streams - The same functionality can be used at a Job
level by using the SETVAR INCLUDEALTFILESTREAMS  switch in the Pre/Post
paths. 

/GI(S)(D) 
Ig no re  File  Size  a nd /o r Da te  Co mp a riso n:  If the /GI or /GIS argument is used,
PeerSync will ignore file size during folder scans (if date matches then skip file). If the /GID
argument is used, PeerSync will ignore file date comparison during folder scan (if size
matches then skip file).f the /GISD argument is used, PeerSync will ignore file date and
size comparison during folder scan (always replace Target file even if they are identical).

/GT  
Ge t Re mo te  PC T ime :  If the /GT  argument is used, PeerSync will attempt to get the
time from the Target PC as well as the local PC and automatically compensate for time dif-
ferences.

Note:  / GT is only applicable in an NT/ 2K Environment

/GX 
Use  De le te  Pa th fo r Re v is io ns:  If the /GX argument is used, PeerSync will use the de-
letions path for all PSBAK revision files.

/ I 
Ig no re  T a rg e t Sp a ce  During  File  Co p y:  The / I argument sets PeerSync to ignore
Target space available during file copy.

/J  
Mo ve  File s :  If the /J  argument is used, PeerSync will move files - deleting them from the
Source after they have been successfully transferred.

/KA:x 
Active  Co nne ctio n Inte rva l:  If the /KA argument is used, PeerSync will attempt to con-
nect every x minutes to Target machine(s).

/LH:x
Se t De le tio n Mo ve  T o  Fo ld e r Cle a nup  Inte rva l:  If the /LH argument is used, Peer-
Sync will check the Move To Folder (the folder where deleted files are move to), every x
minutes to see if files needed to be deleted on the cycle specified by the Delete un-
matched Target Files older than x days option. 

/LI [  R  | T  | A ]
T a rg e t In-Use  Re p la ce me nt:  If the /LI argument is used, PeerSync will perform the fol-
lowing operation if Target File is unavailable:

R Force rename of open Target File
T Force terminate of open Target File application
A Force terminate of all open Target applications

/LM:xOyCz

Se t Fa ile d  Co nne ctio n T ime r:  If the /LM argument is used, PeerSync will use the fol-
lowing variables to determine retry frequency:

x Approximate time, in minutes, for retry of failed connection (time may vary as much
as a few minutes).

y Frequency to retry files
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z Maximum Retry Count

Example: / LM5O25C100 Checks failed connections every 5 minutes, retries files every 25
seconds, to a maximum retry count of 100.

Note: This item is selectable from the Profiler via the Options/ Commands Screen.

/LMD
Disa b le  Fa ile d  Co nne ctio n T ime r:  If the /LMD argument is used, PeerSync will not
check for failed connections:

Example:  / LMD Does not check for failed connections.

Note: This item is selectable from the Profiler via the Options/ Commands Screen.

/LR:f ile
Run a p p lica tio n a t s ta rt o f Pe e rSync:  If the /LR argument is used, PeerSync will ex-
ecute an application or shell script specified by f ile at the initialization of PeerSync.

Example:   / LR:C:\ W INNT\ notepad.exe

/LW
Ena b le  La st Acce ss Co mp a re :  The /LW argument allows you to use the last access
date/time instead of the modified date/time for comparisons to determine file updates.

/NODELFLDR 
Do  no t d e le te  fo ld e rs :  If the /NODELFLDR argument is used, PeerSync will not delete
folders during synchronization.

/O 
Se t T a rg e t File  Ove rwrite :  The /O argument sets Target File overwrite on all Jobs.

/QB
Use  Full Acce ss File  Co p y:  If the /QB argument is used, PeerSync will only copy files
it can gain full access to during synchronization.

/QFn
Sha d o w T ime  Ra ng e :  This argument will use an n second time range for file time
stamps during comparison. If the Source and corresponding Target File time stamps fall in
the range then the file time stamps will be seen as equal.

 n = Time in seconds

Note: / QF:1 is equivalent to a value between 1 to 3 seconds depending on the file systems being used. 

/QF[+] [++] [+++]
Pre c is io n Co mp a riso n: Use this argument to remove minutes, seconds, or milliseconds
from files during comparison. 
 
/QF+ Removes/ignores the milliseconds from both the source and target file time

stamps during comparison
/QF++ Removes/ignores the milliseconds and seconds from both the source and target

file time stamps during comparison
/QF++
+

Removes/ignores the milliseconds, seconds, and minutes from both the source
and target file time stamps during comparison



PeerSync Help 150

Copyright © 1993-2019 Peer Software Inc. All Rights Reserved

/QG
Alwa ys use  the  lo ca l ma chine  time  fo r the  La st Run T ime :  If this argument is used,
PeerSync will always uses the local machine time for the Last Run Time, instead of using
the minimum time of the Source and Target machines involved in the synchronization.

/QH:n
Fo rce  Flush File  Buffe rs :  Forces the file data that has been written across the network
to be fully committed to disk before continuing. The Interval n is the number of buffers worth
of data to write before forcing a disk write of the data, if n is not used the default is 100
cycles. 

Note:  This is expected to naturally occur without this argument, but on some systems across slower networks it
is necessary to force the commit of data to correctly gauge process of writing the file.

/QHD
Dire c t D isk  Write :  Forces the file data that has been written across the network to be
fully committed to disk before continuing. This will occur for each buffer worth of data that is
transferred. 

Note:  You may use this argument or the / GFC option to resolve Windows "Delayed Write Failed..."  messages. 

/QI:ext

Ig no re  Ma tching /Lo cke d  File  Exte ns io ns:  This argument will ignore an add/update
of a file, if a matching file with the same base name and the specified extension e xt exists.

Example:  / QI:dwl

Note:  One instance of this example is if a file called MyFile.dwg is updated it will be excluded from synchroniza-
tion while MyFile.dwl exists.

/QJ :str

Ig no re  Ma tching /Lo cke d  File  Po stfix Re p la ce me nt:  This argument will ignore an
add/update of a file, if a matching file with the same base name with the specified postfix re-
placement s tr exists.

Example:  / QJ:~ $

Note: One instance of this example is if a file called MyDocument.doc is updated, it will be excluded from syn-
chronization while ~$Document.doc exists.

/T
T e rmina te  All Ins ta nce s o f Pe e rSync:  The /T  argument terminates all running in-
stances of PeerSync, including itself. 

/VRBn

Ve rify  Use r-Na me :  If the /V argument is used, PeerSync will verify logged on User-
Name defined in the local user file list, specified by the following options:

R Require user to be in the user file list 
B Bypass the request to add to list dialog
n Maximum number of user allowed

/W:x
Se t Que ue  D ire c to ry  Cha ng e  Co unt:  If the /W argument is used, PeerSync will set
queue directory change count, events to wait for action x.
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/WPFIX 
D isa b le  a p p lica tio n a sso c ia te d  with a c tive  fi le  synchro niza tio n:  When a file is
being synchronized, this option searches all active windows on the desktop for a caption
that contains the path/filename of the active file. PeerSync then disables the active applica-
tion in one of two ways. The command lines "/WPFIX or /WPFIX2" disables the entire ap-
plication and" /WPFIX1" disables the save toolbar and file menu save item. (This option
also verifies that the word "WordPerfect" is in the caption before disabling). Both options
will append "(Synchronizing)" to the existing caption and when the file is synchronized, the
caption will be restored. 

/YC:x
Fo ld e r Que ue  Wa tch Inte rva l:  Change the default timer interval for checking the folder
queue to x seconds (the default is .5 seconds).

Example:  / YC:3

/YD
Allo w Re p lica tio n During  Dyna mica lly  Cre a te d  Jo b s:  This argument will allow dy-
namically created Jobs (i.e. Job scans triggered by Folder Additions) to use the replicate
option.

/YF:e xt1;e xt2;e xtn
Pa rtia l Lo cke d  File  Exte ns io ns Lis t:  This argument is used for file types that are par-
tial locked when open by other applications (i.e. Outlook PST files). If the /YF argument is
used, and Volume Shadow Copy Service (VSS) is enabled PeerSync will always process
files with the specified extensions as though they are open and locked files. If VSS is not
enabled, then PeerSync will pre-scan the files to ensure complete access before file copy.
PST files are included in this list by default and can be changed via this command line.

Example:  / YF:.pst;.dba;

/YN
Use  Ne two rk  Pa sswo rd  D ia lo g :  If the /YN argument is used, PeerSync will display a
network password dialog if you do not have right to access the Source or Target Folder. 

/YR
De le te  Emp ty  So urce  Fo ld e rs  Afte r Mo ve :  This argument will delete all empty
Source Folders after a synchronization scan when using the Move Files - Delete Source
File after successful copy to Target option.

/YV
Do  No t Va lid a te  Co nne ctio ns  Be fo re  Pro file  is  Lo a d e d : This argument will not try
to validate Source and Target Folder connections during the load of a Profile. It will assume
that the connections will be available upon start of each Job. This option is useful if you are
running a Pre Process that will establish a connection and/or create a Source or Target
Folder. This argument should be used when using the /LJP (Always Run Post Process) ar-
gument or when needing to dynamically create the source and or target paths.  

/Z :ext1;ext2;extn

Ig no re  Op e n File  Exte ns io ns:  If the /Z argument is used, PeerSync will ignore files with
the specified extensions that are currently opened where the full name of the file is dis-
played in the caption of another window. This argument may be ignored if Multiple Job or
multiple copy threads are enabled. 

Example:  / Z :.wpd;.txt;
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/LJU:x
Exc lud e  Fo ld e rs  tha t ha ve  a  Re p a rse  Po int: By default PeerSync will exclude
folders that have a Reparse Point object, which are common in Windows Vista. Use this ar-
gument to alter this behaviour: 

/LJU:0 Don't exclude folders that have a Reparse Point object
/LJU:1 Exclude folders that have a Reparse Point object recursively pointing back to itself

(Default)
/LJU:2 Exclude all folders that have a Reparse Point object

/LJP
Alwa ys Run Po st Pro ce ss:  If the /LJP argument is used, PeerSync allows for the abil-
ity to process Post commands even if the Job fails. This argument is useful for non persist-
ent Profiles that need to execute or start other processes regardless whether or not its Job
was able to run. This argument should be used in conjunction with the /YV command which
allows for the Profile to be loaded before the source and target folder(s) are validated. 

/LX:R
Lis te ne r Alte rna te  Ro ute  Pa th: Adding this option will create an Ed it: Lis te ne r Al-
te rna te  Ro ute  Pa th option when right-clicking on either the Source or Target folder selec-
tion paths. This creates and opens a file called %PROFILENAME%.psl in the Profiles dir-
ectory used to configure alternate route(s) for the PSListener. Here is an example of what
the content of the %PROFILENAME%.psl file should look like: 

[LISTENER]

NetAppA=Win2008A

NetAppB=Win2008B

The first column contains the name or IP address of the remote non-Windows server.
The second column lists the name or IP address of the Windows server where the
PSListener is running.

/LZS|A|S|I-|I+|T -|T +|WN 
Co mp a re  a nd  Se t File  Attrib ute s  fro m Wind o ws to  Ne tAp p : Arguments to support

the comparing and setting of file attributes from Windows to NetApp.

A Includes fixes to check for the I attribute to see if the setting of attributes was suc-
cessful and logging of failed setting of attributes. 

S Suppresses the logging of failed setting of attributes due to the above additions
(i.e. /LZAS will run all the new logic but will not log failures).

I- Force off the I attribute when setting target files.
I+ Will force on the I attribute when setting target files. 
T - Will force off the T  attribute when setting target files.
T + Will force on the T  attribute when setting target files.       
WN WN will use A, I- and T - for a potential fix for Windows to NetApp systems.  This is

the recommended workaround for this scenario for now especially for TCP routing.

For a Windows to NetApp Fix use: /LZS:WN

Possible alternatives are to use: /LZSA or /LZSAS

When routing via TCP and not using the WN  (or I- and T-) switches you may require the fol-

lowing entry in the PSLis te ne r93.CFG file:
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[Application Settings]

RevalidateSetFileAttributes=1

/LJFK
Co nve rt We ll-Kno wn SIDs: Set this option to convert well-known SIDs (WNS) when us-

ing ACLs over TCP to act similar to Normal (non-TCP) Jobs.

/LJFK Enable this feature.
/LJFK+ Will Report failures to PSError.log
/LJFK+
+

Will Report converted items to PSError.log

/LJFK+
++

Will Report skipped items to PSError.log

/LJFK+
+++ 

Will Report converted WNS parts to PSError.log

/LJFI Use alternate method.
/LJFIK Uses default and alternate method.

/Q7O
Sha re  Mig ra tio n sup p o rt fo r cDOT  8.3: Add this option to enable Share Migration sup-

port for cDOT 8.3. 

/Q7OM
<

Revert to incrementing message count for the Job for successful share migration
messages. 

/Q7OR
-  

Report Share Errors and Share Totals only

/Q7OR Report Share Errors, Share Totals, Share Actions, Share Permission Errors and
Extended Share Information

/Q7OR
+

Report Share Errors, Share Totals, Share Actions, Share Permission Errors, Exten-
ded Share Information, Get and Set of Shares, Share Permission Matches and
Share Permission Skips

/Q7OR
++

Share Errors, Share Totals, Share Actions, Share Permission Errors, Extended
Share Information, Get and Set Share Information,  Share Permission Matches,
Share Permission Skips and Share Permission Actions

/Q7OV Report source and target system information.
/Q7O- Use previous Share Migration Logic from v9.0.
/Q7OR
- -

Same as /Q7OR- and disables share migration starting information.

/Q7OI- Disable share migration starting information.
/Q7OE Report all activity at the end of share migration, instead of during
/Q7OC
C

PeerSync will use the cDOT 8.2 method which requires user/pass (and optional
Management IP) for source and target cDOT 8.3 systems.

/Q7OC
W

PeerSync will use the cDOT 8.2 method which requires user/pass (and optional
Management IP) for source cDOT 8.3 systems

/Q7O
WC

PeerSync will use the cDOT 8.2 method which requires user/pass (and optional
Management IP) for target cDOT 8.3 systems

/Q7OC
W+

PeerSync will use the cDOT 8.2 method which requires user/pass (and optional
Management IP) for source cDOT 8.3 systems and force on unsupported scen-
arios.

/Q7O
WW

PeerSync will use the Windows and/or 7-Mode method for source and target
cDOT 8.3 systems even for the current scenario that seems to fail for Windows to
cDOT 8.3. 
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/LZR:A|V+
NFS Re p lica tio n: Use these options to enable NFS FPolicy real-time detection, scan-
ning, and the ability to transfer/compare UNIX permissions between NetApp 7-Mode and
cDOT systems.

A Base argument for using rsync for scanning (turned on via the interface)
V+ Turn on debug verbose logging to report why files are excluded

/LZT X
Re mo ve  Fa ile d  Eve nts  If Succe ssfully  Re -Pro ce sse d : Removes Failed Events
from the Failed Event list after they were successfully processed.

/Q7L
cDOT  Op timiza tio ns: This command line argument provides cDOT detection with the
ability to connect to specific nodes, exclude specific shares, and automatically create and
exclude the recommended $ admin share to achieve optimal bi-directional synchroniza-
tion. 

Example:  

/ Q7L:" nodesToConnec t=NODE1;NODE3|nodesToRequire=NODE3;"
/ Q7L:" adminOv errideShare=PeerSync $|v alidateAdminOv errideShare=true|autoCreateAd-
minOv errideShare=true|sharesToExc lude=share1;share2"

Notes:

1.Use " |"  for delimiter between items and " ;"  for delimiter between sub items

2.Quotes are required for strings with " |"  in them

3.RegisterForEvents and UnRegisterForEvents are used if / Q7L string is not set

4.RegisterForEventsExtended and UnRegisterForEventsExtended are used if / Q7L string is set

/LZF:
T ra nsfe r Fo ld e r Info rma tio n: Transfer additional folder information such as modified,
created, accessed time and attributes. This option can diminish performance. 

A+ Enable comparing of Date accessed time (off by default)
U- Disable reporting of Updates
M- Disable reporting of Messages
M+ Enable reporting of Compare Matches to the Updated tab for debugging/analysis
D- Skip processing after each Directory scan
F- Skip processing after each File Copy (the parent folder is checked)
I- Skip processing after each Set Folder Info call (used for Enhanced Bi-Sync) and is

done after real-time / event folder adds (on by default)
E- Skip processing after Folder Renames (on by default)
G- Skip processing parent folder after File/Folder Deletes (on by default)
I+ Force processing after each Set Folder Info call (used for Enhanced Bi-Sync)
P+ Enable processing after each Security Permission check (off by default)
C+ Enable processing after certain Create Folder calls 
R- Not include the Root watch folder

Notes:
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1. Any arguments containing spaces must be enclosed by quotes. 

2. Some features described on this page require the Enhanced Package.

3. Command line arguments can also be identified through hints displayed on the Profiler. 

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will dis-
play both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:/ / www.peersoftware.com/ support/ submit-a-case.html.

6.  Real-Time Arguments

Re a l-T ime  Arg ume nts

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M). 

/GA:x
Se t Emp ty  File  De la y :  If the /GA argument is used, PeerSync will delay x milliseconds
before synchronizing empty (zero size) files that are detected in Real-Time.

/GB:x
Se t Sha d o w De te ctio n:  If the /GB argument is used, PeerSync will delay x milli-
seconds to synchronize subsequent updates of the same file during Real-Time.

/LA 
Re a l-time  Attrib ute  Cha ng e :  If the /LA argument is used, PeerSync will monitor attrib-
ute changes to files in Real-Time and use these changes as triggers for file synchroniza-
tion.

/LF
Use  Up d a te  Se ns itiv ity :  If the /LF argument is used, PeerSync will use the update sec-
tion of PSChangeNotify to detect file changes during real-time. 

Note: This feature is generally too sensitive, and will create multiple detections.

/LG
Fo ld e r Cha ng e  De te ctio n:  If the /LG argument is used, PeerSync will detect folder
changes, and in Enhanced Real-Time will force  the security description to be validated.
Any change to the folder will trig g e r a  sca n of the folder including its sub folders, so that
more CPU will be required. This option is not recommended for non-enhanced Real-Time.

/LG1
Fo ld e r ACL De te ctio n: If the /LG1 argument is used PeerSync will detect folder
changes, and in Enhanced Real-Time will force only  the ACLs and attributes to be valid-
ated.  Any change to the folder (i.e. file/folder adds or deletes) will force a comparison of
security descriptors and attributes.  This argument is more efficient then the /LG option
above because it will not perform a scan of the folder.  Use this argument if you wish to de-
tect and replicate ACLs in real-time for empty folders or folders that contain files for which in-
heritances has been disabled. Without the /LG1 argument PeerSync would need to perform
a scan in order to replicate the permissions for such folders.  

/LL

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/support/submit-a-case.html
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Disa b le  Re a l-time  Se curity  Cha ng e :  If the /LL argument is used, PeerSync will not
trigger updates in Real-Time when a file's security has changed. 

/LPC:x
Se t Ma ximum Numb e r o f Eve nts  to  Pro ce ss within e a ch Enha nce d  Re a l-T ime
Que ue  Che ck:  If the /LPC argument is used, PeerSync will set the maximum number of
events to process within each Enhanced Real-Time queue check to x events. The default
is 25 events and the minimum is 5 events.

/LPC:x+

Se t Ma ximum Numb e r o f Eve nts  to  Pro ce ss within e a ch Enha nce d  Re a l-T ime
Que ue  Che ck:  Adding the + argument PeerSync will process the events currently in the
list at the time of queue checking set by LPQ. 

Example: To queue events for 30 minutes (1800 seconds) and process them on that interval use the following
arguments: / LPQS1800 / LPC+

/LPD:x
Se t De la y  b e twe e n Enha nce d  Re a l-T ime  De le tio ns:  If the /LPD argument is used,
PeerSync will delay the deletion of files x milliseconds during Enhanced Real-Time. 

/LPE:x
Se t De la y  b e twe e n Enha nce d  Re a l-T ime  Eve nt Pro ce ss ing :  If the /LPE argu-
ment is used, PeerSync will delay the processing of each event x milliseconds. 

/LPM:x
Se t Enha nce d  Re a l-T ime  Eve nt Up p e r Limit:  If the /LPM argument is used, Peer-
Sync will set the maximum number of items x to allow in the Enhanced Real-Time event
queue before reverting to non-enhanced Real-Time. If this value is set to 0 then the option
is disabled (the default is 20000 events). If and when the Upper Limit is reached PeerSync
will clear all Enhanced Real-Time events that have not been processed and scan the dir-
ectories for changes. 

/LPW:x:y

Se t Enha nce d  Re a l-T ime  Eve nt Que ue  De la y :  If the /LPW argument is used, Peer-
Sync will set the number of items x in the enhanced real-time event queue to wait for before
processing, as well as, the maximum time to wait for to y milliseconds.

/LPQ:x
Se t De la y  b e twe e n Enha nce d  Re a l-T ime  Que ue  Che ck ing :  If the /LPQ argument
is used, PeerSyncwill delay x milliseconds before checking the Enhanced Real-Time
queue for new events.

/LPX:x
Se t Pro ce ss De la y  fo r Enha nce d  Re a l-time  Cha ng e s:  The /LPX argument allows
you to set the delay time for Enhanced Real-Time changes to be processed to x milli-
seconds. This value will be applied directly for adds and updates and will be multiplied by
3 for deletions. The default is 1000 milliseconds for adds/updates and 3000 milliseconds
for deletions 

/YK:n
Se t Re a l-time  Co p y T hre a d  Po o l:  Used to set the percentage of copy threads to re-
serve for Real-Time events, where n can be set between the values of 1 and 99. The de-
fault value is 10 percent.

/QR
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Re a l-T ime  Glo b a l Exc lus io ns: Use this argument when you want to exclude real-time
events earlier in the process and throw the events away. This argument will not log/report
the exclusions. Improves performance when a high amount of events need to be excluded.

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Some features described on this page require the Enhanced Package. 

3. Command line arguments can also be identified through hints displayed on the Profiler. 

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will dis-
play both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:/ / www.peersoftware.com/ support/ submit-a-case.html.

7.  Managed Files Arguments

Ma na g e d  File s  Arg ume nts

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M). 

/QD
Alwa ys Use  Pa rtia l Lo cke d  File  Exte ns io ns Lis t fo r VSS:  If the /QD argument is
used, any file that is in the Partial Locked File Extension List (default: .pst files) will always
be synchronized using VSS without scanning the file for partial locks. 

Note: Please refer to the / YF argument for more detail on the Partial Locked File Extensions List. 

/GY:x 
VSS Inte rva l:  The /GY argument is used to set the interval to try open and locked files
via E The Default is every 2 hours and the minimum value is every 30 minutes.

Note: This item is selectable from the Profiler via the Options/ Commands Screen.

/YY:n
Se t VSS T ry  Co unt: This argument is used to set the amount of times n to try and lock
down a drive for full access via VSS during each cycle. The default is 5 times.

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. All features described on this page require the VSS add-on module.

3. Command line arguments can also be identified through hints displayed on the Profiler. 

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will dis-
play both a description of the feature as well as its related command line argument (if any).

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/support/submit-a-case.html
http://www.peersoftware.com/products/recommended_options/vss.aspx
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5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:/ / www.peersoftware.com/ support/ submit-a-case.html.

8.  Bi-directional Arguments

Bi-D ire c tio na l Arg ume nts

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M). 

/GV 
Alwa ys Cre a te  Sup e rse t d uring  Bi-d ire c tio na l Synchro niza tio n:  If the /GV argu-
ment is used, PeerSync will not use the TLR value, and therefore always create a superset
of data during a bi-directional synchronization.

Note: This item is selectable from the Profiler via the Options/ Commands Screen.

/GW 
Ena b le  T e mp  File s :  If the /GW argument is used, PeerSync will enable the use of tem-
porary files during file/folder renames and deletes. This is useful during 'Real-time Bi-Direc-
tional Synchronization' in order to prevent oscillation. 

/LB 
Bi-d ire c tio na l Fo ld e r De le tio n:  If the /LB argument is used, PeerSync will delete
folders that have been deleted from Target or  Source during bi-directional scans.

/LC 
Use  La st Acce ss File  T ime :  If the /LC argument is used, PeerSync will always use last
access file time for bi-directional synchronization.

/LD [  M | A | T  | R  ]
Se t T rig g e r Fo ld e r File  Na me :  If the /LD argument is used, PeerSync will set en-
hanced bi-directional synchronization trigger folder filename extension to:

M Use machine name as extension
A Use LastAccessTime for TLR comparison
T Use "~FLDR" extension in place of TLR
R Reset/Delete all trigger folder-files

/LE
Use  Enha nce d  b i-d ire c tio na l synchro niza tio n mo d e :  The /LE argument is equi-
valent to /LDMAT  mode. This will alter the way the bi-directional synchronization option
functions by using enhanced features to track all file and folder adds, updates, deletions,
renames and moves between scan cycles. In this mode PeerSync will use a hidden sys-
tem trigger file within each sub-folder to store information about the last scan cycle for that
sub-folder. Using this trigger file PeerSync can determine if a Folder was added, deleted,
renamed or moved since the last scan.

Note: This item is selectable from the Profiler via the Options/ Commands Screen.

/YO- 
Re ta in La st Acce ss T ime  fo r T wo  Ma chine  b i-d ire c tio na l synchro niza tio n: 
The /YO- argument will store the original Last Access time of the Source File before syn-
chronization and then it will set the Source and Target files' Last Access Times with the

http://www.peersoftware.com/support/submit-a-case.html
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stored time after a file add or update. This will allow bi-directional scans between two ma-
chines to properly track file adds then subsequent file deletes within the next scan cycle.

Notes:

1. When using standard or enhanced bi-directional synchronization we recommend adding / YO- as well
as / QYD:0 to your list of command line arguments to ensure deleted files from one side are not re-added
by the other side.   

2. The / YO- argument should NOT be used if there are more than two machines involved in a bi-direc-
tional synchronization due to the need of the Last Access Time to be used by the third, fourth etc. ma-
chine during comparison with either of the other two machines.

/QYD:n
Se t Sa fe ty  Va lue  fo r La st Run T ime : By default PeerSync uses /QYD:5 during stand-
ard or enhanced bi-directional synchronization. With this option enabled deletion events
are programmatically delayed by approximately 10 seconds to account for any time differ-
ences between machines. This can be problematic when performing standard or en-
hanced bi-directional synchronization where a deleted file from one side can be re-added
by the other. In this scenario we recommend using /QYD:0 which represents a safety value
of 0 seconds for deletions. 

n = 0 safety value = 0 seconds
n = 1 safety value = approximately 2 seconds
n = 2 safety value = approximately 4 seconds
...
n = 5 safety value = approximately 10 seconds

Note: When using standard or enhanced bi-directional synchronization we recommend adding / QYD:0 as
well as / YO- to your list of command line arguments to ensure deleted files from one side are not re-added
by the other side.   

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Some features described on this page require the Enhanced Package.

3. Command line arguments can also be identified through hints displayed on the Profiler. 

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will dis-
play both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:/ / www.peersoftware.com/ support/ submit-a-case.html.

Other Components

1.  PeerSync Status Display

Sta tus  D isp la y  Scre e n

This screen is used to view Current Profile Activity within the PeerSync application. The
Status Display window can only be viewed when PeerSync is running as an Application
and not as a Service. Enable the "Display status in PeerSync" option available in the Op-

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
http://www.peersoftware.com/support/submit-a-case.html
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tions/Commands > Display Options... dialog to have the Status Display show automatically
at the start/launch of PeerSync or right-click on the Tray Icon and select "Show Status Dis-
play". 

Pro file Displays the name of the Profile actively being processed.
This label may not match the name of the Profile currently be-
ing configured through Profiler.

Jo b This indicator will dynamically display the name of whichever
Job is presently being processed for the Active Profile.

Mo d e Displays the Operation Mode (Real-time Mode, Scheduled
Operation, etc.) applied to synchronization of the Active Profile. 

So urce Displays a file path for the Source Folder presently being syn-
chronized.

T a rg e t Displays a file path for the Target Folder presently being syn-
chronized from the Source indicated above.   

Fo ld e rs This indicator provides a count of all unsynchronized folders
contained within the Source, and will decrease as each folder
is synchronized. An additional "thermometer" indicator will also
track the progress of folder synchronization.

File s This indicator displays the total number of files contained within
the Source while also providing a count of synchronized files. In
addition, a "thermometer" indicator will show file synchroniza-
tion progress by increasing according to the size of the current
folder, with 100% representing the cumulative size of files con-
tained within the Source Job set.

File Indicates the name of the file currently being synchronized.

La rg e  File  o r Co m-
p re ss io n Sta tus

This caption will be displayed to the right of the file name that is
currently synchronized for large files and during compression.
The caption will show the size of the file that has been copied to
the Target and/or compression status.

Sk ip  File This button will appear once the active Profile has been
launched. This feature allows you to skip synchronization of the
file currently displayed in the indicator described below. Skip
Files enables you to avoid delays caused by large files on
slow network or dial-up connections.

Size Indicates the size (in bytes) of the file currently being synchron-
ized. A related "thermometer" indicator tracks the progress of
synchronization for that file.

Che cke d This indicator displays the total number of files contained in the
selected Source Folders. 

Exc lud e d Indicates the number of files that were excluded from synchron-
ization (See Exceptions). 

Me ssa g e s Indicates the number of error messages generated during Pro-
file processing. 
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Up d a te d Indicates the number of Target Files that were updated during
synchronization of Profile Jobs. 

Ad d e d Indicates the number of new files added to Target Folders dur-
ing synchronization of Profile Jobs. 

De le te d Indicates the number of files deleted (or moved) during syn-
chronization of Profile Jobs. 

T a rg e t Sp a ce Indicates the Target Folder space remaining during synchron-
ization of Profile Jobs. 

Ela p se d  T ime Indicates the amount of time that has elapsed during the current
Profile activity.

H id e Will hide this display, which can be re-accessed via the Tray
Icon Men.

Quit Allows you to close/exit the current session of PeerSync.

Othe r Scre e n Fe a ture s

Pro ce sse d  Lis ts The Updated, Added, Deletions and Excluded screens will
display statistical information in the above format. Each screen
will have statistical information (File Name, Size, Modified
Date/Time, Path, Duration, etc.) about the changes that have
occurred during the current PeerSync session.

Ite m Co unt Display of the amount of changes that have occurred for the
current screen.

Ma ximum Lis t Size Allows you to select the maximum amount of changes that you
wish to store for the current screen. It is recommended to keep
this value low because each entry requires memory to be used
by PeerSync.

Sta tus  D isp la y  Po p up  Me nu

Activated by right clicking on the PeerSync Status Display. The Status Display window can
only be viewed when PeerSync is running as an Application and not as a Service. Enable
the "Display status in PeerSync" option available in the Options/Commands > Display Op-
tions... dialog to have the Status Display show automatically at the start/launch of PeerSync
or right-click on the Tray Icon and select "Show Status Display". 

Vie w Lo g  File   Allows you to access, launch and view Log files in the default
text editor for the current Profile.

Vie w Ad min Fo ld e r Allows you to access, launch and view Admin log file Folders in
Explorer for the current Profile.

Op e n So urce  Fo ld e r Allows you to access, launch and view Source Folders in Ex-
plorer for the current Profile.
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Vie w T a rg e t Fo ld e r Allows you to access, launch and view Target Folders in Ex-
plorer for the current Profile.

Print Allows you to print the current screen information.

Sa ve  As Allows you to save the current screen information to file.

Cle a r Lis t Allows you to clear/reset the current screen information.

Re -Lo a d  Pro file Allows you to re-load the current Profile if any changes have
occurred.

Ab o ut Pe e rSync Will display an about screen, that contains information about
the current PeerSync you are running.

Quit Allows you to close/exit the current session of PeerSync.

2.  PeerSync Remote Control

Pe e rSync Re mo te  Co ntro l Scre e n Fe a ture s

This feature allows you to connect to and monitor any PeerSync currently running on your
LAN. Including PeerSync running as an application or a service on the local machine
and/or any instances of PeerSync running on any machine that is accessible from the local
machine. 

Pro file  Se le c tio n The field located to the left of the Add Button. This field is used
to add a Profile to the Profile Selection List. The format for a
Profile selection is: MACHINENAME:PROFILENAME (i.e.
DELLSERVER:Profile.snc).

Pro file  Se le c tio n Lis t The list located below the Profile Selection, which contains Pro-
file Selections that can be connected to and monitored by se-
lecting the item and using the Connect button.

Ad d This button will add the current Profile Selection to the Profile
Selection List.

Co nne ct This button will connect to the current Profile Selection and dis-
play its activity on the screen.

D isco nne ct This button will disconnect the current Profile Selection and
stop the display of activity.

Re fre sh This button will refresh the current Profile Selection activity.

Pa use /Re sume This button will pause/resume the current Profile that is selec-
ted.

Que ry This button will search for and add all Profiles that can be found
to the Profile Selection List.

Cle a r Lis t This button will clear out all entries from the Profile Selection
List.

Re mo te  Co nne ctio n
Info rma tio n

Displays the computer, user and last response for the current
connection. 
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Clo se This button will close this dialog.

Note: The features described on this page require the Enhanced Package. 

3.  Quick-Sync

This feature is a quick and easy way to synchronize folder(s) on the fly to backup location(s)
with the option to modify your Job settings at a later time. 

Simply right click on any folder you wish to sync and select "Quick-Sync Folder...".  This will
launch the Wizard, which will ask you to select a Target Folder to sync to...and your ready to
run the Quick-Sync. You also have the options to edit and/or add the current sync Job to your
Quick-Sync Profile or any other selected Profile. Then the next time you select a folder if it
matches any Source or Target selection in the Quick-Sync Profile the Jobs will be listed to
pick from or you have the option to add a new Job. 

http://www.peersoftware.com/products/recommended_options/enhanced_package.aspx
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Run Time)     147

/QH (Force  Flush File Buffers)     147

/QHD (Direct Disk Write)     147

/QI (Ignore Matching/Locked File Extensions)     147

/QJ (Ignore Matching/Locked File Postfix
Replacement)     147

/QP (Disable Job Stats)     143

/QP (Don't Display Job Stats)     140
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Active Job     159

Active Profile List     159

Add  Jobs with Wizard     13

Add - synchronize new files to target     69

Add Jobs     13

Add Quick-Sync Folder option to Explorer menu    
120

Add Shares with the selected Prefix     104

Add Shares with the selected Suffix     104

Add Shares: Do Not Update or Delete     104

Add to Windows registry     120

Add to Windows StartUp     120

Add/Delete/Modify Jobs:  Tool Buttons     13, 26

Added Files Reporting Feature     95
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Additional Features     32, 88
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Additional Options     88

Enable  file recovery     88

Perform binary comparison on all files (using
CRC32)     89

Replace in-use files upon reboot     82, 88
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Additional File Includes     77

Additional Folder Selection Features     59, 88
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Additional/Alternate Target Paths     58

Admin Backup     105

Admin Report Cycle Options     98

Admin Reporting     32, 97

Admin Reporting Features     98

Admin Reporting Screen:     97, 98

Admin Reporting Overview     97
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Report File Path     98

Use error information only     98
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Administrative report file storage  manipulation and
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Advanced Options     32, 104, 105
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99, 102
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target     89

Allow for remote real-time configuration - NetApp
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Alternate Configuration File     136
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Alternate Target Path Selection Dialog     58

Alternate/Additional Target Paths     58

Always create a super-set during bi-directional
synchronization     110

Always Create Superset during Bi-directional Sync    
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Always Run Post Process     147

Always Use Partial Locked File Extensions List For
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Always use the local machine time for the Last Run
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    117
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Argument Selection     111
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Arguments     111
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At the start of this Profile     99

At the stop of this Profile     99

Attach log file to messages     100

Attribute Exceptions     94
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configuration     44

Automatically use recommended settings based on
Detection Method     43
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Automation Command Line Arguments:     144
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Daily Timer     144

Delay Scan at Start     144

Device Driver method     144

Disable Initial Synchronization During Startup    
144

Interval     144

Keyboard Activity     144
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Automation Command Line Arguments:     144

Real time Monitoring Argument     144

Run Scheduled Operation     144

Scan at Start     144

Synchronization Timer Argument     144

Synchronization Timer Argument with Keyboard
Activity     144

Timer Argument     144

Use Device Driver method     144

Automation Features     63

Automation Screen:     63

Activate real-time monitoring     63

Automation Screen Overview     63

Daily Timer Options     63

Run at specific times and selected days     63
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- B -
Back Button     13
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Bi-directional Folder Deletion     158

Enable Temp Files     158

Retain Last Access Time     158

Set Safety Value for Last Run Time     158

Set Trigger Folder File Name     158
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mode     158

Use Last Access File Time     158

Bi-directional Folder Deletion     158

bi-directional synchronization     69

bi-directional synchronziation     86

Binary Comparison     89

Bi-Sync Options Button     111

blackout     67

Blackout Settings     32, 67

Block Size Selection     82

Buffer Size - File Read/Write     80
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Buttons     13

Byte Replicator     32

ByteReplicator     82

Block Size Selection     82

Excluded File Types     82
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Port     82

Time Out     82
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cDOT Options - Global:     45

Asynchronous Mode     45

Disable Alternate Share Lookup     45

Changing Profile Job List Window     26

Check for ACL changes during scans     109

Checked Indicator     159

Choose external applications/scripts to be run before
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CIFS - Permissions     48

CIFS - Scan Method     48

CIFS/NFS Security Style     77

Clear List     159

Clear Log File     95

collect real-time events     67

Command Line Argument Selection     111

Command Line Argument Selection from the Interface
    112, 115

Command Line Arguments     112, 115, 135

Compare and Set File Attributes from Windows to
NetApp     147

Compare Time Change     89

Compression - TCP Target     56

Compression Status     159

Computer Name Variable     59

Configuration Command Line Arguments:     136

Alternate Configuration File     136

Load Alternate Configuration File     136

Set SNC File to Load     136

Set Source Path     136

SNC File     136

Use Arguments from Profile     136

Configuration Entries     6

Configure - NFS Settings     74

Configure Normal Source Folder     51

Configure Normal Target Folder     57

Configure TCP Source Folder     52

Configure TCP Target Folder     58

Connect As - Network Logon Setting     46
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Connect to and monitor any PeerSync currently
running on your LAN     162

Connection Manager    

Only include connections that are set for real-time
monitoring     43

Scan real-time Jobs on reconnect if "Scan Job
once at start" is enabled     43

Connection Manger for Failed Connections - Source
Folder:     43

Disabled     43

Enabled for Source and Target Connections     43

Enabled for Source Connections Only     43

Enabled for Target Connections Only     43

Convert to GMT for comparison purposes     89

Copy File Method - Global:     48

Admin Backup     48

Advanced Backup     48

Advanced Backup with Permissions     48

CIFS - CopyFile API - /GFC Argument     48

CIFS - CopyFileEx API - /GFE Argument     48

CIFS - Default     48

CIFS - File Stream Method - /GFS Argument    
48

NFS - Unix/Linux cp command     48

NFS - Unix/Linux rsync command     48

Copy Jobs     13

Copy Thread Utilization     137

Copy Threads     108, 137

Copyright     3

CRC32     89

Create a report for every event     98

Create a report on an interval     98

Create a report once a day     98

Create a report once a week     98

Create administrative Email messages     99

Create administrative report files     98

Create and Append Summaries into One Report    
140

Create Email messages     99

Create Normal Souce Auto Job Name     51

Create Normal Target Auto Job Name     57

Create Pre Sync Report     26

Create Shortcut on Desktop     120

Create SNC extension association for Profiler     120

Create Source Folder     35

Create Target Folder     52

Create Target TCP Auto Job Name     58

Create TCP Source Auto Job Name     52

Current Arguments     111

Current Arguments Button     111

Current Attributes     94

Current Command Line Argument Selection     106,
111
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Customized View     30
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Daily Timer     144

Daily Timer Options     63

Date variables for Folder Paths     59

Date/Time Variable     59

Dates Exceptions     94

Day variables for Folder Paths     59

Days of the week scheduling     63

Default inclusion     90

Default Read/Write Buffer Size     80

Delay between Enhanced Real-Time Deletions     155

Delay between Enhanced Real-Time Event Processing
    155

Delay between Enhanced Real-Time Queue Checking
    155

Delay Scan at Start     144

Delayed Write Failed     147

Delete 7-Mode FPolicy     50

Delete Empty Source Folders After Move     147

Delete fPolicy on Close - NetApp Settings     44

Delete Jobs     13

Delete log file after successful send     100

Delete Unmatched Target Files     71, 72

Delete unmatched target files older than x days     72

Deleted file storage  manipulation and organization    
59

Deleted Indicator     159

Deletion Folder     72

Deletion Options     71, 72

Deletion Options Button     71, 72

Destination IP     97

Detection Method Options:     40

Allow for remote real-time configuration     40

Exclude Users     40

Detection Method:     40

Default     40

EMC CEE Celerra/VNX     40

EMC CEE Isilon     40

NetApp FPolicy 7-Mode     40

NetApp FPolicy cDOT     40
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Device Driver method     144

Disable all Startup Options     120

Disable Alternate Share Lookup - cDOT Options     45

Disable application associated with sync     147

Disable cDOT FPolicy     50

Disable Failed Connection Timer     147

Disable Initial Synchronization During Startup     144

Disable Install Reboot     6

Disable Jobs that are Not Configured from this Profiler
    118

Disable Real-time Security Change     155

Disabled - Connection Manager     43

Display status in PeerSync     140

Display status in PeerSync upon completion     140

Dissimilar time zone synchronization     89

Distribution     3

Do Not Validate Connections Before Profile is Loaded
    147

Drag and Drop Source Folder Selection     35

Drag and Drop Target Folder Selection     52

Drive Mapping     62

During comparison subtract/add x minute(s) from
target     89

Dynamic  Network  Drive Mapping and Un-mapping    
62

Dynamic archives     59

Dynamic synchronization based on date     59

Dynamic synchronization based on logged on user or
machine name     59

Dynamic synchronization based on personal folders or
other variables read in from the registry     59

- E -
Easy way to synchronize folders on the fly     163

Edit Job Groups Dialog     29

Edit Menu     17

Edit Normal Source Variable File     51

Edit Normal Target Variable File     57

Elapsed Time Indicator     159

Email Report Cycle Options     101

Email reporting     99

E-mail Reporting     32

Email Reporting Features     99

Email Reporting Overview     99

Email Reporting Screen:     99, 100

Attach log file to messages     100

Create administrative Email messages     99

Delete log file after successful send     100

Report file name - Email Reporting     100

Use error information only     100

Use standard report file content     100

Use summary information only     100

Email Threads     137

Embedded Open File Manager     69

EMC Celerra/Isilon Settings     47

EMC Celerra/VNX Settings     46

Enable CIFS Screening     41

Enable file recovery     88

Enable intelligent network load balancing     80

Enable intelligent network load balancing (when
applicable)     80

Enable Last Access Compare     147

Enable NFS Extended Reporting and Display -
Permissions     48

Enable NFSv3 Screening     41

Enable NFSv4 Screening     41

Enable PSObserver Broadcasts     140

Enable SNMP Error Reporting     140

Enable Summary Statistics Collection     140

Enable Temp Files     158

Enabled for Source and Target Connections -
Connection Manager     43

Enabled for Source Connections Only - Connection
Manager     43

Enabled for Target Connections Only - Connection
Manager     43

Encryption - TCP Target     56

Enhanced real-time     63

Enhanced Real-Time Event Queue Delay     155

Enhanced Real-Time Event Upper Limit     155

Enhanced Scan Processing     64

Error Reporting     140

Evaluating a new version of PeerSync     11

Evaluation Menu     24

Event Options     71

Exception Screen Features     90

Exceptions     32, 90

Exceptions Screen:    

Exceptions Screen Overview     90

Exclude Files by Character/String/Extension     91

Exclude Files from Sync by Size     94

Exclude Files in Sync by Attribute     94

Excluding Folders from Sync     93

Include File Types (using wild cards)     90

Include Files in Sync by Attribute     94

Include Files in Sync by Date     94
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Exclude all open files until closed     78

Exclude Extensions - NetApp fPolicy     42

Exclude Extensions - NetApp Settings     44

Exclude File Sizes     94

Exclude Files     91

Exclude Files Button     91

Exclude Folders     93

Exclude Folders Button     93

Exclude Folders drop down list     93

Exclude Folders that have a Reparse Point     147

Exclude IP Address - NetApp fPolicy     42

Exclude IP Address - NetApp Settings     44

Exclude open files     78

Exclude open files (allow read access to source file
during transfer)     78

Exclude open files (deny all access to source file
during transfer)     78

Exclude root folders     93

Exclude specific folders only     93

Exclude Users - NetApp fPolicy     42

Exclude Volumes - NetApp Settings     44

Excluded Indicator     159

Exclusion drop down list     91

Exclusive Remedy     3

Executable Path (PeerLock)     122

Executable Path (PeerSync)     120

Explore Source Folder     35

Explore Target Folder     52

- F -
Failed connection     106

Failed Registration     8

FastSync Settings     116

Features     88

File Date Reporting Feature     95

File Dates     94

File Deletion Options     71, 72

File Exclusions     82

File Folder Path Variables     59

File Indicator     159

File Menu     16

File Options     32, 69

File Options Features     69

File Options Screen:     69, 71, 72

Add - synchronize new files to target     69

Avoiding Permanent Deletion     71, 72

Delete Unmatched Target Files     71, 72

Delete Unmatched: Options     71, 72

Deletion Warning Message     71, 72

Mode Selection     69

Replicate - Delete unmatched files/folders     69

Update - synchronize existing files in target     69

Use Windows Recycle Bin     71, 72

File Path Variables     59

File Path Variables:  Folder Selection     59

File Read/Write Buffer Size     80

File Recovery     88

File Size Reporting Feature     95

File Sizes     94

File Time Change Options     88

File Time Reporting Feature     95

File Versions     84

File/Folder Permission Options:     76

Global Settings     76

NTFS Options     76

Transfer File and Folder Permissions     76

Files Indicator     159

Folder ACL Detection     155

Folder Change Detection     155

Folder Creation Reporting Feature     95

Folder Names Reporting Feature     95

Folder Queue Watch Interval     147

Folder Restoration feature in real-time     63

Folder Selection     32

Folder Selection Features     35

Folder Selection Screen:     35

File Path Variables     59

Folder Selection Screen Overview     35

Source Folder Selection     35

Target Folder Selection     52

Folders Indicator     159

For each individual error message as it occurs     99

for each message/error as it occurs     102

Force  Flush File Buffers     147

Force Source Folder Root as Target TCP Folder Root  
  58

fPolicy Name - NetApp Settings     44

FPolicy Utility Features:     50

Delete 7-Mode FPolicy     50

Disable cDOT FPolicy     50

- G -
General     3

Get Info - cDOT Options     45
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Get Info - System Information for Source Host     46

Get Remote PC Time     147

Global ACL Options     109

Global Advanced File Xfer Options     104, 105

Global bi-directional Options     106, 110

Global Display Options - Profiler Options     112

Global Managed Files Options     106

Global Migrate Shares Options     104, 105

Global Options     118

Global Recovery/Offline Options     106

Global Settings - Permission Options     76

Global Settings (PeerLock):     118

Disable Jobs that are Not Configured from this
Profiler     118

Global Options     118

Link this Profiler to PeerLock     118

Save Changes in PeerLock     118

Show PeerLock     118

Global Settings (PeerSync):     106, 108, 109, 110,
111, 115

Global VSS Options     106

Greater Than File Size Exclusion     94

- H -
H+ (Skip setting of main form visible)     140

Help Button     13

Help Menu     22

Hide     159

Hide Splash Screen     140

Host Name     55

Host Server Name - NetApp Settings     44

Hour variables for Folder Paths     59

- I -
Ignore File Size and/or Date Comparison     147

Ignore Matching/Locked File Extensions     147

Ignore Matching/Locked File Postfix Replacement    
147

Ignore Open File Extensions     147

Ignore Target Space During File Copy     147

Improve Load Balancing     80

Include all open files     78

Include attribute change as synchronization criteria    
87

Include Files     90

Include Files Button     90

Include open files     78

Include open files (allow read & write access to source
file during transfer)     78

Include open files (allow read access to source file
during transfer)     78

Include open files (if possible)     77

Include partially open files     78

Include Shares - cDOT Options     45

Include Sub foldersFolder Selection Screen:    

Include Source Sub-Folders     35

Include this Job in PeerLock     117

Include Volumes - NetApp Settings     44

Inclusion drop down list     90

Information Required to Register software     8

initiate scan on trigger file change     68

Initiate Synchronization on Source or Target
File/Folder Change     63

Install Options     6

Install Service (PeerLock)     122

Install Service (PeerSync)     120

INSTALL.LOG     6

Installation (Silent Install)     6

Installation Configuration Options     6

Installing PeerSync     6

Intelligent Network Load Balancing     80

Intermediate View     30

Interval     144

Intervals Button     106

IP Address - NFS Settings     74

Item Count     159

- J -
job data import     62

Job Indicator     159

Job Menu     21

Job Scan Method - Global:     48

CIFS - Default     48

NFS - Unix/Linux rsync command     48

Job Settings (PeerSync):     32, 35, 63, 67, 68, 69, 77,
79, 80, 82, 84, 85, 88, 90, 95, 97, 99, 103

Job Settings PeerLock:     117

Append Default File/Folder Exclusions from
PeerLock     117

Include this Job in PeerLock     117

Job Threads     108, 137

Jobs     12, 162
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- K -
Keep backup files of overwritten Target Files     84

Keep files in Alternate Folder     84

Keep files in Deletion Folder     84

Keep files in Target Folder     84

Keep multiple versions of files     84

Keyboard Activity     144

- L -
Large File or Compression Status     159

Last Run On     59

Last Run On - Reset     26

Last Run On Feature     26

Last Save     59

Last Scan     59

Launch (PeerLock)     131, 132

Launch (PeerSync)     124, 126

Launch Current Profile     13

Left side Panel - Selection Tree     30

Less Than File Size Exclusion     94

License     3

License File     6

Limit CPU usage during file transfers     137

Limit number of processors to use     137

Limit system resources during file transfers     137

Limitations of Liability     3

Limited Warranty     3

Link this Profiler to PeerLock     118

List of Exclude Files (using sub strings)     26, 91

List of Exclude Folders     93

List of Include File Types (using wild cards)     90

List of Job Selections - Daily Timer     63

Load Alternate Configuration File     136

Load Balancing     80

Log File - Clear     26

Log File - View     26

Log file storage/manipulation/organization     59

Log Files:  Administrative     97

Log Messages by Filter     140

Log Messages by Profile     140

Log Messages Only to a Log File by Filter     140

Log Messages Only to a Log File by Filter and/or by
Profile     140

Log Messages Only to a Log File by Profile     140

Log Service Events to the Event Viewer     140

loopback     35, 52

- M -
Managed Files     32, 79

Managed Files Arguments:     157

Always Use Partial Locked File Extensions List
For VSS     157

Set VSS Base Timeout     157

Set VSS Try Count     157

VSS Interval     157

Management IP - cDOT Options     45

Match Shares: Add, Update and Delete     104

Maximize Speed     80

maximum duration of scans     68

Maximum List Size     159

Maximum Log File Size     96

Maximum Number of Events to Process     155

Menu (PeerSync):    

Edit     17

Evaluation     24

File     16

Help     22

Job     21

Options     18

PeerSync Tray Icon PopUp Menu     25

Run     19

View     17

View Popup Menu     25

Messages Indicator     159

Messages Reporting Feature     95

Migrate Shares     104

Minute variables for Folder Paths     59

Miscellaneous     32, 85

Mode Indicator     159

Mode Selection     69

Modify NFS Default Options:     75

NFS mount Options     75

NFS rsync Options     75

Monitor ACL changes during real-time     109

Monitor PeerSync activity across the LAN     162

Monitor Remote Instances of PeerSync     162

Month variables for Folder Paths     59

Mount Folders - NFS Settings     74

Move Files     86, 147

Move Job Down     13

Move Job Up     13
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MS Windows Explorer Add On - Quick-Sync     163

MSMQ messaging     140

Multiple Copy Threads     108

Multiple Job Threads     108

- N -
Naming and Renaming Jobs     26

NetApp FPolicy - Source Folder NetApp Settings    
44

NetApp FPolicy 7Mode     40

NetApp FPolicy Additional Settings:     44

Exclude Extensions     44

Exclude IP Address     44

Exclude Volumes     44

Include Volumes     44

NetApp FPolicy cDOT     40

NetApp FPolicy cDOT Additional Settings:     45

Include Shares     45

Management IP     45

Primary Server     45

NetApp FPolicy cDOT SVM Logon Settings:     45

Password     45

Username     45

NetApp FPolicy Screening Options:     40

Enable CIFS Screening     40

Enable NFSv3 Screening     40

Enable NFSv4 Screening     40

NetApp Settings :    

Delete fPolicy on Close     44

fPolicy Name     44

Host Server Name     44

Root Path Prefix     44

Use Asynchronous Mode     44

Use cDOT Detection     44

NetApp Settings:     44

Network Constant - TCP Target     55

Network Drive Mapping     62

Network License     3

Network Load Balancing     80

Network Logon Settings:     46

Connect As     46

Password     46

New Profile     13

Next Button     13

NFS - Permissions     48

NFS - Scan Method     48

NFS mount Options     75

NFS Replication     147

NFS rsync Options     75

NFS Settings     32

NFS Settings Screen:     74

Configure     74

IP Address     74

Mount Folders     74

Password     74

Unmount Folders     74

User Name     74

No not delete folders     147

Non Persistent Processes     26

Normal     40

Normal Source     35

Normal Source Mode Selection     40

Normal Source PopUp     51

Normal Target     52

Normal Target Mode Selection     54

Normal Target PopUp     57

NTFS Options     76

Number of backup files to keep     84

- O -
Only Hide the about screen     140

Only use Advanced Settings     98, 101

Open File Manger Options     69

Open File Options     69

Open Files     32, 77, 78, 112, 115

Open Profile     13

Open Source Folder     35, 159

Open Target Folder     52

Open/Locked Files     77

Optimize Performance     137

Optimize speed     80

Options Menu     18

Options/Commands     32, 112, 115, 159

Options/Commands Features     112, 115

Options/Commands Overview     112, 115

Options/Commands Screen:     111, 112, 115

Current Arguments     111

Current Arguments Button     111

Overview     112, 115

Set Access Password     112, 115

Show tray icon     112, 115

Other Global Options/Command     106

Overview     12, 162

Overwrite Existing Log File     95
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Overwrite existing Pre-Sync report file     111

- P -
Parameter Selection from Profiler     111

Partial Locked File Extensions List     147

Password - Network Logon Setting     46

Password - NFS Settings     74

Password - Registration     8

Password - TCP Target     56

Password for Tray Icon     112, 115

Passwords - cDOT Options     45

Path (PeerLock)     122

Path (PeerSync)     120

Path to Host     55

Path to Host - TCP Target     55

pause scan during specific times     67

Pause Service (PeerLock)     131, 132

Pause Service (PeerSync)     124, 126

PeerLock Selection Tree Category     30

PeerLock Service:     131, 132

Launch PeerLock     131, 132

Pause Service     131, 132

Resume Service     131, 132

Run as a service     131, 132

Start Service/Application     131, 132

Stop Service/Application     131, 132

PeerSync Command Line Arguments     135

PeerSync Global Settings     32

PeerSync Installation     6

PeerSync Remote Control     162

PeerSync Selection Tree Category     30

PeerSync Service:     124, 126

In Sync     126

Launch PeerSync     124, 126

Pause Service     124, 126

Resume Service     124, 126

Run as a service     124, 126

Start Service/Application     124, 126

Stop Service/Application     124, 126

Trending     126

PeerSync Status Display     159

PeerSync Status Display Popup Menu     159

PeerSync Temp Folder     6

peersync_architecture_version.exe     6

PeerSync94.lic file     6

Perform binary comparison on all files (using CRC32)  
  89

Performance     32, 80

Performance - Threads     108

Performance Command Line Options:     137

Affinity     137

Application Priority     137

Copy Thread Utilization     137

Copy Threads     137

Email Threads     137

Job Threads     137

Limit CPU usage during file transfers     137

Limit number of processors to use     137

Limit system resources during file transfers     137

Optimize Performance     137

Priority     137

Processor Affinity     137

Set Application Priority     137

Set Copy Threads     137

Set Email Threads     137

Set File Read/Write Buffer Delay     137

Set Multitasking Delay     137

Set Processor Affinity     137

Set Real-time Copy Thread Pool     137

Set Shared Process Delay     137

Set the percentage of copy threads to reserve for
real-time events     137

Shared Process Delay     137

Thread Utilization     137

Threads     137

Performance Features     80

Performance Options All Jobs     112, 115

Performance Package     108, 112, 115

Performance Priority Selection     108

Performance Screen:     80

Enable intelligent network load balancing (when
applicable)     80

File Read/Write Buffer Size     80

Set maximum number of copy threads to x     80

Throttle bandwidth - Use x percent of available
bandwidth     80

Permissions     32

Permissions (Security style) - Global:     48

CIFS - Default (NTFS)     48

Enable NFS Extended Reporting and Display    
48

NFS - Unix/Linux down and chmod commands
(UNIX)     48

Pop Up Menu: Profile Job List     26, 30

Pop Up Menu: Selection Tree     30

Port - Email Reporting     100
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Port - TCP Target     56

Port Configuration     82

Post Installation Configuration Options     6

Post process application     103

Pre Installation Configuration Options     6

Pre process application     103

Pre/Post Features     103

Pre/Post Overview     103

Pre/Post Process     32, 103

Pre/Post Process Overview     103

Pre/Post Process Screen:     103

Select Application/Script to Run After     103

Select Application/Script to Run Before     103

Use maximum wait time of x seconds     103

Wait for application to end before continuing    
103

Preserve Paths     71, 72

Pre-Sync Report Options     111

pricing information     8

Primary Server - cDOT Options     45

Print     159

Priority     137

Priority Selection     108

Process Delay for Enhanced Real-time Changes    
155

Process Migrate Shares after each scan     105

Process Migrate Shares every x minute(s)     105

Processed Lists     159

Processor Affinity     137

Product Definitions     12, 162

Product Support     12, 162

Product Updates     8

Profile Description:     16

Default Description     16

Hiding Profile Description Toolbar     16

Moving Profile Description Toolbar     16

Profile Indicator     159

Profile Job List Pop Up Menu     26

Profile Job List:     26

Add/Delete/Modify Jobs     26

Changing Size of Window     26

Naming and Renaming Jobs     26

Selecting Jobs and Multiple Jobs     26

Profile Options: Customize     30

Profile Options: Show All     30

Profile Selection     162

Profile Selection List     162

Profiler     12, 162

Profiler Command Line Arguments     135

Profiles     12, 162

PSDef.CFG     6

PSError.log     95, 96

PSObserver Broadcasts     140

- Q -
Quantity Discounts     8

Quick-Sync     163

Quick-Sync Folder     163

Quick-Sync Profile     163

Quit     159

- R -
Real time File Folder Change Detection     63

Real Time Mode     12, 162

Real time Monitoring Argument     144

Real Time Options     65

Real-time Attribute Change     155

Real-Time Command Line Arguments:     155

Disable Real-time Security Change     155

Folder ACL Detection     155

Folder Change Detection     155

NFS Replication     155

Real-time Attribute Change     155

Set Delay between Enhanced Real-Time Deletions
    155

Set Delay between Enhanced Real-Time Event
Processing     155

Set Delay between Enhanced Real-Time Queue
Checking     155

Set Empty File Delay     155

Set Enhanced Real-Time Event Queue Delay    
155

Set Enhanced Real-Time Event Upper Limit     155

Set Maximum Number of Events to Process    
155

Set Process Delay for Enhanced Real-time
Changes     155

Set Real-time Copy Thread Pool     155

Set Shadow Detection     155

Use Update Sensitivity     155

Real-time Copy Thread Pool     155

Real-Time Event Detection Options     63

Real-time Monitoring     63

Real-time Options Button     63
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Reboot Options Button     88

receive an e-mail at start of profile     102

receive an e-mail at stop of profile     102

Recovery Intervals Button     106

Register by FAX     8

Register by mail     8

Register by phone     8

Register online     8

Registering Evaluation Copy of PeerSync     9

Registering Unregistered Copy of PeerSync     10

Registration and Passwords:     8

Entering User ID/Password (Evaluation Copy)     8

Register By Mail     8

Registry variables to use in Folder Paths     59

Related Global Settings     77

Relative Paths     72

Re-load Profile     159

Remote Connection Information     162

Remote Connection Licenses     162

Remote Control     162

Remove Failed Events If Successfully Re-Processed  
  147

Remove Service (PeerLock)     122

Remove Service (PeerSync)     120

Rename Job     13

Replace In use Files Options     88

Replace in use files upon reboot     88

Replace Shares: Add and Overwrite     104

Replicate - Delete unmatched files/folders     71, 72

Replication     12, 162

Report file name     98, 100

Report file path     98

Report Non Standard Events     140

Reporting     32, 95

Reporting Command Line Arguments:     140

Create and Append Summaries into One Report  
  140

Display status in PeerSync     140

Display status in PeerSync upon completion    
140

Enable PSObserver Broadcasts     140

Enable SNMP Error Reporting     140

Enable Summary Statistics Collection     140

Error Reporting     140

Hide Splash Screen     140

Log Messages by Filter     140

Log Messages by Profile     140

Log Messages Only to a Log File by Filter     140

Log Messages Only to a Log File by Filter and/or
by Profile     140

Log Messages Only to a Log File by Profile     140

Log Service Events to the Event Viewer     140

MSMQ messaging     140

Only Hide the about screen     140

PSObserver Broadcasts     140

Report Non Standard Events     140

Run Pre-Sync Report     140

Show Tray Icon     140

Skip setting of main form visible     140

SNMP Error Reporting     140

Summary Report     140

Summary Statistics Collection     140

Suppress connection of PeerSync to the Profiler  
  140

Tray Icon     140

Reporting Features     95

Reporting Screen:     95

Clear Log File     95

Include Options     95

Maximum Log File Size     96

Overview     95

Overwrite Existing Log File     95

Use Log File     95

View Log File     95

Reporting Standard report file content     98, 100

Reporting Summary Information Only     98, 100

Reset Last Run On Value     26

Resume Service (PeerLock)     131, 132

Resume Service (PeerSync)     124, 126

Retain Last Access Time     158

Retry failed connections every x minutes     106

Retry open files every x seconds     106

retry open inaccessible files     106

Retry Options Button     88

Revisioning     32, 84

Revisions     84

Root Path - TCP Target     55

Root Path Prefix - NetApp Settings     44

Run a Pre-Sync Report (do not sync files/folders)    
111

run a scan on reconnect     106

Run application at start of PeerSync     147

Run as a service (PeerLock)     131, 132

Run as a service (PeerSync)     124, 126

Run at specific times and selected days     63

Run External applications/scripts before and after the
processing of a given Job     103
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Run Menu     19

Run Pre-Sync Report     140

Run RegEdit     120

Run Scheduled Operation     144

Run selected Jobs at a specific time of day     63

Run VSS every x minutes     111

Run/View     30

Run/View (PeerLock):     131, 132

Launch PeerLock     131, 132

Pause Service     131, 132

Resume Service     131, 132

Run as a service     131, 132

Start Service/Application     131, 132

Stop Service/Application     131, 132

Run/View (PeerSync):     124, 126

In Sync     126

Launch PeerSync     124, 126

Pause Service     124, 126

Resume Service     124, 126

Run as a service     124, 126

Start Service/Application     124, 126

Stop Service/Application     124, 126

Trending     126

Run/View Current Profile Activity Screen:     159

Added Indicator     159

Checked Indicator     159

Deleted Indicator     159

Elapsed Time Indicator     159

Excluded Indicator     159

File Indicator     159

Files Indicator     159

Folders Indicator     159

Job Indicator     159

Messages Indicator     159

Mode     159

Profile Indicator     159

Size Indicator     159

Skip Files Button     159

Source Indicator     159

Target Indicator     159

Target Space Indicator     159

Updated Indicator     159

Running Jobs vs. Running Profiles (Run a Quick Sync)
    26

- S -
Sample Exclusions     91

Save As     159

Save Changes in PeerLock     118

Save Profile     13

Saving Profiles     13

Scan at Start     144

Scan limitations     32, 68

Scanning Options     63

Scheduled Mode     12, 162

Scheduling Options     63

Security style     77

Select a folder for deleted files to be placed     72

Select Application/Script to Run After     103

Select Application/Script to Run Before     103

Select days of the week to run Jobs     63

Select Source Folder     35

Select Source Folder Button     35, 51

Select Target Folder     52

Select Target Folder Button     52

Selected File Dates     94

Selecting Jobs     26

Selecting Multiple Jobs     26

Selecting Source Folders     35

Selecting Target Folders     52

Selection Tree     30

Selection Tree: Customize Options     30

Send an email for every event     101

Send an email on an interval     101

Send an email once a day     101

Send an email once a week     101

Service (PeerLock)     131, 132

Service (PeerSync)     124, 126

Service Details (PeerLock)     122

Service Details (PeerSync)     120

Set Access Password     112, 115

Set Alternate/Additional Normal Targets     57

Set Application Priority     137

Set CIFS Defaults Button     48

Set Copy Threads     137

Set Deletion Move To Folder Cleanup Interval     147

Set Email Threads     137

Set Empty File Delay     155

Set Failed Connection Timer     147

Set File Comparison Value     147

Set File Read/Write Buffer Delay     137

Set Job Comparison Delta     147

Set maximum number of copy threads to x     80

Set maximum number of retries to x     106

Set Multitasking Delay     137
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Set NFS Defaults Button     48

Set Processor Affinity     137

Set Queue Directory Change Count     147

Set Real-time Copy Thread Pool     137

Set Safety Value for Last Run Time     158

Set Shadow Detection     155

Set Shared Process Delay     137

Set SNC File to Load     136

Set Source Path     136

Set Target File Overwrite     147

Set the maximum log file size to x bytes     96

Set the percentage of copy threads to reserve for
real-time events     137

Set Today's Date Button     94

Set Trigger Folder File Name     158

Set VSS Try Count     157

Shadow Time Range     147

Share Migration support for cDOT 8.3     147

Shared Process Delay     137

Show Advanced/Normal Display     126

Show Advanced/Normal Display PeerLock     132

Show All Profile Options     30

Show PeerLock     118

Show Pre-Sync report file at end of run     111

Show Tray Icon     112, 115, 140

Show/hide Selection Tree     13

Show/hide the Selection Tree     30

Silent Installation     6

Simple Network Management Protocol reporting     96

Size Indicator     159

Skip File Button     159

Skip setting of main form visible     140

SMTP Host - Email Reporting     100

SNC File     136

SNMP Error Reporting     140

SNMP Options Button     96

SNMP reporting     96

Source and Target Selections     35

Source Configuration     105

Source File/Folder Alterations     85, 86

Source Folder Connection Manager     43

Source Folder Field     35

Source Folder NetApp Settings     44

Source Folder Popup Menu     51

Source Folder Selection     35

Using Normal Mode     35

Using TCP Mode     35

Source Folder Selection Button:     51

Create Source Button     51

Explore Source Button     51

Open Source Button     51

Source Indicator     159

Specific time scheduling     63

Standard synchronization     69

Start Service/Application (PeerLock)     131, 132

Start Service/Application (PeerSync)     124, 126

Startup/Service     30

Startup/Service (PeerLock):     122

Executable Path (PeerLock)     122

Install Service (PeerLock)     122

Path (PeerLock)     122

Remove Service (PeerLock)     122

Service Details (PeerLock)     122

Startup/Service (PeerSync):     120

Add to Windows registry     120

Add to Windows StartUp     120

Create Shortcut on Desktop     120

Create SNC extension     120

Disable all Startup Options     120

Executable Path     120

Install Service     120

Quick-Sync Folder Option     120

Remove Service     120

Run RegEdit     120

Service Details     120

Status Display     159

Status Screen     159

Stop Service/Application (PeerLock)     131, 132

Stop Service/Application (PeerSync)     124, 126

store events while connection is down     106

store missed events and process on reconnect     106

Summary Report     140

Summary Reporting Feature     95

Summary Statistics Collection     140

Suppress connection of PeerSync to the Profiler    
140

Suppress Reboot during Install     6

suspend file transfer     67

Swap Source and Target Folders     59

Sync Selected Jobs     26

Synchronization     12, 162

Synchronization Command Line Arguments:     147

Active Connection Interval     147

Allow Replication During Dynamically Created
Jobs     147

Always Run Post Process     147
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Synchronization Command Line Arguments:     147

Always use the local machine time for the Last
Run Time     147

Compare and Set File Attributes from Windows to
NetApp     147

Delete Empty Source Folders After Move     147

Disable application associated with sync     147

Disable Failed Connection Timer     147

Do Not Validate Connections Before Profile is
Loaded     147

Enable Last Access Compare     147

Exclude Folders that have a Reparse Point     147

Folder Queue Watch Interval     147

Force  Flush File Buffers     147

Get Remote PC Time     147

Ignore File Size and/or Date Comparison     147

Ignore Matching/Locked File Extensions     147

Ignore Matching/Locked File Postfix Replacement
    147

Ignore Open File Extensions     147

Ignore Target Space During File Copy     147

Move Files     147

No not delete folders     147

Partial Locked File Extensions List     147

Run application at start of PeerSync     147

Set Deletion Move To Folder Cleanup Interval    
147

Set Failed Connection Timer     147

Set File Comparison Value     147

Set Job Comparison Delta     147

Set Queue Directory Change Count     147

Set Target File Overwrite     147

Shadow Time Range     147

Share Migration support for cDOT 8.3     147

Target In-Use Replacement     147

Terminate All Instances of PeerSync     147

Use Alternate Copy File Methods     147

Use Delete Path for Revisions     147

Use Full Access File Copy     147

Use Network Password Dialog     147

Verify User-Name     147

WordPerfect Fixes for synchronization     147

Synchronization of files between dissimilar time zones
    89

Synchronization Timer Argument     144

Synchronization Timer Argument with Keyboard
Activity     144

Synchronize ALL files via Managed Files     79

Synchronize open/locked files via Managed Files     79

Synchronize Selected Jobs Option     26

System Information for Source Host - cDOT:     45

Get Info     45

System Information for Source Host:     46

Get Info     46

- T -
Target Configuration     105

Target File Time Change Option     89

Target File/Folder Alterations     85

Target Folder Field     52

Target Folder Popup Menu     57

Target Folder Selection     52

Target Indicator     159

Target In-Use Replacement     147

Target Space Indicator     159

TCP Source     36

TCP Source Mode Selection     38

TCP Source PopUp     52

TCP Target     53

TCP Target Configuration Tab     55

TCP Target Mode Selection     55

TCP Target PopUp     58

TCP Target Port Configuration Tab     56

TCP Wan Connector Option     36, 38, 53, 55

Temp Files     85, 86

Temp Folder Selection     6

Term and Trial Period     3

Terminate Active Profile     13

Terminate All Instances of PeerSync     147

Thread Utilization     137

Threads     108, 137

Throttle bandwidth     80

Throttle bandwidth - Use x percent of available
bandwidth     80

Time Change After Sync     89

Time Delta Selection     89

Time Out - TCP Target     56

Time variables for Folder Paths     59

Time Zone Option     89

Timer Argument     144

Tool Buttons     13

Tool Buttons:     13

Add Job     13

Back     13

Copy Job     13

Delete Job     13
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Tool Buttons:     13

Help     13

Hiding/Moving Toolbar     13

Launch Current Profile     13

Move Job Down     13

Move Job Up     13

New Profile     13

Next     13

Open Profile     13

Overview     13

Rename Job     13

Save Profile     13

Settings Screens Drop-Down List     13

Show Selection Tree     13

Terminate Active Profile     13

Toolbars:  Profile Description     16

Transfer File and Folder Permissions     76

Transfer Time Reporting Feature     95

Trap Prefix     97

Tray Icon     112, 115, 140

Tray Icon Popup Menu     25

Tree     30

trigger file     68

Turn file archive attribute off after synchronization     86

- U -
Uninstall     6

Uninstall previous versions of PeerSync     11

Unmount Folders - NFS Settings     74

Update - synchronize existing files in target     69

Updated Files Reporting Feature     95

Updated Indicator     159

Updates:  Product     8

Upgrade     11

Upgrade Information     11

Upgrade PSListener     11

Use Alternate Copy File Methods     147

Use Arguments from Profile     136

Use Asynchronous Mode - NetApp Settings     44

Use Block Byte Level Synchronization     82

Use block/byte level synchronization     82

Use cDOT Detection - NetApp Settings     44

Use daily timer scheduling     63

Use Delete Path for Revisions     147

Use Device Driver method     144

Use Enhanced bi-directional synchronization mode    
158

Use enhanced bi-directional synchronization mode
options     110

Use enhanced real-time monitoring     63

Use error information only     98, 100

Use Full Access File Copy     147

Use intermediate file during copy:     86

Use Last Access File Time     158

Use Log File     95

Use maximum wait time of x seconds     103

Use Network Password Dialog     147

Use Optional Target Unix Linux Settings     75

Use SNMP reporting     96

Use standard report file content     98, 100

Use summary information only     98, 100

Use Unix/Linux system for Job Scans, Copy File
and/or setting Permissions     74

Use Update Sensitivity     155

Use Variables for folder paths stored in registry     59

Use VSS     69

User ID - Email Reporting     100

User Name - NFS Settings     74

User Name - TCP Target     56

User Name and Password     9

User Name variable     59

Usernames - cDOT Options     45

Using # in Excluding Folders     93

Using Variable Paths     59

Using Wild Cards for files to Include     90

- V -
Validate target file (using CRC32)     89

Validation Options     88, 89

variable data import     61

Variables     59

Variables:  File Path     59

Verify User-Name     147

version of files     84

View Admin Folder     159

View Alternate Target Path Selection     58

View Log File     26, 95, 159

View Menu     17

View PeerSync activity across the LAN     162

View Popup Menu     25

View Target Folder     159

Volume Shadow Copy Service (VSS)     79, 111, 157

VSS     69, 79, 111, 157

VSS Interval     111, 157
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- W -
Wait for application to end before continuing     103

Web Farms     112, 115

What email address to send from     100

Who to send emails to     100

Window:  Changing Height of Profile Job List     26

Windows Explorer Add On - Quick-Sync     163

Windows Platforms     12

Windows Variables for Folder Paths     59

WordPerfect Fixes for synchronization     147

Working With Jobs     12, 162

Working with Profiles     12, 162

- Y -
Year variables for Folder Paths     59
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